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1.1 Installation
MailStore Server can be installed on virtually any Windows PC. Neither a server operating system nor a database
system is required. For example, you can set up a test installation of MailStore Server on your desktop machine
without any problem. Running MailStore Server inside a virtual machine is supported as well. For more
information, please refer to the System Requirements article.

Choosing a Computer for the Installation of MailStore Server
Whenever possible, MailStore Server should be installed on a dedicated machine. Depending on the
environment, archiving strategy and usage, MailStore Server can be installed on an already existing server, too.
On the part of the email server to be archived, no components need to be installed though.

Starting the Installation
To start the installation process, double-click on the downloaded setup file. This is a regular Windows
installation, just follow the instructions on the screen:

•• If you want to install MailStore Server in a language different to the operating system's, you can choose it
at the beginning of the installation.

•• Carefully read the license agreement and privacy policy. You have to agree to these terms to continue.
•• In the next step you can choose which folder to install MailStore Server in. In most cases, you should keep

the default setting.
•• The installation program now deploys the necessary components.

You must now enter your MailStore
product key which you have received
by email after your trial registration
or upon buying MailStore Server.
Alternatively you can import a license
file here. That file you can download
either through the link provided in
the dialog or directly from our
website [1].

•• If you've entered a valid
30-day-trial key, it will be
activated automatically. If
you've entered a production
license key, all information that
is sent to MailStore will be
displayed before activation.

•• In the next step you can
configure several settings of
your MailStore Server
installation:

https://help.mailstore.com/en/server/index.php?title=System_Requirements
https://go.mailstore.com/?lang=en&target=activate
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Auto-configure Windows Firewall
If this option is enabled, the default
MailStore TCP ports will be opened in
the Windows Firewall by the
installation program automatically.

• Enable automatic update
check for server
If this option is enabled,
MailStore Server regularly
checks for new product
versions. If a new version
is available, this will be
displayed on the
dashboard in the
MailStore Client.

• Enable automatic update
check for Web Access
If this option is enabled,
MailStore Server regularly
checks for new versions of
the MailStore Web Access. If a new version is available, this will be displayed on the dashboard in the
MailStore Client.

Submission of anonymous usage
data
If this option is enabled, MailStore
Server regularly sends data on how
the program is being used to
MailStore. This data allows us to
better understand different usage
scenarios of MailStore Server and
focus our development capacities
accordingly. The submitted data is
collected and evaluated exclusively
for this purpose.
No personal data such as user names,
passwords or email content will be
submitted. The submitted data is
completely anonymized and cannot
be correlated to a specific customer
installation. You can enable or
disable this option in the MailStore
Client under Administrative Tools >
Miscellaneous > Product Updates at
any time; the option is disabled by default (opt-in).

• By clicking on Finish the installation will be completed and the MailStore Server Service and the MailStore
Client will be started.

The installation program creates a fully functional default installation of MailStore Server, which is perfectly
suited for testing purposes. For production environments, parameters such as the Master Database directory,
features, TCP ports, SSL certificates etc can be customized via the MailStore Server Service Configuration.

https://help.mailstore.com/en/server/index.php?title=MailStore_Server_Service_Configuration%23IP_Addresses_and_Ports
https://help.mailstore.com/en/server/index.php?title=MailStore_Server_Service_Configuration%23IP_Addresses_and_Ports
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First Time Installation
After successfully installing MailStore Server for the first time, it is recommended to continue with the Quick
Start Guide. A step-by-step tutorial explains the basics, from creating users to successfully archivig emails for the
first time.

References
[1] https:/ / go. mailstore. com/ ?lang=en& target=activate

https://help.mailstore.com/en/server/index.php?title=Quick_Start_Guide
https://help.mailstore.com/en/server/index.php?title=Quick_Start_Guide
https://go.mailstore.com/?lang=en&target=activate
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2.1 Archiving Email

Email Archiving with MailStore Basics
Emails can be archived from the mailboxes of email servers such as Microsoft Exchange as well as from the
locally installed email clients of the users. Dependent on its type, archiving tasks can be performed continously,
manually or based on a schedule.

If you are not sure which archiving method best suits your company, please refer to chapter Choosing the Right
Archiving Strategy.

In chapter Email Archiving with MailStore Basics you can find out more about working with archiving profiles,
archiving specific folders, deleting emails after archiving and automating the archiving process.

Email Clients

Archiving Email from Outlook, Thunderbird and Other E-mail Clients
As opposed to all other archiving features, it is imperative that the MailStore Client software is installed on the
user computers when archiving emails from these users' email applications. Once the archiving task is set up, it
can be started manually by the user or executed automatically according to a schedule. Additional information
about this topic is available in chapter Archiving Email from Outlook, Thunderbird and others.

Email Files

Archiving Outlook PST Files
As administrator, you can archive Microsoft Outlook PST files for other MailStore users. Additional information
about these topics is available in chapter Archiving Outlook PST Files Directly.

Archiving EML or MBOX Files
As administrator, you can archive emails from .eml or .msg files for other MailStore users. Additional information
about these topics is available in chapter Archiving Emails from External Systems (File Import).

Email Servers

Archiving Microsoft Exchange or Office 365 Mailboxes and Public
Folders
With MailStore you can archive already existing Exchange or Office 365 mailboxes as well as public folders. You
have the option to archive individual, multiple or all mailboxes in one step as well as archiving all incoming and
outgoing emails by using the Exchange journal feature.

Additional information about this topic is available in the chapter matching your Exchange version:

•• Microsoft Exchange 2003
•• Microsoft Exchange 2007
•• Microsoft Exchange 2010
•• Microsoft Exchange 2013
•• Microsoft Exchange 2016
•• Microsoft Office 365

https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Microsoft_Exchange_2003
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Microsoft_Exchange_2007
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Microsoft_Exchange_2010
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Microsoft_Exchange_2013
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Microsoft_Exchange_2016
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Microsoft_Office_365
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Archiving Alt-N MDaemon Mailboxes
MailStore offers first class support for the popular MDaemon Messaging Server from Alt-N. With MailStore you
are able to archive single mailboxes, multiple or all mailboxes in one step as well as archiving all incoming and
outgoing emails. Additional information is available in chapter Archiving Emails from MDaemon.

Archiving Kerio Connect Mailboxes
MailStore Server offers special support for the popular Kerio Connect email server allowing you to archive
individual, multiple or all mailboxes in one easy step. Additional information is available in chapter Archiving
Emails from Kerio Connect

Archiving IceWarp Mail Server Mailboxes
MailStore Server offers special support for the popular Ice Warp Mail Server allowing you to archive individual,
multiple or all mailboxes in one easy step. Additional information is available in chapter Archiving Emails from
IceWarp Mail Server

Archiving Other Email Servers
With MailStore you can also archive the mailboxes of other email servers using the IMAP or POP3 protocols.
These include web-based mailboxes such as Google Mail or Web.de. MailStore supports archiving individual
mailboxes, multiple mailboxes in one step, as well as catchall or multidrop mailboxes that can be used to
archive all incoming and outgoing emails.

General information is available in the chapters:

•• Archiving Single Mailboxes
•• Archiving Multidrop Mailboxes
•• Batch-archiving IMAP Mailboxes

The actual procedure depends on the email server you are using. Detailed information for a number of email
servers is available in our Implementation Guides.

https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_MDaemon
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Kerio_Connect
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Kerio_Connect
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_IceWarp_Mail_Server
https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_IceWarp_Mail_Server
https://help.mailstore.com/en/server/index.php?title=Implementation_Guides
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2.2 Choosing the Right Archiving Strategy
MailStore Server offers several options for archiving emails. Choosing the right archiving strategy depends on
the email infrastructure (e.g. email server and email clients) on one hand, and company objectives on the other.

Archiving All Incoming and Outgoing Emails Automatically
With this archiving method, all emails are archived before they are delivered to the user mailboxes.

Advantages
•• Completeness of the archive is guaranteed
•• Emails cannot be manipulated before archiving
•• Meeting legal requirements is made possible or greatly facilitated

Disadvantages
•• If private emails are allowed in the company, this archiving method may cause difficulties regarding the

privacy laws of some countries. In this case, a company-wide ban of all private email communication, a
contractual agreement with the employees or approval of an employee organization would be required

•• The workload of the email server and the amount of data is not reduced because all emails are still
delivered and stored in the mailboxes

•• Emails can only be allocated to users as sent or received object; a reproduction of the mailbox folder
structure is not possible

Implementation
• With Microsoft Exchange by archiving the Journal mailbox
• With IMAP-compatible email servers such as MDaemon, Kerio Connect or IceWarp MailServer by archiving

multipdrop mailboxes (also called catchall mailboxes)
• In all other cases and in companies without their own email server by using the MailStore Proxy Server free

of charge

Archiving of Individual Mailboxes
With this archiving method, emails are archived from the individual mailboxes of the users. This can be achieved
by archiving the mailboxes directly from the email server or, if that is not possible, by archiving of email clients.

Advantages
•• The folder structure of the archived mailboxes, email clients or PST files is applied to the archive

facilitating access to the archived emails
•• The archived emails can be deleted from the mailboxes according to pre-defined rules permanently

reducing the workload of the email server

Disadvantages
•• Emails can be deleted or manipulated before archiving, even if the archiving intervals are very short
•• Meeting legal requirements cannot, or only with difficulty, be implemented

Time-controlled Execution of Archiving Tasks
Archiving of email servers is a continuously running task in MailStore Server, carried out server-side in the
background, as soon as the execution of an archiving profile is set to Automatic. By defining a break between
each execution as well as a period in which the archiving profile is never executed, administrators have full
control over the automatic archiving process.

https://help.mailstore.com/en/server/index.php?title=Archiving_Emails_from_Microsoft_Exchange
https://help.mailstore.com/en/server/index.php?title=MailStore_Proxy
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Archiving of email clients and email files usually depends on the current Windows user and is therefore executed
on the client, typically manually (see One-time Archiving of Existing Emails). MailStore allows to create scheduled
tasks in the Windows Task Scheduler to automate client-side archiving tasks. This should be considered if no
other option is availble - server-side archiving is always to be preferred.

One-time Archiving of Existing Emails
In addition to archiving future emails, preexisting emails should also be archived and made available
permanently to your company. This one-time process should include emails in decentralized storage (e.g. PST
files or the users' email clients). At the same time, older emails (e.g. more than two years old) can be deleted
from the mailboxes automatically after archiving. This frees up storage space on the email server and simplifies
backup procedures. All emails remain accessible to users via the MailStore archive.
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2.3 Email Archiving with MailStore Basics

Working with Archiving Profiles
In MailStore Server, every archiving task is stored as an archiving profile. By executing such a profile the
archiving process is started.

Such an archiving profile could contain the following information:

•• WHAT: Mailbox p.berten@company.com
•• WHENCE: Exchange server EXCHANGE01
•• WHERE (Target archive in MailStore Server): peter.berten
•• SCOPE: All folders except drafts
•• DELETION RULE: Delete all archived emails from the Microsoft Exchange mailbox that are older than 3

months.
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Creating an Archiving Profile
To create a new archiving profile proceed as follows:

• Start the MailStore Client and click on Archive Email to create and execute an archiving profile.
• In the Create Profile section of the application window, select the source from which the emails should be

archived (e.g. Microsoft Outlook). A wizard opens.
•• During the first steps of the wizard, several different settings can be specified for the archiving profile.

These include the selection of folders (e.g. "Inbox") or deletion rules (by default, no emails are deleted).
•• If you are logged on as MailStore Server administrator, you will be prompted for the target archive (user

archive), in which the emails should be stored. If logged on as a regular user, the corresponding user
archive will be used automatically.

• In the last step, a name for the archiving profile can be specified. Archiving profiles of type E-mail Server
provide an option to configure the automatic execution from here as well. After clicking Finish, the
archiving profile will be listed under Saved Profiles and can be run immediately, if desired.

Please note: Only MailStore Server administrators can archive emails into a target archive other than their own.
This is not possible for regular MailStore Server users.

Manual Start of Archiving Process
As long as the automatic execution of an archiving profile has not already been configured (type E-mail Servers
only) during its creation, you can manually execute archiving profiles at any time. It is recommended to always
start the initial archiving process manually in order to identify possible configuration issues (i.e. incorrect
credentials) as early as possible.

To manually start the archiving process, select the archiving profile to be executed from the list under Saved
Profiles and click on Run.

A progress windows appears. After the archiving process has been completed you can get further information
about its course as well as possible errors by clicking on Details.... A debug log is also available here.

In addition to being executed manually, archiving profiles can also be run automatically according to a schedule.
Additional information about this topic is available in the chapter Automating the Archiving Process.

Executing Archiving Profiles Multiple Times
Any archiving profile can be run any number of times without concern. MailStore Server only archives emails that
are not yet stored in the target archive (the specified user archive). MailStore Server also detects if any emails
were moved to a different folder within the source application (e.g. Microsoft Outlook) and reproduces such
moves in its archive accordingly.

Editing Archiving Profiles
To edit an existing archiving profile, proceed as follows:

• Select the archiving profile you want to edit from the list Saved Profiles and click on Properties.
• Navigate between the profile's pages with Next and Back and change the settings as desired.
• Save the new settings on the last page by clicking OK.
• By clicking Cancel you can quit editing the archiving profile at any time without committing any changes.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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Deleting Archiving Profiles
If no longer needed, you can delete an existing archiving profile.

• Right-click on the archiving profile you want to delete or click on Commands and select Delete
• A confirmation prompt appears. Acknowledge by clicking OK.

Please note: Deleting an archiving profile has no effect on emails that have already been archived. They remain
in the archive.

Changing Owner of Archiving Profiles
As MailStore Server administrator (admin) you can change the owner of an archiving profile. That way you can
prepare archiving profiles for your users which they can execute on their own afterwards.

• Right-click on the profile you want to change and select Change Owner....
•• Choose the profile's new owner in the next dialog.
• Confirm the selection by clicking on OK.

Please note: If you as a MailStore Server administrator have selected a target archive that does not belong to
the new profile owner, the execution of that profile by its new owner will fail if she is not a MailStore Server
administrator herself.
Only MailStore Server administrators can archive emails into a target archive other than their own. This is not
possible for regular MailStore Server users.

Managing and Executing the Archiving Profiles of Other Users
As MailStore Server administrator (admin) you can manage the archiving profiles created by other users as well.

• In the section Saved Profiles activate the option Show Profiles of All Users.
•• You can now edit, execute or delete these profiles just as your own.

Special Case: Executing the archiving profiles for email clients for
other users
The execution of archiving profiles for email clients such as Microsoft Outlook or Mozilla Thunderbird usually
makes only sense on the PC where the corresponding email client is installed because that client stores emails
and data necessary for accessing them locally on that PC.

Example: If user A has an archiving profile for Microsoft Outlook, you can view and edit it as a MailStore Server
administrator through your MailStore Client. However, executing this profile only makes sense if it is run using
the MailStore Client that is installed on user A's computer because only there can the locally stored data be
accessed.

This information only applies to archiving profiles listed in the E-mail Clients section.

Archiving Specific Folders
By default MailStore Server archives the emails from all folders of the email application or email mailbox except
the following (the list may vary depending on the system):

• Deleted Items - Emails that were deleted by the user
• Drafts - Emails that are still being edited and that have not yet been sent
• Junk Email - Emails that have been classified as spam
• Outbox - Emails that are about to be sent and will be listed under Sent Items after sending

The standard settings can be customized; for every archiving profile, folders can be included or excluded as
needed.

Please notice: Take care of upper and lower case when manually specifying folder names for inclusion or
exclusion. These declarations are case-sensitive.
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General Procedure
You can select the folders to be archived directly upon creating a new archiving profile. Alternatively, you can
adjust the selection for already existing profiles. Additional information about creating and editing archiving
profiles is available in the chapter Working with Archiving Profiles. The following screenshot shows how to
access the folder settings using a Microsoft Outlook archiving profile as an example:

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
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Selecting Folders for Archiving
You can specify the folders that MailStore Server should archive. In this case, MailStore Server limits archiving to
the selected folders and ignores all others.

• In the folder selection under Include Folders and Subfolders, click on Add.

•• Select a folder.
• With the Include Subfolders option you can specify if subfolders of the selected folder should be included in

the archiving process as well.
• Click on OK to add the folder to the list.

Example: You have created a folder Archive in the email application or the mailbox, into which the user moves
all emails that should be archived. In this case, add the folder Archive to the inclusion list. That way, only this
single folder will be archived.
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Excluding Folders from the Archiving Process
MailStore Server can be configured to always exclude certain folders from the archiving process.

• In the folder selection in the Exclude Folders and Subfolders section, click on Add.

•• Select a folder.
• With the Include Subfolders option you can specify if subfolders of the selected folder should be excluded

from the archiving process as well.
• Click on OK to add the folder to the list.

Example 1: Emails that are still in the Inbox should not be archived because they will either be deleted or moved
to a project folder by the user. In this case, add the Inbox folder to the list of folders to be excluded.

Example 2: Emails that are in a folder named Private should not be archived as it may contain personal
information that is prohibited by law (in some countries) to be archived.

Please note: Depending on the system, some folders (e.g. Deleted Items) are always excluded from the archiving
process. To deactivate this automatic exclusion, clear the checkbox Always exclude <folder names>.
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Using Regular Expressions to Include or Exclude Folders
In MailStore Server you can include or exclude folders using regular expressions. The syntax follows the
Specification of Regular Expressions in the .NET Framework 4.5.1 [1]. To specify a regular expression simply prefix
it with || or |i| (using case sensitivity/insensitivity).

Examples
The regular expression "||Folder\d/Folder\d\.\d" would for example include
Folder1/Folder1.1 in the archiving.

The regular expression "||Folder\d/Folder\d\.\d/\w+" excludes further subfolders in the structure
above from being archived. The result could look like this:

http://msdn.microsoft.com/en-us/library/az24scfc(v=vs.110).aspx
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Defining Sent Items Folders
The message list in the archive displays the recipient on sent messages and the sender on received messages.
Therefore a user always sees his communication partner in the message list.

When archiving user mailboxes, sent messages are identified through their containing folder. In case of
Exchange- and Outlook archiving profiles, MailStore is able to detect the sent items folder automatically. When
archiving from IMAP servers that implement the SPECIAL-USE-capability, MailStore is also able to detect the sent
items folder if the option is enabled in the archiving profile. Since IMAP clients may not support that capability,
these clients may have created their own sent items folder, with the result of multiple folders that hold send
items. For MailStore to detect all sent items, the list of sent items folders can be extended in IMAP archiving
profiles.

In case the wrong communication partner is displayed in the message list, the message type can be changed by
an administrator in the MailStore Client by right clicking on the message and selecting Change Message Type.

Archive access on other users' messages has to be unblocked in case the message type of other users should be
changed. The archiving profile should configured that manually changing the message type afterwards should
not be necessary.

https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_the_MailStore_Client_software%23Changing_Message_Type
https://help.mailstore.com/en/server/index.php?title=Compliance_General%23Archive_Access
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Showing the Folders Selected for Archiving
In the folder selection, click on Show Effective Folders to verify the selected settings. Hereby all folders that will
effectively be archived are displayed. Folders displayed in gray will not be archived. In IMAP archiving profiles,
folders that contain sent messages will have a small envelope icon attached.
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Specifying Filter Criteria for Archiving
In MailStore Server, you can limit archiving to certain emails for most archiving profiles by specifying filter
criteria. The following filter options are available:

• Also archive unread messages
By default, MailStore Server archives emails without regard to their read/unread status. Deactivating this
option limits archiving to emails with status read.

•• Only archive messages that are older than
• Date

Here you can specify a particular date to which MailStore Server compares the send or receive date of
the emails to be archived. Only emails that have been sent or received before this date will be
archived. The UTC option defines whether this date is specified in Coordinated Universal Time (UTC)
or takes the local time zone of the MailStore Server into account.

• Range
With this option MailStore Server only archives emails that have been sent or received before the
beginning of this range, measured from the date of archiving.
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Deleting Emails after Archiving
MailStore Server can be used to reduce and to keep the amount of emails stored in a source system at a
minimum. Source system can be email servers, email mailboxes, email applications as well as email files or
email container files. Please notice that deletion of emails is not available in some archiving profiles due missing
interfaces of the source system.

The delete feature that has to be activated explicitly enables MailStore Server to delete emails from the source
system autonomously, according to specified rules and time periods.

Please note: In order to not jeopardize ongoing business processes, emails that have been flagged will never be
deleted by MailStore Server. Configured deletion rules do not apply to such emails. To get them delete by
MailStore Server you have to un-flag them in the source system directly.

Functionality
By default, MailStore Server only copies emails from the source system into its archive. The archives emails
remain in the source system and will not be deleted.

The deletion process will be executed after the archiving of all emails by the archiving profile has been finished.
During this process it is explicitly checked whether any email that is about to be deleted has really been
archived. This ensures that only emails will be deleted from the source system that have been written into the
archive before.

Please note: Emails can only be deleted from a source system after an archiving process, which means that such
deletions are always tied to an archiving profile. Furthermore, deletion rules have to be configured explicitly in
such a profile as described in further detail below.
Beyond this functionality, no other automatic processes exist to delete emails from their source systems.
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Configuration
Delete conditions can be configured during setting up a new archiving profile or for existing profiles under
Advanced Settings > Delete.

The following options are available:

• never
Emails are never deleted from the source system. In effect, emails will be copied into the MailStore Server
archive. This is the default setting.

• immediately after archiving
Emails are deleted from the source system as soon as they have been successfully archived. In effect,
emails will be moved into the MailStore Server archive.

• at least [period] after archiving 
Emails are deleted from the source if they have been in the MailStore Server archive for at least the given
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period of time. In effect, emails will be copied into the MailStore Server archive at first and also remain in
the source system for the given period, before they will be deleted in a subsequent run of the archiving
profile.

• if message older than [period]
Emails are deleted from the source system if their send or receive dates predate the given period of time.
In effect, emails with send or receive dates in the given range will be copied into the MailStore Server
archive at first, while those with send or receive dates predating the given range will be moved into the
MailStore Server archive. During subsequent runs of the archiving profiles, previously archived emails will
be deleted from the source systems if they match the defined age criterion.

Please note: If a filter date or range is configured together with a deletion rule if message older than,
the longer period of time will be applied to the deletion rule as well.
If, for example, the filter range is set to Only archive messages that are older than 1 month and the
deletion rule is set to if message older than 1 day, only emails will be deleted that are older than one
month because younger emails have not been archived yet.
With MailStore Server, it is not possible to delete emails from source systems that have not been
previously archived.

Automating the Archiving Process
With MailStore, every archiving profile can be executed automatically. MailStore Server distinguishes mainly
between two type of automatic executions. For archiving profiles from the category E-mail Server, a continuous
server-side execution by MailStore Server is available, whereas profiles from the category E-mail Clients and
E-mail Files are executed solely on the clients by means of the Windows Task Scheduler.

Important notice: The time-controlled execution of archiving processes cannot prevent users from deleting
emails from their email applications or mailboxes prior to having been archived. In order to ensure that all
emails are archived they should be automatically archived upon sending and receiving.

By deleting a scheduled task (through MailStore's Administrative Tools or the Windows Task Manager) neither
the underlying archiving profile nor the emails already archived by the task are deleted.

Automating Execution of E-mail Server Archiving Profiles
If the automatic execution was not already configured while creating a new archiving profile, follow the below
instructions to activate the automatic execution of archiving profiles from the E-mail Servers category.

•• Start MailStore Client
•• Log in to MailStore Server
• Click on Archive Email.
• Right-click on an existing archiving profile in the Saved Profiles list or click on Commands and then click on

Automatic....
• In the Automatic Execution dialog you can specify the properties of the continuous execution:

• Between executions, wait...seconds
Defines how long MailStore Server should wait until the next execution of the archiving profile.

• Do not execute between
This option allows to specify a period in which the archiving profile is not executed. This for example
can be due to nightly backups or other maintenance tasks.

• After defining all settings, click OK
MailStore immediately starts the continuous execution of the archiving profile in the background. In the Current
Status section, the status of the selected archiving profile can be watched. The very last execution results can be
shown by clicking on Details..., whereas a list of all previous executions results is shown after clicking on All
Results....

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Specify_Filter_Criteria_for_Archiving
https://help.mailstore.com/en/server/index.php?title=Choosing_the_Right_Archiving_Strategy%23Archiving_All_Incoming_and_Outgoing_Emails_Automatically
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Automating Execution of E-mail Client or E-mail Files Archiving
Profiles
Archiving profiles from the category E-mail Clients (i.e Microsoft Outlook, Mozilla Thunderbird) and E-mail Files
must be executed in the context of the Windows users whose emails are to be archived or who has access to the
files to be archived. To automate the archiving process of these profiles please proceed as follows:

Please note: As MailStore administrator and using MailStore's user management, first verify that the user
possesses the privilege to archive emails.

• Start MailStore Client on the user's computer.
•• Log on to MailStore Server using the user's credentials.
• Click on Archive Email.
• Right-click on an existing profile or click on Commands and then select Create Task on <COMPUTERNAME>.

•• In the next window "Schedule Task" the following settings can be specified:
• Task - Name:

The task name can be chosen freely. By default, the name of the archiving profile and its internal
MailStore ID are used.

• Trigger:
The following triggers can be specified:

• Daily at - Specify a time for the daily execution (once a day)
• Every [xx] minutes - Specify an interval of minutes to execute the profile (i.e. every 60 minutes)
• Other Trigger - If the option Other Trigger is chosen. the archiving task is still created as a

Windows task but the execution times have to be specified separately. This has to be done using
the Windows Task Scheduler and is described in Windows Help. All options offered by your
version of Windows can be used.

• After all settings have been specified, the task can be created by clicking on OK. Confirm the safety prompt
• Confirm again by clicking OK.

Please notice: Modifications to the schedule of archiving profiles from the categories E-mail Clients or E-mail 
Files is only possible through the Windows Task Scheduler. The task scheduler can be opened directly from
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MailStore Client by right-clicking on one of the existing profiles from the above categories and selecting the
option Open Windows Task Scheduler.

Showing the Command Line
If desired, the archiving process of E-mail Client and E-mail Files profiles can be incorporated into a larger
procedure, such as one run by a batch file (.bat). To simplify this process, MailStore offers the option Copy Cmd
Line in the Schedule Task window (see top of this page). Click on the button to view a command line that can be
incorporated into the desired procedure. For example:

"C:\Programme\Mailstore\MailStore Server\MailStoreCmd.exe"
--h="localhost" --pkv3="A3774AD575BA6DE29844829697585EBE21B20B83"
--cred="admin@127.0.0.1"
-c import-execute --id=4 --user="admin" --verbose

The command line is to be read as follows:

"...\MailStoreCmd.exe" - MailStoreCmd.exe is the MailStore Management Shell. It was developed for the
automated execution of certain processes in MailStore. Additional information about MailStoreCmd is available
in chapter MailStore Server Management Shell.

--h="localhost" - The computer name of MailStore Server to which MailStoreCmd.exe is to connect.

--pkv3="..." - Public Key Fingerprint. It guarantees that the MailStore server at the time of archiving is the same
as it was at the time when the scheduled task was created (optimal safety feature).

--cred="admin@127.0.01" - The password of the user admin of the server 127.0.0.1 will be read from the
Windows Credential Manager, which has been stored there before by MailStore.

-c - The actual command follows (non-interactive mode).

import-execute --id=4 --user="admin" --verbose - Execute the archiving profile of user admin with the internal
ID 4.

References
[1] http:/ / msdn. microsoft. com/ en-us/ library/ az24scfc(v=vs. 110). aspx

http://msdn.microsoft.com/en-us/library/az24scfc(v=vs.110).aspx
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2.4 Archiving Email from Outlook,
Thunderbird and others
Important notice: As opposed to all other archiving features, it is imperative that the MailStore Client software
is installed on the user computer when archiving emails from Outlook, Thunderbird and other email
applications.

Once the archiving task is set up, it can be started manually by the user or executed automatically according to a
schedule any number of times. During this process, the emails are transferred by the MailStore Client of the user
to the central MailStore Server for archiving.

Please note: If the user emails are accessible (e.g. on a network drive) to the MailStore administrator in form of
individual PST files, they can be archived directly by the administrator. As opposed to archiving from Outlook,
this can be done completely independently from the user and the user computer. Additional information about
this topic is available in the chapter Archiving Outlook PST Files Directly.

Supported Email Applications
MailStore supports archiving emails from various email applications, including:

•• Microsoft Outlook 2003, 2007, 2010, 2013, 2016 (Click-to-Run versions 2013 and higher only)
•• Microsoft Windows Mail (integrated in Windows Vista)
•• Microsoft Windows Live Mail
•• Mozilla Thunderbird
•• Mozilla SeaMonkey

Even email applications not listed here can often be archived using the file system (EML) and MBOX import.
Additional information is available in the chapter Archiving Emails from External Systems (File Import).

Important notice: MailStore does not support archiving of Microsoft Outlook profiles that use third-party
components to access mailboxes on an email server. Please archive those mailboxes directly.

Procedure
Setting up archiving processes for Outlook, Thunderbird and other email applications is done using archiving
profiles. General information about archiving profiles is available in the chapter Working with Archiving Profiles.

• Create a MailStore user account (if one does not already exist) for each user whose emails are to be
archived and grant them the privileges to archive emails and to create, edit and delete archiving profiles.
Additional information is available in the chapter User Management.

•• Install the MailStore Client software on the corresponding user computers.
• Ask each user to log on to MailStore Server using their MailStore Client. Under Archive Email, a new

archiving profile can be created for each user. In the Create Profile area of the application window, select
the source from which the emails are to be archived (e.g. Microsoft Outlook).

• A wizard opens. At the first steps of the wizard, several settings can be specified for the archiving profile.
These include the selection of the folders (e.g. "Inbox") and deletion rules (by default, no emails are
deleted). An explanation of these settings can be found later on in this chapter under Settings for Archiving
Profiles.

•• If logged on to MailStore Server as administrator, the target archive can be specified at the next step of the
wizard. Select the archive of the user whose computer is currently being used.

• At the last step, a name for the archiving profile can be specified. After clicking Finish, the archiving profile
will be listed under Saved Profiles and can be run immediately, if desired.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
https://help.mailstore.com/en/server/index.php?title=Archiving_Email_from_Outlook%2C_Thunderbird_and_others%23Settings_for_Archiving_Profiles
https://help.mailstore.com/en/server/index.php?title=Archiving_Email_from_Outlook%2C_Thunderbird_and_others%23Settings_for_Archiving_Profiles
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Settings for Archiving Profiles
Upon creating or editing an archiving profile, different settings can be specified for the archiving task. Settings
vary depending on the type of the email client selected (e.g. Microsoft Outlook or Mozilla Thunderbird).

Folders - Specify here, which folders (e.g. "Inbox") are to be archived. Additional information is available in
chapter Archiving Specific Folders.

Filter - Also archive unread messages: By default, MailStore archives both read and unread emails. Clear the
checkbox next to this text to exclude unread emails from the archiving process.

Delete - If desired, MailStore can automatically delete emails from the source application (e.g. Microsoft
Outlook), after they have been archived successfully. Additional information is available in chapter Deleting
Emails after Archiving.

Settings Available for Outlook Only

Archive Email Stored in your Local Outlook
If multiple Outlook profiles exist, to which the user can log on to, the Outlook profile to be archived can be
selected here.

Archive Email Stored in a PST File
Select this option if MailStore is to access the PST file directly. This option is described in the chapter Archiving
Outlook PST Files Directly.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Selecting_Folders_for_Archiving
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Deleting_Emails_after_Archiving
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Deleting_Emails_after_Archiving
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Settings Available for Mozilla Thunderbird Only

Profile: If multiple Thunderbird profiles exist, to which the user can log on to, the profile to be archived can be
selected here. Alternatively, by using the Browse button, any directory containing Thunderbird data (e.g. from
the portable version) not listed under Profile can be specified. Select the directory containing the file prefs.js.
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Settings Available for Mozilla SeaMonkey Only

Profile: If multiple SeaMonkey profiles exist, to which the user can log on to, the profile to be archived can be
selected here. Alternatively, by using the Browse button, any directory containing SeaMonkey data not listed
under Profile can be specified. Select the directory containing the file prefs.js.

Starting the Archiving Process

Starting the Archiving Process Manually
On the start page of MailStore Client, click on Archive Email and from the list under Saved Profiles, select the
appropriate archiving profile. Click on Run. After the archiving process has been executed, a protocol appears. It
contains information about the volume of emails that have been archived as well as any errors that may have
occurred.

This process can be repeated by the user any number of times. MailStore only archives those emails that are not
yet stored in the corresponding user archive.

Automating the Archiving Process
In addition to being executed manually, archiving tasks can also be executed automatically. Additional
information about this topic is available in chapter Automating the Archiving Process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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2.5 Archiving Outlook PST Files Directly
With MailStore Server, PST files can be archived directly. Contrary to archiving emails from Outlook, here you
can create and execute archiving tasks independently from users and user computers. The users' individual PST
files should be made available centrally, e.g. through a network share.

Please note: The computer used for archiving PST files through the MailStore Client must have a version of
Outlook installed that is compatible with the PST files selected. For example, to archive an Outlook 2007 PST file,
the corresponding version of Outlook needs to be installed.

Setting up archiving processes for PST files is done using archiving profiles. General information about archiving
profiles is available in the chapter Working with Archiving Profiles.

Archiving a PST file that contains emails of a single user
Please note: If you don't want to archive PST files in your personal user archive only, you'll have to be logged on
to MailStore Client as a MailStore Server administrator. Only a MailStore Server administrator can archive emails
for other users.

For each PST file, please proceed as follows:

• In MailStore Server, click on Archive Email.
• From the E-mail Files category in the Create Profile section select Microsoft Outlook PST files.
•• A wizard opens, guiding you through the setup process.

• Select Single User and click on OK.
• The dialog window Archive Microsoft Outlook appears.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
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• Select Archive Email Stored in a PST File as source and specify the PST file to be archived. Click on Next.
Please note: If you work with an Outlook/Exchange environment, you get better results by first
opening the existing PST file in Outlook and then using the Archive Email Stored in your Local Outlook
option. This way you can ensure that all existing sender and recipient addresses are correctly
archived.

• If needed, adjust the settings for the List of Folders to be Archived, the filter and the Deletion Rules.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Archiving_Specific_Folders
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Archiving_Specific_Folders
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•• If logged on to MailStore Server as a MailStore Server-administrator, the target archive can be specified in
the next step of the wizard. Select the archive of the user for whom the selected PST file is to be archived.
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• In the final step you can specify a name for the new archiving profile. After clicking on Finish, the archiving
profile will be listed under Saved Profiles and can be run immediately, if desired.

Archiving a PST file that contains emails of multiple users
Please note: In order to be able to select this archiving method, you'll have to be logged on to MailStore Client
as a MailStore Server administrator. Only a MailStore Server administrator can archive emails for other users.

In addition to archiving PST files that contain emails of a single user, MailStore Server can archive PST files that
contain emails of multiple users, e.g. from a multidrop mailbox export.
To archive such emails please proceed as follows:

• In MailStore Server, click on Archive Email.
• From the E-mail Files category in the Create Profile section select Microsoft Outlook PST files.
•• A wizard opens, guiding you through the setup process.
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• Select Multiple Users and click on OK.
• The dialog window Archive Multidrop Mailbox (Filesystem) appears.

•• Select the PST file to be archived.
•• Adjust any further settings such as how to handle emails with unknown addresses or asking MailStore

Server to delete email files after they have been archived.
• Click on Next.
• In the final step you can specify a name for the new archiving profile. After clicking on Finish, the archiving

profile will be listed under Saved Profiles and can be run immediately, if desired.
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Starting the Archiving Process

Starting the Archiving Process Manually
On the start page of MailStore Client, click on Archive Email and from the list under Saved Profiles, select the
appropriate archiving profile. Click on Run. After the archiving process has been executed, a protocol appears. It
contains information about the volume of emails that have been archived as well as any errors that may have
occurred.

This process can be repeated by the user any number of times. MailStore only archives those emails that are not
yet stored in the corresponding user archive.

Automating the Archiving Process
In addition to being executed manually, archiving tasks can also be executed automatically. Additional
information about this topic is available in chapter Automating the Archiving Process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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2.6 Archiving Emails from External Systems
(File Import)
MailStore Server can also archive the emails from applications that are not directly supported if they are
available in a standardized format. With most applications it is necessary to export the emails to one of those
formats first.

Using file import, MailStore Server can archive the following formats:

• EML - One file per email. Often called RFC 822 or MIME format.
• MSG - One file per email. Microsoft Outlook email files.
• PST - Microsoft Outlook personal folder files.
• MBOX - This file format is used by Mozilla Thunderbird, for example, although in this case the file ending is

omitted. The MBOX file format is also used by many Unix mail servers.

Procedure for Archiving PST Files
Archiving PST files is described separately in chapter Archiving Outlook PST Files Directly.

Procedure for Archiving EML and MSG Files
Setting up archiving processes for files from the file system is done using archiving profiles. General information
about archiving profiles is available in chapter Working with Archiving Profiles.

Archiving Emails of a Single User
Please note: If you do not want to archive email files in your personal user archive only, you'll have to be logged
on to MailStore Client as a MailStore Server administrator. Only a MailStore Server administrator can archive
emails for other users.

Please proceed as follows:

• In MailStore Server, click on Archive Email.
• From the E-mail Files category in the Create Profile section select EML and MSG files.
•• A wizard opens, guiding you through the setup process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
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• Select Single User and click on OK.
• The dialog window Archive EML and MSG files appears.

•• Select the folder to be archived. All email files in this folder will be archived.
• If desired, adjust the advanced settings or simply click Next.

• Include Subfolders:
In addition to the emails in the selected folder also those located in any subfolders will be archived.

• Read MailStore Headers:
RFC 822 files created by the MailStore Server-specific export process contain additional information
such as the source folder. Set the checkmark if this information should be taken into account.

• Custom File Extensions:
Here you can make appropriate entries if the files to be archived are in EML or MSG format but have a
different file extension.

• If needed, adjust the settings for the List of Folders to be Archived, the filter and the Deletion Rules.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Archiving_Specific_Folders
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Archiving_Specific_Folders
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•• If logged on to MailStore Server as a MailStore Server-administrator, the target archive can be specified in
the next step of the wizard. Select the archive of the user for whom the selected files are to be archived.
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• In the final step you can specify a name for the new archiving profile. After clicking on Finish, the archiving
profile will be listed under Saved Profiles and can be run immediately, if desired.

Archiving Emails of Multiple Users
Please note: In order to be able to select this archiving method, you'll have to be logged on to MailStore Client
as a MailStore Server administrator. Only a MailStore Server administrator can archive emails for other users.

In addition to archiving email files of a single user, MailStore Server can archive email files of multiple users from
a single directory; such emails may have been exported from a multidrop mailbox.
To archive such emails please proceed as follows:

• In MailStore Server, click on Archive Email.
• From the E-mail Files category in the Create Profile section select EML and MSG files.
•• A wizard opens, guiding you through the setup process.
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• Select Multiple Users and click on OK.
• The dialog window Archive Multidrop Mailbox (Filesystem) appears.

•• Select the folder with the email files to be archived.
•• Adjust any further settings such as how to handle emails with unknown addresses or asking MailStore

Server to delete email files after they have been archived.
• Click on Next.
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• In the final step you can specify a name for the new archiving profile. After clicking on Finish, the archiving
profile will be listed under Saved Profiles and can be run immediately, if desired.

Archiving Emails from a MailStore Export
Please note: In order to be able to select this archiving method, you'll have to be logged on to MailStore Client
as a MailStore Server administrator. Only a MailStore Server administrator can archive emails for other users.

To archive EML files which have been created by a MailStore Export, the correct options have been pre-selected.
This provides an easy way to file emails exported from MailStore Server into the correct user archives and folders
again.
Please proceed as follows:

• In MailStore Server, click on Archive Email.
• From the E-mail Files category in the Create Profile section select EML and MSG files.
•• A wizard opens, guiding you through the setup process.

• Select MailStore Export and click on OK.
• The dialog window Archive EML and MSG files appears.
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•• Select the folder to be archived. All email files in this folder will be archived.
• If desired, adjust the advanced settings or simply click Next.

• Include Subfolders:
In addition to the emails in the selected folder also those located in any subfolders will be archived.

• Read MailStore Headers:
RFC 822 (EML) files created by the MailStore Server-specific export process contain additional
information about the source archives and folders. This information allows to file emails exported
from MailStore Server into the correct user archives and folders when being rearchived. Non-existent
archives and folders will be created automatically.

• Custom File Extensions:
Here you can make appropriate entries if the files to be archived are in EML or MSG format but have a
different file extension.

• If needed, adjust the settings for the List of Folders to be Archived, the filter and the Deletion Rules.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Archiving_Specific_Folders
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Archiving_Specific_Folders
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• You can specify the target archive in the next step of the wizard. Select the archive of the user for whom
the selected files are to be archived. The target archive will be ignored if the option Read MailStore Headers
has been selected and the email to be archived contains such headers.
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• In the final step you can specify a name for the new archiving profile. After clicking on Finish, the archiving
profile will be listed under Saved Profiles and can be run immediately, if desired.

Procedure for Archiving MBOX Files
Setting up the archiving process for files from the file system is done using archiving profiles. General
information about archiving profiles is available in chapter Working with Archiving Profiles.

Please note: If you do not want to archive email files in your personal user archive only, you'll have to be logged
on to MailStore Client as a MailStore Server administrator. Only a MailStore Server administrator can archive
emails for other users.

Please proceed as follows:

• In MailStore Server, click on Archive Email.
• From the Email Files list in the Create Profile area of the application window select MBOX File.
•• A wizard opens, guiding you through the setup process.
•• Select the MBOX file to be archived.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
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•• If logged on to MailStore Server as administrator, the target archive can be specified. Select the archive of
the user for whom the selected file is to be archived.

• In the final step you can specify a name for the new archiving profile. After clicking on Finish, the archiving
profile will be listed under Saved Profiles and can be run immediately, if desired.
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Archiving with Drag & Drop
Files can also be archived using Drag & Drop: Simply drag the appropriate folder containing EML files or the
appropriate MBOX file into the list of saved settings to create an archiving profile for this process directly.

Starting the Archiving Process

Starting the Archiving Process Manually
On the start page of MailStore Client, click on Archive Email and from the list under Saved Profiles, select the
appropriate archiving profile. Click on Run. After the archiving process has been executed, a protocol appears. It
contains information about the volume of emails that have been archived as well as any errors that may have
occurred.

This process can be repeated by the user any number of times. MailStore only archives those emails that are not
yet stored in the corresponding user archive.

Automating the Archiving Process
In addition to being executed manually, archiving tasks can also be executed automatically. Additional
information about this topic is available in chapter Automating the Archiving Process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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2.7 Archiving Server Mailboxes
This chapter describes how a single mailbox located on any email server can be archived using the IMAP or POP3
protocols. To archive multiple mailboxes in one step, Batch-archiving IMAP Mailboxes can be used. If the mailbox
is a multidrop mailboxes, also called catchall mailboxes, that contains emails for more than one person please
read the chapter Archiving IMAP and POP3 Multidrop Mailboxes

Important: This article describes the general procedure independent from the e-mail server used. Please find
e-mail server specific information in our Implementation Guides.

Required Information
In order to archive a server mailbox, MailStore requires the following data:

•• The server name (e.g. imap.myserver.com).
•• The protocol used (e.g. IMAP-TLS).
•• The user name. Often times, the full email address or the local part (left of the @ character) is used.
•• The password.

IMAP or POP3?
When choosing between IMAP and POP3, we strongly recommend using IMAP. With IMAP, all or specific folders of
the mailbox can be archived. POP3 does not "recognize" any folders; because of this it is likely that, with most
service providers, only the inbox will be archived.

Setting Up the Archiving Process
By following the procedure described here, a single mailbox can be archived for a specific MailStore user. The
archiving process can be executed manually or automatically.

Setting up archiving processes for IMAP or POP3 mailboxes is done using archiving profiles. General information
about archiving profiles is available in chapter Working with Archiving Profiles.

For each mailbox, please proceed as follows:

•• Users can only archive their own mailboxes to their personal user archive. To archive the emails of other
users, you have to be logged on to MailStore Client as MailStore administrator. Only MailStore
administrators can archive the emails of other users.

• In MailStore, click on Archive Email.
• To create a new archiving profile, select Other Server via IMAP/POP3 from the Email Servers list in the Create

Profile area of the application window.
•• A wizard opens guiding you through the setup process.

https://help.mailstore.com/en/server/index.php?title=Implementation_Guides
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
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• Select Single Mailbox and click on OK.
• Fill out the fields Email Address, Host, Access via, User Name and Password. Click on Test to verify the data

entered.
For the IMAP-TLS and IMAP-SSL protocols only: You have the option to ignore SSL security warnings.
Generally, these warnings appear if an unofficial certificate is used on the server.

• Click on Next.
• Customize the list of folders to be archived (IMAP only), the filter (IMAP only) and the deletion rules. By

default, no emails will be deleted from a mailbox. The timeout value only has to be adjusted as needed
(e.g. with very slow servers).

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Selecting_Folders_for_Archiving
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Specifying_Filter_Criteria_for_Archiving
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Deleting_Emails_after_Archiving
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• Click on Next.
•• If logged on to MailStore Server as administrator, the target archive can be specified at the next step.

Select the archive of the user for whom the mailbox is to be archived.
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• At the last step, a name for the new archiving profile can be specified. After clicking on Finish, the archiving
profile will be listed under Saved Profiles and can be run immediately, if desired.

Starting the Archiving Process

Starting the Archiving Process Manually
On the start page of MailStore Client, click on Archive Email and from the list under Saved Profiles, select the
appropriate archiving profile. Click on Run. After the archiving process has been executed, a protocol appears. It
contains information about the volume of emails that have been archived as well as any errors that may have
occurred.

This process can be repeated by the user any number of times. MailStore only archives those emails that are not
yet stored in the corresponding user archive.

Automating the Archiving Process
In addition to being executed manually, archiving tasks can also be executed automatically. Additional
information about this topic is available in chapter Automating the Archiving Process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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2.8 Batch-archiving IMAP Mailboxes
This chapter describes how multiple IMAP mailboxes can be archived in one step.

Important: This article describes the general procedure independent from the e-mail server used. Please find
e-mail server specific information in our Implementation Guides.

Multiple IMAP Mailboxes (Master Password)
MailStore supports archiving multiple IMAP mailboxes by means of a privileged user and the procedure to log in
to an IMAP server as specified in RFC 4616 - The PLAIN SASL Mechanism. In addition to the privileged user's user
name and password, the primary email address (as mailbox name) of the user whose emails are to be archived is
passed on in the process as well.

You can learn from your email server's manufacturer if your email server supports this type of login and what the
prerequisites are.

Setting up the Archiving Process
Archiving processes for IMAP or POP3 mailboxes are set up using archiving profiles. General information about
archiving profiles is available in chapter Working with Archiving Profiles.

Please proceed as follows:

•• Log on as MailStore administrator using MailStore Client.
• In MailStore, click on Archive Email.
• From the list of email servers under Create Profile, select Other Server via IMAP/POP3.
•• A wizard opens to assist in specifying the archiving settings.

Hint: The Online Help gives you direct access to the respective Implementation Guides.

• Select Multiple IMAP Mailboxes (Master Password) and click on OK.

https://help.mailstore.com/en/server/index.php?title=Implementation_Guides
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
https://help.mailstore.com/en/server/index.php?title=Implementation_Guides
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• Fill out the fields Host and Access via and enter the login data of the privileged user under User Name and
Password.
Only with IMAP-TLS and IMAP-SSL: If you are using an unofficial certificate on the email server, select the
option to Ignore SSL Security Warnings .

• In the Sent Items field you can enter the name of the folder containing sent emails.
• Click on Next.
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•• If needed, customize the list of folders to be archived, the deletion rules, the filters, the timeout value in
seconds and the maximum number of archiving jobs to be executed simultaneously. The timeout value
only has to be adjusted if needed (e.g. when using a very slow server).

• Click on Next.
•• Select the users whose mailboxes are to be archived.
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The following options are available:

• All users with configured email address
Choose this option to archive the mailboxes of all users who are set up, along with their email
addresses, in MailStore's user management.

• All users except the following
Choose this option to exclude individual users (and thereby their IMAP mailboxes) from the archiving
process, using the list of users below.

• Only the following users
Choose this option to include individual users (and thereby their IMAP mailboxes) in the archiving
process, using the list of users below. Only the mailboxes of those users explicitly specified will be
archived.

• Synchronize with Directory Services before archiving
If selected, the MailStore user list will be synchronized with the configured directory service before
any archiving process is executed. This has the advantage that, for example, new employees will be
created as MailStore users before archiving, so once the archiving process is executed, their IMAP
mailbox is archived automatically as well. This option is especially recommended when the archiving
process is to be executed automatically.

• Click on Next.
• In the last step, a name for the archiving profile can be specified. After clicking Finish, the archiving profile

will be listed under Saved Profiles and can be run immediately or automatically, if desired.
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Multiple IMAP Mailboxes (CSV File)

Archiving multiple IMAP mailboxes based on a CSV file is described below. Use this procedure if your IMAP server
does not support any of the authentication methods described under Multiple IMAP Mailboxes (Master Password)

Preparation: Creating a CSV File
In order to set up batch archiving of multiple IMAP mailboxes, first, a CSV file needs to be created. For this, a
Microsoft Excel spreadsheet can be used, for example:

Set up the columns as shown above. Please keep in mind that the headings (e.g."IMAP user name") must be in
place but their notation may differ. Beneath the headings, enter a row for each mailbox to be archived:

IMAP user name and IMAP password
These entries are mandatory for MailStore to be able to access the mailbox.

Email address (optional)
If entered, MailStore will label the folder for the respective mailbox in the tree structure of the archive with the
email address specified.

MailStore user name (optional)
If entered, MailStore will archive the respective mailbox for each MailStore user specified (store the emails in the
appropriate user archive). If the user does not yet exist, a user will be created automatically. If this field is left
blank, a new MailStore user is created automatically and labeled with the IMAP user name specified.

This way, any number of mailboxes of an email server may be entered. When finished, save the file in .csv format
(if Microsoft Excel is used via the Save As function).

Setting Up the Archiving Process
Setting up archiving processes for IMAP or POP3 mailboxes is done using archiving profiles. General information
about archiving profiles is available in chapter Working with Archiving Profiles.

Please proceed as follows:

•• Log on as MailStore administrator using MailStore Client.
• In MailStore, click on Archive Email.
• To create a new archiving profile, select Other Server via IMAP/POP3 from the Email Servers list in Create

Profile area of the application window.
•• A wizard opens guiding you through the setup process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
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• Select Multiple Mailboxes (CSV File) and click on OK.
• Fill out the fields Host and Access via, and under CSV File enter the path of the new CSV file (created as

described above). This file contains the access information for the mailboxes to be archived. Under Special
Folder (optional) you may enter the name of the IMAP folder containing sent messages.
For the IMAP-TLS and IMAP-SSL protocols only: You have the option to Ignore SSL Security Warnings.
Generally, these warnings appear if an unofficial certificate is used on the server.



Batch-archiving IMAP Mailboxes 56

• Click on Next.
•• If needed, adjust the list of folders to be archived, the deletion rules, the filter, the timeout value in

seconds and the maximum number of archiving jobs to be executed simultaneously. The timeout value
only has to be adjusted if needed (e.g. when using a very slow server).

• Click on Next.
• At the last step, a name for the new archiving profile can be specified. After clicking on Finish, the archiving

profile will be listed under Saved Settings (Profiles) and can be run immediately, if desired.

Starting the Archiving Process

Starting the Archiving Process Manually
On the start page of MailStore Client, click on Archive Email and from the list under Saved Profiles, select the
appropriate archiving profile. Click on Run. After the archiving process has been executed, a protocol appears. It
contains information about the volume of emails that have been archived as well as any errors that may have
occurred.

This process can be repeated by the user any number of times. MailStore only archives those emails that are not
yet stored in the corresponding user archive.

Automating the Archiving Process
In addition to being executed manually, archiving tasks can also be executed automatically. Additional
information about this topic is available in chapter Automating the Archiving Process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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2.9 Archiving IMAP and POP3 Multidrop
Mailboxes
In this chapter, learn how to archive multidrop mailboxes. Multidrop mailboxes, also called catchall mailboxes,
contain emails for more than one person. Generally, all emails for a certain domain are collected therein to be
retrieved by an internal email server; the server then distributes the emails among the appropriate user
mailboxes. Multidrop mailboxes are also used when sending a copy of all emails to a single mailbox on the email
server; MailStore extracts the sender and recipient information from the email headers to assign them to the
appropriate users. By using this type of mailboxes it is possible to archive all incoming and outgoing emails.

Important: This article describes the general procedure independent from the e-mail server used. Please find
e-mail server specific information in our Implementation Guides.

Setting up the Archiving Process
By following the procedure described here, an IMAP or POP3 multidrop mailbox can be archived. The archiving
process can be executed manually or automatically.

Setting up archiving processes for multidrop mailboxes is done using archiving profiles. General information
about archiving profiles is available in chapter Working with Archiving Profiles.

Please proceed as follows:

•• Log on as MailStore administrator using MailStore Client.
• In MailStore, click on Archive Email.
• To create a new archiving profile, select Other Server via IMAP/POP3 from the Email Server list in the Create

Profile area of the application window.
•• A wizard opens guiding you through the setup process.

• Select Multidrop Mailbox and click OK.
• Fill out the fields Access via, Host, Username and Password. Click on Test to verify the data entered.

For the TLS and SSL protocols only: You have the option to ignore SSL warnings. Generally, these warnings
appear if an unofficial certificate is used on the server.

https://help.mailstore.com/en/server/index.php?title=Implementation_Guides
https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
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•• Adjust any further settings such as how to handle emails with unknown addresses or asking MailStore to
delete emails after they have been archived. The latter option is especially sensible when dealing with
mailboxes that are exclusively used for archiving.

Notice: If you are additionally archiving messages from the users mailboxes, you have to set the target folder
names here to the folder names that match the names that were created by the user mailbox archiving profiles.
Otherwise, additional or similar folders could be created in the users' archives. The folder names are
case-sensitive.

• If the option Synchronize with Directory Services before archiving is enabled, the MailStore user list will be
synchronized with configured directory service before the archiving process actually runs. This has the
advantage that, for example, new employees will be created as MailStore users before archiving which
enables MailStore to sort their emails into the correct archives.

• Click on Next.
•• The timeout value only has to be adjusted on a case-by-case basis (e.g. with very slow servers).
• Click on Next.
• At the last step, select a name for the new archiving profile. After clicking on Finish, the archiving profile

will be listed under Saved Profiles and can be run immediately or automatically, if desired.
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Starting the Archiving Process

Starting the Archiving Process Manually
On the start page of MailStore Client, click on Archive Email and from the list under Saved Profiles, select the
appropriate archiving profile. Click on Run. After the archiving process has been executed, a protocol appears. It
contains information about the volume of emails that have been archived as well as any errors that may have
occurred.

This process can be repeated by the user any number of times. MailStore only archives those emails that are not
yet stored in the corresponding user archive.

Automating the Archiving Process
In addition to being executed manually, archiving tasks can also be executed automatically. Additional
information about this topic is available in chapter Automating the Archiving Process.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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3.1 Accessing the Archive
MailStore provides several ways to access archived emails:

Accessing the Archive with the MailStore Client Software
MailStore Client is a Windows application that
can be installed on any number of user
computers (depending on the license
purchased). Of all the options for accessing the
archive, MailStore Client provides the largest
range of functions: Not only can users browse
and view their emails but, depending on the
privileges assigned to them, set up and
execute archiving and exporting tasks.

MailStore Client Manual

Accessing the Archive with MailStore Web Access
The responsive MailStore Web Access provides
access to the archive using an internet
browser. This has the advantage that no
additional software needs to be installed on
the user machines. In addition to browsing and
viewing emails, web access also offers access
through the folder structure and functions for
restoring emails from the archive.

MailStore Web Access Manual
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Accessing the Archive with the Microsoft Outlook
Integration
With a MailStore add-in, users can access the
archive directly from Microsoft Outlook.

MailStore Outlook Add-in Manual

Access Using Other Email Clients
MailStore Server provides an integrated IMAP
server, that offers you read-only access to the
archive for any IMAP capable email client.
Especially for alternative email clients (Mozilla
Thunderbird) or operating systems (e.g.
MacOS or Linux), as well as for mobile
platforms such as Android, IPhone or Symbian,
this is a very convenient way of accessing the
archive.

MailStore Integrated IMAP Server Manual

https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_via_Integrated_IMAP_Server
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3.2 Accessing the Archive with the MailStore
Client software

Installation & Update
The MailStore Client setup file that matches your MailStore Server version is stored on the MailStore Server
machine. Follow the Install MailStore Client on other Computers link on your desktop and copy the corresponding
setup file to the client computer.

It is a regular Windows setup program, that can by executed on the appropriate client computer by
double-clicking on the setup file. Just follow on-screen instructions.

Notice: Alternatively to installing the MailStore Client application manually, you can also deploy it to the client
computer though the Active Directories Group Policy feature. More information on that can be found in the
article MailStore Client Deployment

If an update is installed on the MailStore Server computer, MailStore Client updates itself automatically on first
login to stay compatible with MailStore Server. Therefore a re-installation of MailStore Client is usually not
required.

Starting and Login
Start MailStore Client by using the appropriate link on the desktop. The window Connect to E-mail Archive
appears.

Enter the hostname or IP address of
the computer on which the MailStore
Server Service is installed into Server
Name. Be aware, that the pre-filled
entry localhost only works if the
MailStore Client is run from the same
machine where the MailStore Server
Service is installed. Click OK to
connect to MailStore Server. You may
be asked to trust the MailStore
Server; click OK here.

Hint: Did you activate the option
Always connect to this server and you want to change the destination server later? Hold the Shift key pressed
while opening MailStore Client.

https://help.mailstore.com/en/server/index.php?title=MailStore_Client_Deployment
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The login window appears.
Enter the username and password of
a MailStore administrator (admin) or
a normal MailStore user into the User
Name and Password fields and click
OK.

The MailStore Folder Structure
For each user, MailStore creates a folder on the highest level of the folder
structure which corresponds to the archive of the respective user. It contains
all emails that were archived for this user and is labeled My Archive.

If the user has access to the archives of other MailStore users (as MailStore
administrator, for example), their folders are listed as Archive of <User Name>
under the top level folder Other Archives

Below these main folders, the individual email sources (e.g. Microsoft Outlook
or Exchange mailboxes) and their folder structures (e.g. Inbox) are listed.

Notice: For MailStore administrators, accessing the archives of other users via
the folder structure is blocked by default; this setting can be changed in the
compliance settings. Additionally, MailStore administrators can manage
archives via the Archives page.

Deleting Folders
Folders and the emails contained therein can only be deleted after the
appropriate user privileges have been assigned explicitly by the administrator.
If the folder to be deleted contains any subfolders, they will be deleted as well.

Moving, Renaming, and Creating Folders
Manually
Within MailStore, folders can be moved, renamed or created. Regular users can
only do this within their own user archive, while MailStore administrators can
move and rename folders beyond the boundaries of user archives.During the
archiving process, MailStore adopts the folder structure and the folder names
of the source (e.g. Microsoft Outlook).

MailStore sorts all archived email into MailStore's own folder structure. Below the main folders, the individual
email sources (e.g. Microsoft Outlook or Exchange mailboxes) and their folder structures (e.g. Inbox) are listed.
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Viewing the Emails in a Folder
To view the emails in a folder, simply click on the folder name. The emails will
be listed below the folder structure.

Click on the text Sorted by: <value> to change the order in which emails are
displayed. Emails can be sorted according to:

•• Date

•• From/To (sender/recipient of the email)

•• Subject

Click on the Field to the right of Sorted by ("New to Old" in the screenshot) to
reverse the order in which emails are arranged. By default, the latest email is
displayed first.

Refreshing the View
To refresh the list of folders, click on a folder and press F5 on your keyboard.

Click on the folder again to refresh the list of emails.

Starting an Advanced Search in a Folder
To start an advanced search in a folder, right click on the folder and select
Search here.... The advanced search is shown and the folder is preselected.

Quick Search
With quick search you can browse all emails located in the archives you have access to. This feature is especially
suitable for simple queries; alternatively, the advanced search can be used.

Using Quick Search
The input field is located in the upper left part of the MailStore Client. Simply enter one or more keywords and
press ENTER. The search results are displayed. Keywords which appear in the header or the subject line are
highlighted.

Searching for Word Fragments
To display all emails containing a word with a particular fragment, use the wildcard character (*). For example:

auto*

will return auto, automatic, automobile etc.

*example.com

will return all email addresses and domains of example.com.

firstname.lastname*

will return all email addresses of firstname.lastname.
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Searching for Words with unknown letters
To view all emails containing a word where you do not know how to spell it correctly, you can use the question
mark (?). For example

Me?er

would locate Meier and Meyer, but not Maier.

The question mark (?) cannot be used at the beginning of a word or at the end of a word, use the wildcard
character (*) instead.

Searching for Phrases
To search for words appearing consecutively and in a specific order, use quotation marks (""). For example:

"Microsoft Windows"

will return the text Microsoft Windows but not Microsoft Works or Windows 95.

Narrowing by Fields
A search for keywords or phrases can be limited to specific fields. For example:

subject:News                  only in Subject
from:john@mailstore.com       only in From
to:michael@mailstore.com      only in To
cc:lisa@mailstore.com         only in Cc
bcc:customers@mailstore.com   only in Bcc
bcontent:billing              only in Body of message
acontent:billing              only in Attachments of message

Excluding Words
To narrow a search, you may want to specify words which must not be present in the emails. To exclude words
from the search results, prepend the word with the minus character (-). For example:

ZDNet -download-tip

returns all emails from ZDNet which do not contain download-tip.

Combining Search Options
Any of the search options described above can be combined. For example:

ZDNET -"Daily Update"

returns all emails from ZDNet which do not contain the consecutive words Daily Update.

from:ZDNET bcontent:MailStore

returns all emails from ZDNET which have MailStore somewhere in their message body.

from:billing@example.com acontent:bill

returns all emails from billing@example.com which have bill in any attachment.

to:recruiting@example.com -sales

returns all emails to recruiting@example.com which do not have sales in any part of the email.

from:billing@example.com to:myaddress@company.tld acontent:bill -subject:admonition

returns all message from billing@example.com to myaddress@company.tld which have bill in any attachment
but do not have admonition in the subject.
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About Special Characters
Words inside indexed emails or attachments which are a combination of alphanumeric (letters, digits) and
non-alphanumeric characters (white space, line break, delimiter or other control characters), may be returned in
search results when searching for the alphanumerical part only.

For instance, when searching for firstname, firstname.lastname and lastname, e-mails containing
the word firstname.lastname will be returned.

Commonly occurring characters are:

•• Period (.)
•• Comma (,)
•• Colon (;)
•• Hyphen (-)
•• Underscore (_)
•• AT-Sign (@)
• Slash & Backslash (/,\)
•• Null character (NUL)

Advanced Search
With MailStore's integrated advanced search, complex queries can be executed which may not only refer to the
email content but also parameters such as the date or the email size.

Using the Advanced Search
In the MailStore Client, click on Search Email and enter the search parameters. The criteria are AND-combined,
i.e. the search returns only those emails that satisfy all criteria. Click on Search to start the search.
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Search Criteria under "Search"
Enter a keyword or phrase into the text field and specify where MailStore is to conduct the search. The following
options are available:

• Subject - The subject line of the email is searched.
• Sender/Recipient - The fields "From", "To", "Cc", and "Bcc" are searched.
• Message body - The text-only or HTML sections of the email are searched (depending on availability).
• Attachments File Names - The file names of the email attachments are searched.
• Attachment Contents - The contents of the email attachments are searched. If and to what extent

attachments can be searched depends on the indexing options specified (under Administrative Tools).
All options described in section Quick Search, such as phrases and wildcards, are available in the textfield Search
for as well.

Search Criteria under "General"
Under General, the following options are available:

• Folder - The folder to be searched by MailStore can be selected here. By default, all folders readable by the
current user are selected. By clicking the button next to the text field, folders can also be selected using
the folder structure.

• Include subfolder - If selected, MailStore not only searches the selected folder (e.g. Inbox), but all
subfolders created therein (e.g. Inbox / Projects 2008 / Profit Optimization) as well.

• From - Any keywords or email addresses entered here are searched for within the email's sender field only.
• To/Cc/Bcc - Any keywords or email addresses entered here are searched for within the email's recipient

fields only.
• Date - The time frame the search is to cover can be selected here. Either a predefined range, such as

Yesterday or This year, can be selected or, by choosing Custom, a specific period can be specified manually.
In this case, the start and end dates will be included.

• Archiving Date - The archiving time frame the search is to cover can be selected here. Either a predefined
range, such as Yesterday or This year, can be selected or, by choosing Custom, a specific period can be
specified manually. In this case, the start and end dates will be included.

All options described in section Quick Search, such as phrases and wildcards, are available in the fields From and
To/Cc/Bcc as well.

Search Criteria under "Advanced"
Under Advanced, the following options are available:

• File Group - If the archive consists of more than one file group, the search can be limited to just one of the.
By default all file groups are searched.

• Messages with/without attachments - By default, all messages are searched, regardless of whether or
not they have any file attachments. Clear one of the check boxes to remove certain emails, such as those
without attachments, from the results.
Important: These searches can be imprecise at times because items like background pictures could be
regarded as attachments.

• Size - By default, all messages are searched regardless of their size. Use the appropriate fields provided to
limit the search according to the size of the emails, e.g. at least 5 MB or between 400 and 600 KB.

• Priority - Emails are searched according to the priority level of the email as assigned by the sender. When
choosing Low, all emails with a priority level lower than Normal are returned, when choosing High, all
emails with a priority level higher than Normal are returned. Emails not containing any information
regarding priority are assumed to have a priority level of Normal.
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Starting the Search
Click on Search to start the search. Results are displayed in a list in the left section of the main window.

Refining the Search Results
Click on Search Email again to further narrow the results after a search has been executed. Specify any additional
search criteria and click on Search once more.

Starting a New Search
Click on New Query to start a new search. All search criteria will be reset to their default values (i.e. an
unrestricted search of the folders readable by the current user).

Saving Search Criteria for Reuse
Search criteria that are used repeatedly (such as "all receipts from last month") can be saved and reused at a
later time: Click on Create Search Folder... and provide a meaningful name for the search.

The new search folder will be available under the Search Email folder on the left side of the application window.

Through the context menu you can view the search criteria of a search folder (New Search Query) and rename or
delete it.

About Special Characters
Words inside indexed emails or attachments which are a combination of alphanumeric (letters, digits) and
non-alphanumeric characters (white space, line break, delimiter or other control characters), may be returned in
search results when searching for the alphanumerical part only.

For instance, when searching for firstname, firstname.lastname and lastname, e-mails containing
the word firstname.lastname will be returned.

Commonly occurring characters are:

•• Period (.)
•• Comma (,)
•• Colon (;)
•• Hyphen (-)
•• Underscore (_)
•• AT-Sign (@)
• Slash & Backslash (/,\)
•• Null character (NUL)
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Email Preview
MailStore offers an integrated email preview displaying emails the same way as standard email applications. To
activate the preview, simply click on an email or use the arrow keys to highlight the desired email in the list.

The menu bar above the email preview shows all functions available for the email currently displayed.

Save as...
Click on Save as... to save the current email in any Windows folder. Emails can be saved in the following file
formats:

• RFC822 EML - These files can be opened independently from MailStore by double-clicking and can be
moved to applications such as Mozilla Thunderbird by drag & drop.

• Outlook MSG - These files can be opened with or imported to all versions of Microsoft Outlook directly.

Print
Using the print function the email currently displayed will be printed including header information such as Date
and Subject.

Find in Email
Click on Find in Email... to search the message body of the current email.
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Internet Headers...
Click on Internet Headers to view the header of the current email, including all MIME parts.

Message Source
Click on Message Source to show the full source of the current message including all MIME-parts.

Delete (only with the appropriate privilege)
Click on Delete to delete the current email from the archive. Please keep in mind that, in order to use this
function, the appropriate privilege has to be in place.

Retention Details (Administrators only)
This button is only available if retention policies are configured and enabled.

Click on Retention Details to view the
minimum and maximum retention
date and the corresponding retention
policies if applicable.

By clicking on a retention policy you
can view its configuration directly.

Reopening Emails in an
Email Application
Emails previewed in MailStore can be
reopened in any email application to reply to or forward them. Select an email client you want to open email
messages in first, by clicking on Email Client:. MailStore only lists email clients that are supported and that are
installed on the computer from which MailStore Client is executed.

Depending on the selected email client, additional button may be visible:

• Open in <email client> - Open the current message to the selected email client. Please note, that emails
are simply opened, not stored, in the application. To restore emails to an email application, please use
MailStore's Export Feature.

• Restore to <email client>... - Restore the current message to the selected email client. If further settings
are required an additional button Settings.. will be shown.
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3.3 Accessing the Archive with MailStore
Web Access
The responsive Web Access makes the archive accessible through any current internet browser on any device.
This way, important functions such as browsing and viewing archived messages can be made available without
having to install additional software.

Please note: This site describes the new responsive Web Access available since version 10.2. Please refer to
MailStore Web Access (Legacy) for information about the previous Web Access.

Requirements for Using Web Access
Activation and configuration of Web Access is done in the MailStore Server Service Configuration. A list of
supported internet browsers can be found in the System Requirements.

In order to use the Restore to Mailbox feature an administrator needs to configure the SMTP settings under
Administrative Tools > Miscellaneous > SMTP Settings first.

Accessing Web Access
For security reasons, the responsive Web Access is only available through HTTPS. Unless configured differently,
users can use the following URL:

https://<servername>:8462

Please replace <servername> with the actual name of the server.

To log in to the Web Access, fill out the Username and Password fields and click Sign in.

Search Archive

Searching for Word Fragments
To display all emails containing a word with a particular fragment, use the wildcard character (*). For example:

auto*

will return auto, automatic, automobile etc.

*example.com

will return all email addresses and domains of example.com.

firstname.lastname*

will return all email addresses of firstname.lastname.

https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_MailStore_Web_Access_%28Legacy%29
https://help.mailstore.com/en/server/index.php?title=System_Requirements%23MailStore_Web_Access
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Searching for Words with unknown letters
To view all emails containing a word where you do not know how to spell it correctly, you can use the question
mark (?). For example

Me?er

would locate Meier and Meyer, but not Maier.

The question mark (?) cannot be used at the beginning of a word or at the end of a word, use the wildcard
character (*) instead.

Searching for Phrases
To search for words appearing consecutively and in a specific order, use quotation marks (""). For example:

"Microsoft Windows"

will return the text Microsoft Windows but not Microsoft Works or Windows 95.

Narrowing by Fields
A search for keywords or phrases can be limited to specific fields. For example:

subject:News                  only in Subject
from:john@example.com         only in From
to:michael@example.com        only in To
cc:lisa@example.com           only in Cc
bcc:customers@example.com     only in Bcc
bcontent:billing              only in Body of message
acontent:billing              only in Attachments of message

Excluding Words
To narrow a search, you may want to specify words which must not be present in the emails. To exclude words
from the search results, prepend the word with the minus character (-). For example:

ZDNet -download-tip

returns all emails from ZDNet which do not contain download-tip.

Combining Search Options
Any of the search options described above can be combined. For example:

ZDNET -"Daily Update"

returns all emails from ZDNet which do not contain the consecutive words Daily Update.

from:ZDNET bcontent:ACME

returns all emails from ZDNET which have ACME somewhere in their message body.

from:billing@example.com acontent:bill

returns all emails from billing@example.com which have bill in any attachment.

to:recruiting@example.com -sales

returns all emails to recruiting@example.com which do not have sales in any part of the email.

from:billing@example.com to:myaddress@company.tld acontent:bill -subject:admonition

returns all message from billing@example.com to myaddress@company.tld which have bill in any attachment
but do not have admonition in the subject.
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Search Criteria
The following options are available:

Scope
• Subject - The subject line of the email is searched.
• Sender/Recipient - The fields "From", "To", "Cc", and "Bcc" are searched.
• Message body - The text-only or HTML sections of the email are searched (depending on availability).
• Attachments File Names - The file names of the email attachments are searched.
• Attachment Contents - The contents of the email attachments are searched. If and to what extent

attachments can be searched depends on the indexing options specified (under Administrative Tools).

Folder
The folder to be searched can be selected here. By default, all folders readable by the current user are selected.

• Include subfolder - If selected, not only the selected folder (e.g. Inbox) is searched, but also all subfolders
created therein (e.g. Inbox / Projects 2008 / Profit Optimization).

From
Any keywords or email addresses entered here are searched for within the email's sender field only.

Phrases and wildcard searches are supported in this field.

To/Cc/Bcc
Any keywords or email addresses entered here are searched for within the email's recipient fields only.

Phrases and wildcard searches are supported in this field.

Date
The time frame the search is to cover can be selected here. Either a predefined range, such as Yesterday or This
year, can be selected or, by choosing Custom, a specific period can be specified manually. In this case, the start
and end dates will be included.

Size
By default, all messages are searched regardless of their size. Use the appropriate fields provided to limit the
search according to the size of the emails, e.g. at least 5 MB or between 400 and 600 KB.

Attachments
By default, all messages are searched, regardless of whether or not they have any file attachments. Clear one of
the check boxes to remove certain emails, such as those without attachments, from the results.

Important: These searches can be imprecise at times because items like background pictures could be regarded
as attachments.

Priority
Emails are searched according to the priority level of the email as assigned by the sender. When choosing Low,
all emails with a priority level lower than Normal are returned, when choosing High, all emails with a priority
level higher than Normal are returned. Emails not containing any information regarding priority are assumed to
have a priority level of Normal.

About Special Characters
Words inside indexed emails or attachments which are a combination of alphanumeric (letters, digits) and
non-alphanumeric characters (white space, line break, delimiter or other control characters), may be returned in
search results when searching for the alphanumerical part only.

For instance, when searching for firstname, firstname.lastname and lastname, e-mails containing
the word firstname.lastname will be returned.
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Commonly occurring characters are:

•• Period (.)
•• Comma (,)
•• Colon (;)
•• Hyphen (-)
•• Underscore (_)
•• AT-Sign (@)
• Slash & Backslash (/,\)
•• Null character (NUL)

Browse Archive
The folder My Archive contains all emails that were archived from your mailboxes. If you have read-access to the
archives of other users, their emails are located in the folders labeled Archive of <user name>.

To list the emails of a specific folder, simply click on the folder name.

Email Preview
The email preview displays a message with its original formatting. For security reasons, contents and images
that are referenced externally will be downloaded and displayed only upon request.

Open Email in Email Application
The toolbar item Open provides access to the functions Open as MSG and Open as EML. This allows users to open
the displayed message in an external email application such as Microsoft Outlook (MSG), Mozilla Thunderbird
(EML) or other. These may be used to answer or forward archived emails.

Restore Email
The toolbar item Restore allows to send the displayed message to an arbitrary email address.

Please note: Before this function can be used preparations have to be done by an administrator. Please refer to
SMTP Settings for more information.

Print Email
The toolbar item Print allows users to print the displayed message.

Show Internet Headers
The toolbar item Internet Headers shows the internet headers of the displayed message as well as all MIME parts.

User Menu

Settings
By default the Web Access uses the same regional settings as the user's web browser. The regional settings can
also be specified manually in the Web Access' settings dialog.
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Help
Open this online help website.

About
Displays legal information such as Licensing Terms and Conditions, 3rd Party Licenses, and Privacy Policy.

Sign out
Signs the current user out of the Web Access.
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3.4 Accessing the Archive with the Microsoft
Outlook integration
MailStore users can access their archives using a convenient add-in for Microsoft Outlook. A list of supported
Microsoft Outlook versions can be found under System Requirements.

Requirements
MailStore Server should be in use and the add-in for Microsoft Outlook should be installed on the appropriate
machine. In this case, a toolbar (up to 2007) or a tab (Outook 2010 or later) labeled "MailStore" will be visible in
Microsoft Outlook.

Image: MailStore toolbar in Microsoft Outlook 2007

Image: MailStore tab in Microsoft Outlook 2010

Image: MailStore tab in Microsoft Outlook 2013

Installation & Update
The MailStore Outlook Add-In setup file that matches your MailStore Server version is stored on the MailStore
Server machine. Follow the Install MailStore Client on other Computers link on your desktop and copy the
corresponding setup file to the client computer.

It is a regular Windows setup program, that can by executed on the appropriate client computer by
double-clicking on the setup file. Just follow on-screen instructions.

Notice: Alternatively to installing the MailStore Outlook Add-In application manually, you can also deploy it to
the client computer though the Active Directories Group Policy feature. More information on that can be found in
the article MailStore Outlook Add-in Deployment

If an update is installed on the MailStore Server computer, MailStore Outlook Add-In usually stays compatible
with MailStore Server. Therefore a re-installation of MailStore Outlook Add-In is usually not required.

https://help.mailstore.com/en/server/index.php?title=System_Requirements%23MailStore_Outlook_Add-in
https://help.mailstore.com/en/server/index.php?title=MailStore_Outlook_Add-in_Deployment
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Login to MailStore Server
If the MailStore Outlook Add-in is not pre-configured, you will be asked to log in to MailStore Server as soon as
you click any button in the MailStore Outlook Add-in. Please refer to your system administrator for the server
name and your access data.

Deleting Saved Access Data
If you would like to log in to a different server or use different access data, you may have to delete the existing
access information saved in Microsoft Outlook. Please proceed as follows:

• Click on Settings in the MailStore Outlook Add-in
• Click on Clear Cached Credentials.
• Click on OK.
•• Click on any button in the add-in to go back to the login window.

Technical Considerations
•• The MailStore Outlook Add-in uses the HTTP server integrated in MailStore Server to access the archive.
• If a valid SSL certificate was selected within the MailStore Server Service Configuration, you can mark the

checkbox Secure Connection in the Outlook Add-in settings to use HTTPS instead of HTTP.
• If you have changed the configuration of the HTTP/HTTPS ports within the MailStore Server Service

Configuration (the default HTTP port is 8461, the default HTTPS port is 8462), you must include the port
number when logging in. Simply append the port number to the server name, separated by a colon (for
example: mailstore:443)
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Search by Archive Folder

Display of the Archive Folder
In the MailStore Outlook Add-in, click on Browse Archive to display the part
of the archive that is visible to you.

User Archives
The folder My Archive contains all emails that were archived from your
mailboxes. If you have read-access to the archives of additional users,
their emails are located in the folders labeled Archive of <user name>.

Display of Emails in a Folder
To view the emails of a specific folder, simply click on the folder name. The
emails are listed below the tree structure.

With quick search you can browse all emails located in the archives you have access to. This feature is especially
suitable for simple queries; alternatively, the advanced search can be used.

Using Quick Search
The input field is located in the left part of the MailStore Outlook Add-In. Simply enter one or more keywords and
press ENTER. The search results are displayed. Keywords which appear in the header or the subject line are
highlighted.

Searching for Word Fragments
To display all emails containing a word with a particular fragment, use the wildcard character (*). For example:

auto*

will return auto, automatic, automobile etc.

*example.com

will return all email addresses and domains of example.com.

firstname.lastname*

will return all email addresses of firstname.lastname.

Searching for Words with unknown letters
To view all emails containing a word where you do not know how to spell it correctly, you can use the question
mark (?). For example

Me?er

would locate Meier and Meyer, but not Maier.

The question mark (?) cannot be used at the beginning of a word or at the end of a word, use the wildcard
character (*) instead.

Searching for Phrases
To search for words appearing consecutively and in a specific order, use quotation marks (""). For example:

"Microsoft Windows"
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will return the text Microsoft Windows but not Microsoft Works or Windows 95.

Narrowing by Fields
A search for keywords or phrases can be limited to specific fields. For example:

subject:News                  only in Subject
from:john@mailstore.com       only in From
to:michael@mailstore.com      only in To
cc:lisa@mailstore.com         only in Cc
bcc:customers@mailstore.com   only in Bcc
bcontent:billing              only in Body of message
acontent:billing              only in Attachments of message

Excluding Words
To narrow a search, you may want to specify words which must not be present in the emails. To exclude words
from the search results, prepend the word with the minus character (-). For example:

ZDNet -download-tip

returns all emails from ZDNet which do not contain download-tip.

Combining Search Options
Any of the search options described above can be combined. For example:

ZDNET -"Daily Update"

returns all emails from ZDNet which do not contain the consecutive words Daily Update.

from:ZDNET bcontent:MailStore

returns all emails from ZDNET which have MailStore somewhere in their message body.

from:billing@example.com acontent:bill

returns all emails from billing@example.com which have bill in any attachment.

to:recruiting@example.com -sales

returns all emails to recruiting@example.com which do not have sales in any part of the email.

from:billing@example.com to:myaddress@company.tld acontent:bill -subject:admonition

returns all message from billing@example.com to myaddress@company.tld which have bill in any attachment
but do not have admonition in the subject.

About Special Characters
Words inside indexed emails or attachments which are a combination of alphanumeric (letters, digits) and
non-alphanumeric characters (white space, line break, delimiter or other control characters), may be returned in
search results when searching for the alphanumerical part only.

For instance, when searching for firstname, firstname.lastname and lastname, e-mails containing
the word firstname.lastname will be returned.

Commonly occurring characters are:

•• Period (.)
•• Comma (,)
•• Colon (;)
•• Hyphen (-)
•• Underscore (_)



Accessing the Archive with the Microsoft Outlook integration 81

•• AT-Sign (@)
• Slash & Backslash (/,\)
•• Null character (NUL)

Advanced Search
With MailStore's integrated advanced search, complex queries can be executed which may not only refer to the
email content but also parameters such as the date or the email size.

Using the Advanced Search
In the MailStore Outlook Add-In, click on Advanced Search and enter the search parameters. The criteria are
AND-combined, i.e. the search returns only those emails that satisfy all criteria. Click on Search to start the
search.

Search Criteria under "Extended Search"
Enter a keyword or phrase into the text field and specify where MailStore is to conduct the search. The following
options are available:

• Subject - The subject line of the email is searched.
• Sender/Recipient - The fields "From", "To", "Cc", and "Bcc" are searched.
• Message body - The text-only or HTML sections of the email are searched (depending on availability).
• Attachments File Names - The file names of the email attachments are searched.
• Attachment Contents - The contents of the email attachments are searched. If and to what extent

attachments can be searched depends on the indexing options specified (under Administrative Tools).
All options described in section Quick Search, such as phrases and wildcards, are available in the textfield Search
for as well.
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Search Criteria under "General"
Under General, the following options are available:

• Folder - The folder to be searched by MailStore can be selected here. By default, all folders readable by the
current user are selected. By clicking the button next to the text field, folders can also be selected using
the folder structure.

• Include subfolder - If selected, MailStore not only searches the selected folder (e.g. Inbox), but all
subfolders created therein (e.g. Inbox / Projects 2008 / Profit Optimization) as well.

• From - Any keywords or email addresses entered here are searched for within the email's sender field only.
• To/Cc/Bcc - Any keywords or email addresses entered here are searched for within the email's recipient

fields only.
• Date - The time frame the search is to cover can be selected here. Either a predefined range, such as

Yesterday or This year, can be selected or, by choosing Custom, a specific period can be specified manually.
In this case, the start and end dates will be included.

• Archiving Date - The archiving time frame the search is to cover can be selected here. Either a predefined
range, such as Yesterday or This year, can be selected or, by choosing Custom, a specific period can be
specified manually. In this case, the start and end dates will be included.

All options described in section Quick Search, such as phrases and wildcards, are available in the fields From and
To/Cc/Bcc as well.

Search Criteria under "Extended"
Under Extended, the following options are available:

• Messages with/without attachments - By default, all messages are searched, regardless of whether or
not they have any file attachments. Clear one of the check boxes to remove certain emails, such as those
without attachments, from the results.
Important: These searches can be imprecise at times because items like background pictures could be
regarded as attachments.

• Size - By default, all messages are searched regardless of their size. Use the appropriate fields provided to
limit the search according to the size of the emails, e.g. at least 5 MB or between 400 and 600 KB.

• Priority - Emails are searched according to the priority level of the email as assigned by the sender. When
choosing Low, all emails with a priority level lower than Normal are returned, when choosing High, all
emails with a priority level higher than Normal are returned. Emails not containing any information
regarding priority are assumed to have a priority level of Normal.

Starting a Search
Click on Search to start the search. The results are displayed in a list.

Refining the Search Results
To narrow the results after a search has been executed, click on Advanced Search again, enter additional search
criteria and click on Search.

Starting a New Search
To start a new search, click on New Query. All search criteria will be reset to their default values (i.e. no
restrictions; the search covers all folders readable by the current user).

Saving a Search
Search criteria that are used repeatedly (such as "all receipts from the last month") can be saved and reused at
any time. Click on Save As... and choose a meaningful name for the search. Click on Open to access, edit or restart
the search.
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About Special Characters
Words inside indexed emails or attachments which are a combination of alphanumeric (letters, digits) and
non-alphanumeric characters (white space, line break, delimiter or other control characters), may be returned in
search results when searching for the alphanumerical part only.

For instance, when searching for firstname, firstname.lastname and lastname, e-mails containing
the word firstname.lastname will be returned.

Commonly occurring characters are:

•• Period (.)
•• Comma (,)
•• Colon (;)
•• Hyphen (-)
•• Underscore (_)
•• AT-Sign (@)
• Slash & Backslash (/,\)
•• Null character (NUL)

Email Display
To view an email which was returned by one of the search functions described above, simply click on it. A
preview of the email is displayed on the right side of the screen.

Please keep in mind that images and any formatting will not be displayed in the preview for security reasons.
Emails cannot be forwarded or replied to within the preview, either.

For a comprehensive view of an archived email and the ability to use all the Microsoft Outlook features such as
printing, forwarding and replying, click on Open Email in the MailStore Outlook Add-in. The email will be loaded
from the archive and displayed, either immediately or after a few seconds depending on size.

Restoring Emails to the Application
To restore an archived email which is no longer in your mailbox
to Outlook, please proceed as follows:

•• Locate the email within the archive and open it.

• In the MailStore Outlook Add-in, click on Restore Message.

•• Drag and drop the envelope icon into an Outlook email
folder or a Windows Explorer file system folder.

•• The email is restored immediately or after a few seconds,
depending on its size.

Changing Regional Settings
By default the MailStore Outlook Add-in uses the same regional settings as Microsoft Outlook. The regional
settings can also be set manually in the MailStore Outlook Add-in settings dialog.
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3.5 Accessing the Archive using other Email
Clients
With MailStore's integrated IMAP server you can access the MailStore archive in read-only mode with any
IMAP-enabled email client. This provides a convenient way to access the email archive using not only many
alternative email clients running on any operating system (e.g. MacOS or Linux) but also through mobile
platforms such as Android or IPhone. Installing MailStore Client on the user machines is not required.

Prerequisite for Using the MailStore-Integrated IMAP Server
Activation and configuration of the integrated IMAP server are done using the MailStore Server Service
Configuration. All IMAP-enabled email clients that support encrypted connections are supported, since the
integrated IMAP server refuses the login over unencrypted connections.

Accessing the Integrated IMAP Server
Unless the integrated IMAP server is configured otherwise, users can access MailStore Server using the following
settings:

• Incoming Mail Server - Host name or IP address of the MailStore server
• Port - For STARTTLS-encrypted connections (explicit TLS) the standard IMAP port 143 is used. For implicit

TLS-encrypted connections the standard IMAP port 993 is used.
• User Name - Name of the MailStore user.
• Password - Password which is required for accessing the MailStore server.

Please note: In addition to configuring the incoming mail server, email clients often require configuring the
outgoing mail server as well. In this case, using the same data as for an existing email account will facilitate
further processing emails from the email archive.

Configuring Mobile Devices
In addition to providing access for alternative email clients or for non-Windows operating systems, using the
integrated IMAP server is especially useful for mobile devices. The following articles provide detailed information
on how to configure an email account for accessing the integrated IMAP server:

•• Accessing the Archive from iOS Based Devices
•• Accessing the Archive from Android Based Devices

https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_from_iOS_Based_Devices
https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_from_Android_Based_Devices
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4.1 Exporting Email
MailStore provides several functions regarding the export of archived emails. Emails can be exported directly
into server mailboxes, or to the file system as individual email files (EML or MSG format), for example.

Please note: Backup strategies (a backup of the entire archive) are discussed separately in the article Backup
and Restore.

Available Export Destinations

Email Server
• Exchange mailbox - A folder named MailStore Export is created in the Exchange mailbox into which emails

are copied.
• Google Apps - A folder named MailStore Export is created in a Google Apps mailbox into which emails are

copied.
• Gmail - A folder named MailStore Export is created in a Gmail mailbox into which emails are copied.
• IMAP mailbox - A folder named MailStore Export is created in an IMAP mailbox into which emails are

copied.

Email Clients
• Microsoft Outlook - A folder named MailStore Export is created in Microsoft Outlook into which emails are

copied.
• Windows Mail - A folder named MailStore Export is created in Windows Mail into which emails are copied.
• Mozilla Thunderbird - A folder named MailStore Export is created in Mozilla Thunderbird into which emails

are copied.
• Mozilla SeaMonkey - A folder named MailStore Export is created in Mozilla SeaMonkey into which emails

are copied.

Email Files
• Directory (File System) - Either EML or MSG files are created (one per email). The option Sign Export

allows to ensure integrity of the exported data outside of the archive. Refer to Verifying a Signed Export for
further details on how to verify integrity.

• Outlook PST File - A folder named MailStore Export is created in a Microsoft Outlook PST file into which
emails are copied.

Please note: EML files can be opened independently from MailStore by double-clicking and moving to
applications such as Mozilla Thunderbird via drag & drop. Outlook MSG files can be opened or archived directly
with all versions of Microsoft Outlook.

Starting an Export
Using the email preview - To export an email currently displayed in the Email Preview, click on Export in the
menu bar above the preview and select the export destination. A window appears in which additional settings
may have to be specified.

Using the list of emails (folder contents or search results) - Highlight the emails to be exported by holding
down the control key (Ctrl) and right-clicking onto the emails. Pressing Ctrl and A highlights all emails. Click
Export To and select the export destination. A window appears in which additional settings may have to be
specified.

Using the page "Export Email" - On this page, exporting tasks can be created and executed as export profiles
(just like archiving profiles). Export profiles hold information about which emails will be exported to which
destination. Each profile (i.e. the exporting task) can be executed manually or regularly according to a schedule.
To learn more, please read on in the next section.

https://help.mailstore.com/en/server/index.php?title=Verifying_a_Signed_Export
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Working with Exporting Profiles
In MailStore, every exporting task is stored as an exporting profile. The exporting process is started by executing
such a profile.

Such an exporting profile could contain the following information:

•• WHAT: Mailbox p.berten@company.com
•• TO: Exchange server EXCHANGE01
•• SCOPE: All folders except drafts

Like archiving profiles, existing export profiles can be executed, modified, deleted or even executed
automatically. Further details can be found in the chapters
[[Email_Archiving_with_MailStore_Basics#Working_with_Archiving_Profiles Working with Archiving Profiles]]
and Automating the Archiving Process

Important notice: Be aware that an export does not verify if the messages already exist in the destination.
Therefore duplicates are created in the selected destination when re-executing an export profile multiple times.
Thus is is not recommended to automate the execution of export profiles. Only exception is the Directory (File
System) export profile, where MailStore is able to do a comparison based on the file names.

Creating an Export Profile
To create a new export profile, please proceed as follows:

•• Start MailStore Client on the computer which is to execute the export. Log on as administrator if the emails
of other users are to be exported as well. Only a MailStore administrator is allowed to export the emails of
others.

• In MailStore, click on Export Email.

• From the lists in the upper Create Profile area, select the destination to which emails are to be exported.
•• A wizard opens to assist in specifying the export settings.
• At the first step, specify which folder is to be exported (subfolders are always included). Depending on the 

export destination, the file format to be used (e.g. EML , MSG or database backup) can be selected as well. 
Click on Next.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Automating_the_Archiving_Process
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Please note: Below the list of folders, a saved search can also be selected. MailStore runs the search
before executing the actual export procedure; all emails returned by the search will be exported.

• At the second step, specify the exact target location to which emails are to be exported. For example, if
Exchange Mailbox was selected as export destination earlier, the access data for the target mailbox can be
specified and verified by clicking on Test. Then click on Next.

• Depending on the export destination specified, additional settings can be selected at the next step. For
example, if IMAP mailbox was selected as the destination, a timeout value can be set, if needed.

• At the last step, a name for the export profile can be specified. After clicking on Finish, the profile will be
listed under Saved Profiles and can be run immediately, if desired.



Chapter
5

Administration
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5.1 Users, Folders and Settings

User Management
When emails are archived, they are always assigned to individual users (the original owners of the emails). Every
MailStore user has his or her own user archive which is created automatically upon setting up the new user
account. For this reason, before any emails can be archived, the appropriate user accounts have to be created
first.

Options for the Setup of New User Accounts
•• Adding users manually (described here)
• Synchronizing User Accounts with Active Directory
• Synchronizing User Accounts with an Application Integration Server
• Synchronizing User Accounts with an IceWarp Server
• Synchronizing User Accounts with a Kerio Connect Server
• Synchronizing User Accounts with a generic LDAP Server
• Synchronizing User Accounts with MDaemon USERLIST.DAT

Opening User Management
Log on to MailStore Client as administrator. Click on Administrative Tools > Users and Archives > Users.

Creating a New User
Click on Create New and enter a login name for the new user. This could be a combination of first and last name,
for example. Click on OK to confirm. In the next window, additional settings may be specified. Again, click on OK
to confirm the new settings.

The user is added to the list of users and can be edited at any time, as described in the following section.

Please note: The emails of a new user can be archived right away, no additional settings have to be specified.
However, for the user to be able to log on to MailStore Client, a password has to be created (in the case of
MailStore integrated authentication).

A password must meet the complexity rules. A password must

•• must be at least 10 characters long
•• must not contain the user name
• must not contain the product name MailStore, the comparison is done case insensitive
•• must not contain the same character more than two times in a row
•• must have characters from at least 3 out of 5 character classes. These 5 character classes are:

•• the upper case letters A-Z
•• the lower case letters a-z
•• the digits 0-9
• the special characters !"#$%&'()*+,-./:;<=>?\[]@^_`{|}~ and the space character
•• letters that are neither upper case nor lower case, e.g. Chinese and Japanese letters
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Editing an Existing User Account
Select a user from the list and click on Properties.

•• In the next window, the following settings can be specified:
General Information

• Full Name: Enter first and last name of the user.
• Authentication: If choosing the setting MailStore-integrated, users have to use the password

specified in user management when logging on to MailStore Client. Click on Password... to set the
password. Users can later change their passwords through the Administrative Tools in their
installation of MailStore Client.
Alternatively, the authentication Directory Services can be used. In this case, users can log on to
MailStore using their directory service credential (e.g. Active Directory access data).

• User is an Administrator: Only administrators have access to the administrative functions found in
MailStore Client's Administrative Tools and in the management shell.

Integration (optional)

• LDAP DN String: This information is needed if the user is to be authenticated through an LDAP based
directory service such as Active Directory or other generic LDAP servers.

• Email Addresses: This information is only needed for the following archiving options: MailStore Proxy
Server, Microsoft Exchange Journaling, and archiving multiple Exchange mailboxes synchronously.

• POP3 User Names: This information is only needed for archiving tasks using MailStore Proxy. If the
POP3 user name does not match the user's email address, the user name has to be specified here.

Privileges

Privileges are described separately in section Specifying Privileges. As long as the appropriate
privileges are not set, users are not able to delete any emails from the archive (even their own).

• Click on OK to apply the new settings.

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23Specifying_Privileges
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Renaming Users
Select the user whose name you would like to change from the list of users and click on Rename. In the dialog
window, enter the new user name and click OK.

Please note that the user archive must be renamed manually. The same applies to user privileges, archiving
profiles, scheduled tasks, etc.

Deleting Users
Click on Administrative Tools > User and Archives and then on Users. Select the one or more users from the list,
click on Delete and confirm the next dialog with OK.

Deleting a user has the following effects:

•• Emails that were archived for that user are not being deleted. The corresponding user archive is still
available in MailStore and can be accessed by the administrator or shared with other users through the
privileges system (see below).

•• Archiving and export profiles that belong to that user will be deleted. To preserve them, they have to be
assigned to another user prior to the deletion.

•• The user's license will be released. This license can be used to create a new user account.

Specifying Privileges
To specify the privileges for a user, click on Administrative Tools > Users and Archives and then on Users. Select
the appropriate user from the list and click on Properties.

Please Note: If you highlight multiple users and click on Properties, you can change the privileges for all selected
users in one step.
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The Following Privileges can be Assigned:
Log on to MailStore Server
Only users with this privilege can log on to MailStore Server through MailStore Client. Please note: Without this
privilege, emails can still be archived for the respective user.

Change Password
Only users with this privilege can change their passwords independently by using the button on the start page.
Users without this privilege must use the password created by the administrator in user management (relevant
with MailStore-integrated authentication).

Archive Email
Only users with this privilege can execute archiving profiles independently and thereby archive emails to
MailStore Server. Please note: An administrator can always archive emails for the user regardless of this setting.
Please keep in mind that users can archive emails only if they have write-access to their MailStore user folders.
This setting can be specified under Folder Access (described below).

Unlimited - Users with this privilege can create and edit archiving profiles.

Run existing profiles only - Users with this privilege can only execute already existing archiving profiles
but can neither create new profiles nor modify existing ones.

Manage profiles only - Users with this privilege can modify already existing archiving profiles and create
new ones, but cannot run any profiles.

You can find additional information about this topic in chapter Working with Archiving Profiles

Export Email
Only users with this privilege can export emails from MailStore. Please see chapter Exporting Email for a
description of the many options MailStore offers for email export.

Unlimited - Users with this privilege can create and edit export profiles.

Run existing profiles only - Users with this privilege can only execute already existing export profiles but
can neither create new profiles nor modify existing ones.

Manage profiles only - Users with this privilege can modify already existing export profiles and create new
ones, but cannot run any profiles.

Additional information about this topic can be found in chapter Working with Export Profiles

Delete Email
Only users with this privilege can delete emails from their user archives. Please keep in mind that this privilege
should only be granted with great care, because legal requirements are hard, if not impossible, to meet if users
are allowed to delete their emails independently. Once deleted, emails can only be recovered by restoring a
MailStore backup.

Folder Access (e.g. Access to the Emails of Other Users)
All main folders, which the current user has access to, are listed here. These folders correspond to the archives of
individual MailStore users and contain all their archived emails. By default, users have only access to their own
archives (to read and write, but not to delete). By clicking on Add New, the main folder of another user can be
added to the list of folders accessible by the current user. Then the type of access to be permitted has to be
specified.

The following options are available:

•• Full Access
•• Read
•• Write
•• Delete

From the users' perspective, the folders they have access to appear as entries in the folder structure of MailStore
Client. Please refer to section The MailStore Folder Structure for more information.

Please keep in mind that users can archive emails independently only if they have write-access to their own
folders.

https://help.mailstore.com/en/server/index.php?title=Email_Archiving_with_MailStore_Basics%23Working_with_Archiving_Profiles
https://help.mailstore.com/en/server/index.php?title=Exporting_Email%23Working_with_Export_Profiles
https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23The_MailStore_Folder_Structure
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Overview of all Privileges Regarding Folder Access
To view all privileges regarding folder access, click on Administrative Tools > Users and Archives and then on
Privileges.

The first column shows all user archives, the second column shows the MailStore users that have access to the
respective user archive, and the third column lists the type of access privilege (e.g. Read, Write).
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5.2 Archives
Under Administrative Tools > Users and Archives > Archives you can perform several archive related tasks as well
as view statistical data.

Via context menu you can rename or delete archives. For every user archive, the following statistics are
displayed:

•• Name of the archive
•• Number of emails per user archive
•• Percentage share a user archive has of the total volume based on the MIME size of the email
•• Total size of email per user archive in megabyte

The archives count and the sum over the columns Messages and Total Size MB is shown under the table.

Using the copy function in the lower area of the application window, the information shown can be copied to the
clipboard and pasted into other applications, e.g. Microsoft Excel.
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5.3 Active Directory Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the Active Directory of your company.

During synchronization user information such as user names and email addresses are read from the Active
Directory and recorded in MailStore Server's user database. No changes are made to the Active Directory itself by
MailStore Server. The scope of the synchronization can be limited through filters.

Please note: MailStore Server does support neither subdomains nor domain trusts. The MailStore Server service
must run as 'Local System account' and the server must be a member of the domain if you want to use
'Integrated Windows authentication'.

Accessing Directory Service Integration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
• In the Integration section, change the directory service type to Active Directory.

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
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Connection to Active Directory
For synchronization MailStore Server requires information on how to connect to the Active Directory.

• Server (optional)
DNS name or IP address of an Active Directory domain controller. If the MailStore Server machine is a
member of the Active Directory, this setting is detected automatically.

• Protocol
The protocol used to communicate with an Active Directory domain controller.

• LDAP
The default protocol when accessing an Active Directory. Though parts of the connection is
unencrypted the real payload is encrypted.

• LDAPS
Additionally SSL secured version. Be aware that a properly configured certificate infrastructure is
required, in which the MailStore Server computer must classify the domain controller's certificate as
trustworthy.

• Base-DN (optional)
Base DN of your Active Directory. Often the Base DN can be derived from the Active Directory domain
name. For example, if the Active Directory domain name is company.local the Base DN usually is
dc=company,dc=local. The Base DN can also be selected by clicking the button left of the text field if access
to an Active Directory domain controller is available. If the MailStore Server machine is a member of the
Active Directory, this setting is detected automatically.

• Authentication
Define how the MailStore Server service should identify itself to the Active Directory:

• Standard Authentication
If MailStore Server is not installed directly on an Active Directory domain controller, using standard
authentication is required. In this case, fill out the User Name and Password fields; enter the user
name in UPN notation, e.g. Administrator@company.local

• Windows Authentication
If MailStore Server is installed directly on an Active Directory domain controller, the MailStore Server
service already has the necessary privileges to authenticate against Active Directory using Windows
authentication.

User Database Synchronization
After configuring the connection settings as described above, you can specify filter criteria for the Active
Directory synchronization in this section.

• Synchronize Microsoft Exchange users only
Only user accounts with email addresses configured in Active Directory will be taken into account by the
synchronization. Clear this checkbox only if all Active Directory users should be created as MailStore
Server users as well.

• Synchronize enabled users only
Only user accounts enabled in Active Directory will be taken into account by the synchronization.
Deactivating this option may be useful if certain Exchange mailboxes should be archived whose Active
Directory user accounts are deactivated by default.

• Synchronize users visible in address lists only
Only Active Directory user accounts will be taken into account by the synchronization whose Exchange
mailboxes are not hidden from Exchange address lists.

• Sync only these groups
Choose one or several Active Directory security groups if you only want their members to be created as
MailStore users. That way it's possible to exclude certain Active Directory accounts from being
synchronized to MailStore, e.g. system accounts.

• User Name Format
Choose which naming scheme MailStore user names should follow:

• SAM Account Name
The Pre-Windows 2000 user name.
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• User Principal Name (UPN)
The Windows user name including domain, e.g. jane.doe@example.com

• User Principal Name (UPN) Local Part
The Windows user name excluding domain, e.g. jane.doe

Options
• Automatically delete users in MailStore Server

Here you can choose whether users that have been deleted in the Active Directory will also be deleted in
the MailStore user database by the synchronization. If the archive folder of such a user already contains
archived emails, only the user entry but not its archive folder will be deleted in MailStore. Additionally,
only MailStore users that have their authentication method set to Directory Services will be deleted.

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from an Active Directory have the privilege to
log on to MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.

Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the Active Directory
without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.
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Login with Active Directory Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their Active
Directory username and Active Directory password.

To use Windows-Authentication it is a requirement that the client and the MailStore Server computer are member
of the same domain and that the client is authenticated at the domain controller.

To use Single-Sing-On additional configuration steps are necessary which are described in the articles MailStore
Client Deployment and MailStore Outlook Add-in Deployment.

https://help.mailstore.com/en/server/index.php?title=MailStore_Client_Deployment
https://help.mailstore.com/en/server/index.php?title=MailStore_Client_Deployment
https://help.mailstore.com/en/server/index.php?title=MailStore_Outlook_Add-in_Deployment
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5.4 Application Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the Application Integration Server of your company.

During synchronization user information such as user names and email addresses are read from the Application
Integration Server and recorded in MailStore Server's user database. No changes are made to the Application
Integration Server itself by MailStore Server. The scope of the synchronization can be limited through filters.

Accessing the Directory Service Configuration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
• In the Integration section, change the directory service type to Application Integration.

Connection to Application Integration Server
For synchronization MailStore Server requires information on how to connect to the the Application Integration
server.

• URL
The URL where the Application Integration server is serving requests. When using a self signed or
non-public SSL certificate on the Application Integration server, enable the Ignore SSL warnings option. If
accessing the Application Integration server requires authentication , enable the Server requires
authentication and enter the credential in the following fields:

• User Name
Name of user who has access to the Application Integration server

• Password
Password of the user who has access to Application Integration server

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
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Options
• Automatically delete users in MailStore Server

Here you can choose whether users that have been deleted in the Application Integration Server will also
be deleted in the MailStore user database by the synchronization. If the archive folder of such a user
already contains archived emails, only the user entry but not its archive folder will be deleted in MailStore.
Additionally, only MailStore users that have their authentication method set to Directory Services will be
deleted.

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from Application Integration Server have the
privilege to log on to MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.

Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the Application
Integration Server without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.

You can test the authentication for a user by first selecting him from the list and then clicking on the button on
the lower left. You will now be asked for that user's password. Upon clicking OK you'll receive a message
whether the authentication has been successful.
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Login with Application Integration Server Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their
Application Integration Server username and Application Integration Server password.
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5.5 G Suite Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the G Suite account of your company.

During synchronization user information such as user names and email addresses are read from the G Suite
account and recorded in MailStore Server's user database. No changes are made to the G Suite account itself by
MailStore Server. The scope of the synchronization can be limited through filters.

Prepare the G Suite account
In order to synchronize account information from G Suite, MailStore Server requires a service account which has
been granted permission to access the G Suite account. The same service account is later used for archiving
email from G Suite, too.

Creating a Project
Before MailStore is able to connect to G Suite accounts, a project has to be created. In Google's terminology, a
project is the collection of all settings, credentials and meta data of an application that uses Google Developer
APIs or Google Cloud resources.

• Go to the Google Developers Console [1].
•• If prompted, login using a Google Account with administrative rights.
• Select Create project from the Project drop-down list.
• Name the project, e.g. MailStore API Access and click Create.
• Once the project has been created, the Google APIs Library is shown.
• In the library, enable Admin SDK and Gmail API.
•• In the dashboard, disable any other APIs that have may been enabled automatically during project

creation.
• In Credentials, select Service account key from the Create credentials drop-down list.
• Select New service account from the Service account drop-down list.
•• Enter a name for the service account key. The service account does not require permissions on project

level, therefore do not select a role.
• Select the JSON key type and click on Create.
• Acknowledge the next dialog by clicking Create without role.
• Save the JSON file (e.g. MailStore API Access-e035d2ad4f35.json) to a folder on the

MailStore Server.
• Close the Service account created dialog.
• Click on Manage service accounts.
•• Click on the 3-dots-drop-down list and select "Edit".
• In the "Edit service account" dialog, check the box Enable G Suite Domain-wide Delegation.
• If requested, enter MailStore as Product name for the consent screen.
• Click on Save.
• Click on View Client ID and note the client ID and the email address shown for use in the next step.

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
https://console.developers.google.com/
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Grant access to the required APIs
Once created, grant the project access to the APIs used by MailStore Server's Directory Services module.

• Go to your G Suite domain’s Admin console [2].
• Select Security from the list of controls. If you don't see Security listed, select More controls from the gray

bar at the bottom of the page, then select Security from the list of controls. If you can't see the controls,
make sure you're signed in as an administrator for the domain.

• Click on Basic Settings.
• Make sure that the setting under Less secure apps is not set to Disable access to less secure apps for all

users (Recommended). If it is, choose one of the other options and save the changes.
• Navigate back to Security.
• Select API reference from the list of options.
• Enable the API access and save the changes.
• Select Advanced settings from the list of options. If this section is not visible, click on Show more first.
• Select Manage API client access in the Authentication section.
• In the Client name field enter the service account's Client ID (e.g. 108878593494909748351).
• In the One or More API Scopes field enter the following scopes:
https://mail.google.com/,
https://www.googleapis.com/auth/admin.directory.group.readonly,
https://www.googleapis.com/auth/admin.directory.user.readonly

• Click Authorize.

Accessing Directory Service Integration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
• In the Integration section, change the directory service type to G Suite.

https://admin.google.com/
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Connection to G Suite
For synchronization MailStore Server requires information on how to connect to the G Suite.

• Key ID
To import the private key, select the JSON file (e.g. MailStore API Access-e035d2ad4f35.json)
that has been generated by Google for the service account.

• Service Account
The service account is determined automatically from the JSON file.

• User Name
The email address of a G Suite Administrator (e.g. admin@example.com).

User Database Synchronization
After configuring the connection settings as described above, you can specify filter criteria for the G Suite
synchronization in this section.

• Sync only these groups
Choose one or several G Suite groups if you only want their members to be created as MailStore Server
users. That way it's possible to exclude certain users from being synchronized to MailStore Server.

Options
• Automatically delete users in MailStore Server

Here you can choose whether users that have been deleted in the G Suite Account will also be deleted in
the MailStore user database by the synchronization. If the archive folder of such a user already contains
archived emails, only the user entry but not its archive folder will be deleted in MailStore. Additionally,
only MailStore users that have their authentication method set to Directory Services will be deleted.

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from G Suite Account have the privilege to log
on to MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.

Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the G Suite Account
without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.
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You can test the authentication for a user by first selecting him from the list and then clicking on the button on
the lower left. You will now be asked for that user's password. Upon clicking OK you'll receive a message
whether the authentication has been successful.

Important Notice: For authentication with G Suite to work, the setting Allow less secure apps of the respective
G Suite user has to turned on if it has not been enforced for all users (see above).

Login with G Suite Account Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their G
Suite Account username and G Suite Account password.

References
[1] https:/ / console. developers. google. com/

[2] https:/ / admin. google. com/

https://console.developers.google.com/
https://admin.google.com/
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5.6 IceWarp Server Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the IceWarp Server of your company.

During synchronization user information such as user names and email addresses are read from the IceWarp
Server and recorded in MailStore Server's user database. No changes are made to the IceWarp Server itself by
MailStore Server. The scope of the synchronization can be limited through filters.

Please note: For using this feature, IceWarp Server API 10.4 or newer is required.

Accessing the Directory Service Integration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
• In the Integration section, change the directory service type to IceWarp Server.

Connection to the IceWarp Server
For synchronization MailStore Server requires information on how to connect to the IceWarp Server.

• Server Name
DNS name or IP address of the IceWarp server. If you use a self-signed or non-public SSL certificate on the
IceWarp server, please set a checkmark next to Ignore SSL Security Warnings.

• User Name
Name of a user with administrative privileges on the IceWarp server.

• Password
Password of that user.

• Timout
The timout value for IceWarp API requests. For large IceWarp Server user databases it may be necessary to
increase this value.

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
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Synchronize
After configuring the connection settings as described above, you can specify filter criteria for the IceWarp Server
user database synchronization in this section.

• Domains and Groups
Choose one or more domains or groups to let only their members be created as MailStore Server Users. If
no domains or groups are selected, all users will be synchronized.

Options
• Automatically delete users in MailStore Server

Here you can choose whether users that have been deleted in the IceWarp Server will also be deleted in
the MailStore user database by the synchronization. If the archive folder of such a user already contains
archived emails, only the user entry but not its archive folder will be deleted in MailStore. Additionally,
only MailStore users that have their authentication method set to Directory Services will be deleted.

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from an IceWarp Server have the privilege to
log on to MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.

Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the IceWarp Server
without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.
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You can test the authentication for a user by first selecting him from the list and then clicking on the button on
the lower left. You will now be asked for that user's password. Upon clicking OK you'll receive a message
whether the authentication has been successful.

Important Notice: For authentication with the IceWarp Server to work, the respective MailStore Client has to be
in a network that is trusted by the IceWarp Server.

Login with IceWarp Server Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their
IceWarp Server username and IceWarp Server password.
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5.7 Kerio Connect Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the Kerio Connect of your company.

During synchronization user information such as user names and email addresses are read from the Kerio
Connect and recorded in MailStore Server's user database. No changes are made to the Kerio Connect itself by
MailStore Server. The scope of the synchronization can be limited through filters.

Accessing the Directory Service Integration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
• In the Integration section, change the directory service type to Kerio Connect.

Connection to the Kerio Connect
For synchronization MailStore Server requires information on how to connect to the Kerio Connect.

• Server Name
DNS name or IP address of the Kerio Connect. If you use a self-signed or non-public SSL certificate on the
Kerio Connect, please set a checkmark next to Ignore SSL Security Warnings. In case the Kerio Server is
reachable over a non-default port (the default port is 4040), the port can be appended to the server name
with a colon.

• User Name
Name of a user with administrative privileges on the Kerio Connect.

• Password
Password of that user.

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
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Synchronize
After configuring the connection settings as described above, you can specify filter criteria for the Kerio Connect
user database synchronization in this section.

• Domains and Groups
Choose one or more domains or groups to let only their members be created as MailStore Server Users. If
no domains or groups are selected, all users will be synchronized.

Options
• Automatically delete users in MailStore Server

Here you can choose whether users that have been deleted in the Kerio Connect will also be deleted in the
MailStore user database by the synchronization. If the archive folder of such a user already contains
archived emails, only the user entry but not its archive folder will be deleted in MailStore. Additionally,
only MailStore users that have their authentication method set to Directory Services will be deleted.

Authentication
As the Kerio Connect API only support synchronization, but not authentication of users, MailStore allows
authenticate users via an IMAP login. To achieve this, you have to configure the following settings in the
Authentication section:

• Kerio IMAP Server
Enter the IP address or the DNS name of the Kerio Connect server against which authentication should be
performed.

• IMAP Server Access
Configure the connection protocol. Be aware that IMAP servers often expect the connection to be
encrypted (IMAP-TLS, IMAP-SSL). Additionally activate the Ignore SSL warnings option if a self-signed or
non-public certificate is used on the email server

Important Notice: If your Kerio Connect users authenticate against an Active Directory or if you store the
passwords as SHA hashes, you must disable CRAM-MD5 and DIGEST-MD5 under Configuration > Advanced Options
> Security Policy in your Kerio Connect Server. Otherwise users will not be able to log on to MailStore.

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from an Kerio Connect Server have the
privilege to log on to MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.

Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the Kerio Connect
without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.
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You can test the authentication for a user by first selecting him from the list and then clicking on the button on
the lower left. You will now be asked for that user's password. Upon clicking OK you'll receive a message
whether the authentication has been successful.

Login with Kerio Connect Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their Kerio
Connect username and Kerio Connect password.
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5.8 Generic LDAP Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the LDAP server of your company.

During synchronization user information such as user names and email addresses are read from the LDAP server
and recorded in MailStore Server's user database. No changes are made to the LDAP server itself by MailStore
Server. The scope of the synchronization can be limited through filters.

Accessing Directory Service Integration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
• In the Integration section, change the directory service type to LDAP server.

Connection to the LDAP Directory Service
For synchronization MailStore Server requires information on how to connect to the LDAP directory service and
how to obtain the required data from it.

LDAP Connection

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
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Name Description

Server Name DNS name or IP address of your LDAP server

Protocol Configure whether the connection to the LDAP server is to be
unencrypted on port 389, LDAP-TLS on port 389, or LDAP-SSL on port
636

Ignore SSL Security Warnings (only when
using LDAP-TLS or LDAP-SSL)

Permit connections when a self-signed or non-public certificate is used
by the LDAP server

Administrative DN Distinguished Name (DN) or user name of a user with appropriate
privileges on the LDAP server

Password Password of the user specified in Administrative DN

Base DN LDAP base DN, if needed

User Filter and Attributes

Name Description

Filter (optional) Filter LDAP objects to return only user objects with email addresses

User Name The LDAP attribute containing the username that you wish MailStore to use

Local Part Only
(E-mail Addresses /
UPN)

If unchecked, MailStore will use the full username including domain portion, e.g.
username@example.com. If checked, MailStore will only use the local part of the User
Name specified, e.g. the username

Full Name (optional) The full name of the user, for display purposes within MailStore

E-mail Addresses
(opt.)

The LDAP attribute containing the user's email address. This can contain multiple, comma
separated, e-mail addresses

Group Filter and Attributes

Name Description

Filter LDAP filter to return only group objects

Name The LDAP attribute that contains the common name of a group

Description
(optional)

The LDAP attribute that contains a human readable description for each group

Members The LDAP attribute that contains the common name of group members

Search Filter for
Members

LDAP filter to resolve group members when members are not specified as a DN string as part of
the group results. MailStore will fill in the {member} variable with values from the Members
attribute

Group The actual group(s) containing users that MailStore Server will synchronize



Generic LDAP Integration 115

Options

Name Description

Automatically delete users
in MailStore Server

If enabled, MailStore will delete users from the local MailStore database when the
user is deleted, removed from the filtered group, or falls out of scope based on the
above LDAP filter settings

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from a directory service have the privilege to
log on to MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.

Configuration Samples

Active Directory
It is possible to connect LDAP Generic to Active Directory, allowing for more flexibility and control than
MailStore's built-in Active Directory support. For example, LDAP Generic will allow you to accept invalid or
self-signed certificates, use custom filters or change which attributes are used by MailStore.

It is assumed that the Active Directory LDAP service is reachable by the MailStore instance on TCP port 389 or
636, including opening ports in the firewall, where applicable.

As most Active Directory configurations are quite similar, it will be possible to copy/paste most of the examples
below, making only minor modifications based on your environment.

LDAP Connection

Name Value Description

Server Name dc001.example.com DNS name or IP address of an Active Directory domain
controller.

Protocol LDAP Do not use transport encryption

LDAP-TLS Use TLS as transport encryption

LDAP-SSL Use SSL as transport encryption

Ignore SSL Security
Warnings

Enabled Establish a TLS/SSL encrypted connection, even if the
certificate validation failed.

Disabled Do not establish a TLS/SSL encrypted connection, if the
certificate validation failed.

Administrative DN mailstore@example.com Active Directory account for MailStore's use

Password MySecretPassword Password of the user specified in Administrative DN
above

Base DN Empty LDAP base DN will be detected automatically in Active
Directory environments
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User Filter and Attributes

Name Value Description

Filter
(optional)

(objectCategory=User) All users

(&(objectCategory=User)(mail=*)) All users with Active
Directory e-mail
addresses

(&(objectCategory=User)(proxyAddresses=*)) All users with Exchange
e-mail addresses

(&(objectCategory=User)(proxyAddresses=*)(mail=*)) All users with Exchange
e-mail addresses who
are also listed in the
global address book

User Name userPrincipalName Use Active Directory
user name as MailStore
user name

sAMAccountName Use pre-Windows 2000
user name as MailStore
user name

Local Part
Only (E-mail
Addresses /
UPN)

Enabled Only use the local part
from the Active
Directory user name in
UPN format

Disabled Use the full Active
Directory user name in
UPN format

Full Name
(optional)

displayName The user's visible name
in Active Directory

E-mail
Addresses
(opt.)

proxyAddresses Exchange environments

mail Non-Exchange
environments

Group Filter and Attributes

Name Value Description

Filter (objectCategory=Group) All objects of category Group, usually all groups

Name cn Use the value of the LDAP attribute CN as group name

Description (optional) description Use the value of the LDAP attribute description as group
name

Members member Use the value LDAP attribute member to determine
group members

Search Filter for
Members

emtpy Group members are returned as Distinguished Names

Group MailStore Users Synchronize only users from the MailStore Users group
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OpenLDAP
OpenLDAP is a commonly used LDAP server, configuration will require some knowledge of your LDAP
environment.

It is assumed that the LDAP service is reachable by the MailStore instance on TCP port 389 or 636, including
opening ports in the firewall, where applicable.

As OpenLDAP is very flexible, configuration options vary from server to server and you may need to make
significant modifications to the examples below to fit the schema used in your environment.

LDAP Connection

Name Value Description

Server Name directory.example.com DNS name or IP address of the OpenLDAP server.

Protocol LDAP Do not use transport encryption

LDAP-TLS Use TLS as transport encryption

LDAP-SSL Use SSL as transport encryption

Ignore SSL Security
Warnings

Enabled Establish a TLS/SSL encrypted connection, even if
the certificate validation failed.

Disabled Do not establish a TLS/SSL encrypted connection,
if the certificate validation failed.

Administrative DN cn=admin,dc=example,dc=com LDAP username that MailStore should use for
accessing the OpenLDAP server

Password MySecretPassword Password of the user specified in Administrative DN
above

Base DN dc=example,dc=com The Base-DN of the LDAP directory

User Filter and Attributes

Name Value Description

Filter (optional) (objectClass=posixAccount) All objects of type posixAccount,
usually all users

(&(objectClass=posixAccount)(mail=*)) All users with configured email
address

User Name uid Use the value of LDAP attribute UID
as MailStore user name

cn Use the value of LDAP attribute CN
as MailStore user name

Local Part Only
(E-mail Addresses /
UPN)

Enabled Only use the local part from a user
name in UPN format

Disabled Use the full user name in UPN format

Full Name (optional) displayName Use the value of LDAP attribute
displayName as MailStore user name

E-mail Addresses
(opt.)

mail Use the values of LDAP attribute
mail for the email addresses of
MailStore users



Generic LDAP Integration 118

Group Filter and Attributes

Name Value Description

Filter (objectClass=posixGroup) All objects of

category

posixGroup,

usually all

groups

Name cn Use the value

of the LDAP

attribute CN

as group

name

Description

(optional)
description Use the value

of the LDAP

attribute

description as

group name

Members member Use the value

LDAP

attribute

member to

determine

group

members

Search

Filter for

Members

emtpy Group

members are

returned as

Distinguished

Names

(|(&(objectClass=posixAccount)(uid={member}))(&(objectClass=posixGroup)(cn={member}))) members in

memberUid

are only given

as plain user

or group

names

Group MailStore Users Synchronize

only users

from the

MailStore

Users group
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Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the directory service
without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.

You can test the authentication for a user by first selecting him from the list and then clicking on the button on
the lower left. You will now be asked for that user's password. Upon clicking OK you'll receive a message
whether the authentication has been successful.

Login with LDAP server Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their LDAP
server username and LDAP server password.
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5.9 MDaemon Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the MDaemon Email Server of your company.

During synchronization user information such as user names and email addresses are read from the MDaemon
Email Server and recorded in MailStore Server's user database. No changes are made to the MDaemon Email
Server itself by MailStore Server. The scope of the synchronization can be limited through filters.

Accessing the Directory Service Integration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
• In the Integration section, change the directory service type to MDaemon Email Server.

Connection to the MDaemon
For synchronization MailStore Server requires information on how to access the MDaemon App directory.

• MDaemon App Directory
Enter the path to the App directory of your MDaemon installation. The App directory contains the files
Userlist.dat and Groups.dat. If MailStore Server is installed on the same computer as the MDaemon Email
Server, the MDaemon App directory is detected automatically.
If MailStore Server is not installed on the same machine, share the App directory of the MDaemon Email
Server with the MailStore Server computer and enter the share's UNC path into the field MDaemon App
Directory (e.g. \\MDAEMON\MDApp).

Please note: To access the MDaemon App directory through a network share it may be necessary to
configure a startup script for the MailStore Server Service.

• Code Page 
You only have to change this option if the encoding of the filesUserlist.dat and Groups.dat differs from the

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
https://help.mailstore.com/en/server/index.php?title=MailStore_Server_Service_Configuration%23Startup_Script
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standard encoding of the MailStore Server computer.

User Database Synchronization
After configuring the connection settings as described above, you can specify filter criteria for the MDaemon user
database synchronization in this section.

• MDaemon Groups
Choose one or more groups to let only their members be created as MailStore Server Users. If no groups
are selected, all users will be synchronized.

Authentication
To achieve this, you have to configure the following settings in the Authentication section:

• MDaemon IMAP Server
Enter the IP address or the DNS name of the MDaemon Email Server against which authentication should
be performed.

• IMAP Server Access
Configure whether the IMAP connection to the MDaemon Email Server should be unencrypted or
IMAP-TLS/IMAP-SSL encrypted.

• Ignore SSL Security Warnings (only when using IMAP-TLS or IMAP-SSL)
Activate this option if a self-signed or non-public certificate is used for IMAP encryption on the MDaemon
Email Server. Otherwise the authentication will permanently fail.

Important Notice: If your MDaemon users authenticate against an Active Directory, you must disable ... honor
APOP & CRAM-MD5 under Setup > Default Domain / Servers > Default Domain & Servers > Servers in your MDaemon
Email Server. Otherwise users will not be able to log on to MailStore Server.

Options
• Automatically delete users in MailStore Server

Here you can choose whether users that have been deleted in the MDaemon Email Server will also be
deleted in the MailStore user database by the synchronization. If the archive folder of such a user already
contains archived emails, only the user entry but not its archive folder will be deleted in MailStore.
Additionally, only MailStore users that have their authentication method set to Directory Services will be
deleted.

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from an MDaemon Email Server have the
privilege to log on to MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.
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Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the MDaemon Email
Server without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.

You can test the authentication for a user by first selecting him from the list and then clicking on the button on
the lower left. You will now be asked for that user's password. Upon clicking OK you'll receive a message
whether the authentication has been successful.

Login with MDaemon Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their
MDaemon username and MDaemon password.
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5.10 Office 365 Integration
In addition to adding users manually as described in chapter User Management, MailStore Server can
synchronize its internal user database with the Office 365 tenant of your company.

During synchronization user information such as user names and email addresses are read from the Office 365
tenant and recorded in MailStore Server's user database. No changes are made to the Office 365 tenant itself by
MailStore Server. The scope of the synchronization can be limited through filters.

Preparing the Office 365 tenant
In order to synchronize user account information from Office 365, MailStore Server requires a service principal
which has been granted permission to access the Office 365 tenant. The service principal represents MailStore
Server in the Office 365 tenant and makes it possible to authenticate to the tenant's services and use their
resources.

Installing the Azure Active Directory Module
Office 365 relies on Azure Active Directory as directory service. Each Office 365 tenant corresponds to an Azure
AD tenant where its user information is being stored. In order to create a service principal, the necessary
PowerShell module Microsoft Azure Active Directory Module for Windows PowerShell has to be installed first.

This module requires PowerShell 5.1 or higher on a 64-bit operating system to work correctly. PowerShell 5.1 is
part of current builds of Windows 10 and Windows Server 2016. For other Windows versions, you have to install it
as part of the Windows Management Framework.

These prerequisites as well as instructions on how to install them are available directly from Microsoft:

Windows Management Framework 5.1 [1]

Connect to Office 365 PowerShell [2]

Creating a service principal
Once the PowerShell module has been installed, a service principal can be created in the Azure AD by following
these steps:

1.1. Open a PowerShell Session.
2.2. The command to connect to the Office 365 Azure AD tenant depends on its Azure Cloud:

Global Azure Cloud

In case your Office 365 Azure AD tenant resides in the global Azure Cloud enter the following command

Connect-MsolService -AzureEnvironment AzureCloud

Azure Germany Cloud

In case your Office 365 Azure AD tenant resides in the Azure Germany Cloud enter the following command

Connect-MsolService -AzureEnvironment AzureGermanyCloud

Azure China Cloud

In case your Office 365 Azure AD tenant resides in the Azure China Cloud enter the following command

Connect-MsolService -AzureEnvironment AzureChinaCloud

3.3. A login dialog opens. Enter admin credentials of your Office 365 plan.
4. Optional: To get a list of all service principals that currently exist in the AD tenant, enter

Get-MsolServicePrincipal

5.5. Create a new service principal by entering
$principal = New-MsolServicePrincipal -DisplayName 'MailStoreSP' -ServicePrincipalNames @("MailStoreSP")
-Type Password -Value 'use_a_password_of_your_choice_here'

https://help.mailstore.com/en/server/index.php?title=Users%2C_Folders_and_Settings%23User_Management
https://docs.microsoft.com/en-us/powershell/wmf/5.1/install-configure
https://docs.microsoft.com/en-us/office365/enterprise/powershell/connect-to-office-365-powershell
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6. The service principal object was created and is stored in the $principal variable. Its ObjectId is
needed for role assignment in the next step. The service principal's password is valid for one year from its
creation date by default. Additional information can be found on MSDN [3].

7. For the service principal to be able to read information from the Azure AD tenant, assign the Directory
Readers role by entering

Add-MsolRoleMember -RoleName "Directory Readers" -RoleMemberType ServicePrincipal -RoleMemberObjectId
$principal.ObjectId

Accessing Directory Service Integration
•• Log on to MailStore Client as a MailStore Server administrator.
• Click on Administrative Tools > Users and Privileges and then on Directory Services.
•• The directory service type depends on the Azure Cloud of your Office 365 Azure AD tenant:

Globale Azure Cloud

If your Office 365 Azure AD tenant resides in the global Azure Cloud, chose the directory service type Office 365.

Azure Germany Cloud

If your Office 365 Azure AD tenant resides in the Azure Germany Cloud, chose the directory service type Office 365
Germany.

Azure China Cloud

If your Office 365 Azure AD tenant resides in the Azure China Cloud, chose the directory service type Office 365
operated by 21 Vianet.

https://docs.microsoft.com/en-us/powershell/module/msonline/new-msolserviceprincipal
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Connecting to Office 365
For synchronization MailStore Server requires information on how to connect to Office 365.

• Service Principal
The service principal name of the service principal (e.g. MailStoreSP).

• Password
The password of the service principal.

• Domain Name
An email domain in the Office 365 tenant.

User Database Synchronization
After configuring the connection settings as described above, you can specify filter criteria for the Office 365
synchronization in this section.

• Synchronize licensed Microsoft Exchange Online users only
Only Office 365 user accounts with a Microsoft Exchange Online license assigned to them will be taken into
account by the synchronization.

• Synchronize enabled users only
Only Office 365 user accounts that do not have their login to Office 365 blocked will be taken into account
by the synchronization.

• Sync only these groups
Choose one or several Office 365 groups if you only want their members to be created as MailStore Server
users. That way it's possible to exclude certain users from being synchronized to MailStore Server.

• User Name Format
Choose which naming scheme MailStore user names should follow:

• User Principal Name (UPN)
The full Office 365 login name e.g. jane.doe@office365.example.com

• User Principal Name (UPN) Local Part
The Office 365 login name without domain, e.g. jane.doe

Options
• Automatically delete users in MailStore Server

Here you can choose whether users that have been deleted in the Office 365 tenant will also be deleted in
the MailStore user database by the synchronization. If the archive folder of such a user already contains
archived emails, only the user entry but not its archive folder will be deleted in MailStore. Additionally,
only MailStore users that have their authentication method set to Directory Services will be deleted.

Assigning Default Privileges
By default, users that have been synchronized to MailStore Server from Office 365 have the privilege to log on to
MailStore Server as well as read access to their own user archive.
You can configure those default privileges before synchronization, for example, to assign the privilege Archive
E-mail to all new users. To do this, click on Default Privileges...
More information on managing user privileges and their effects is available in the chapter Users, Folders and
Settings which also has details on editing existing privileges.
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Running Directory Services Synchronization
Click on Test Settings to check synchronization configuration and the results returned by the Office 365 tenant
without any changes to the MailStore Server user database being actually committed.

To finally run the synchronization, click on Synchronize now. The results are shown with any changes committed
to the MailStore Server user database.

You can test the authentication for a user by first selecting him from the list and then clicking on the button on
the lower left. You will now be asked for that user's password. Upon clicking OK you'll receive a message
whether the authentication has been successful.

Login with Office 365 Credentials
After synchronization MailStore users can log on to MailStore Server via Standard Authentication with their Office
365 username and Office 365 password.

References
[1] https:/ / docs. microsoft. com/ en-us/ powershell/ wmf/ 5. 1/ install-configure

[2] https:/ / docs. microsoft. com/ en-us/ office365/ enterprise/ powershell/ connect-to-office-365-powershell

[3] https:/ / docs. microsoft. com/ en-us/ powershell/ module/ msonline/ new-msolserviceprincipal

https://docs.microsoft.com/en-us/powershell/wmf/5.1/install-configure
https://docs.microsoft.com/en-us/office365/enterprise/powershell/connect-to-office-365-powershell
https://docs.microsoft.com/en-us/powershell/module/msonline/new-msolserviceprincipal
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5.11 Compliance General
Under Administrative Tools > Compliance > Compliance General MailStore Server offers several features enabling
you to meet operational as well as legal compliance requirements. MailStore logs changes to these settings in
the audit log. Additional information about event logging is available in chapter Auditing.

Archive Access
With this setting, access to the archives of other users by MailStore administrators can be unblocked or blocked.
By default, MailStore administrators cannot access or search through other users' archive contents.

To change this setting, you have to enter your password again. You can optionally provide a reason for the
change which is written into the audit log.

If archive access is blocked, other users' archive folders are not visible in the main menu tree and MailStore
administrators do not have access to any emails archived therein. In this case, administrative tasks such as
renaming folders can only be performed through the main menu item Administrative Tools > Users and Archives
> Archives.
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If archive access is unblocked, the folder Other Archives and its subfolders are visible in the main menu tree and
MailStore administrators can view, search through and export any emails archived therein. In this case,
administrative tasks such as renaming folders can also be performed through the folder structure.
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Retention Policies
By default, MailStore allows the immediate deletion of archived emails by users with the privilege Delete Emails.
With retention policies you can specify the maximum and minimum retention period of either all messages or
only those that match certain search criteria. At the end of the retention period messages can be deleted from
the archive either automatically by a corresponding retention policy or manually by users with sufficient
privileges.

Under Retention Policies, click on
Change....

• Configure retention policies
according to your needs.

• Click OK to confirm.

Legal Hold
Enabling the Legal Hold feature temporarily prohibits deleting emails from the archive. This may become
necessary in case of legal disputes to prevent the deletion of emails which may serve as evidence.

Auditor Access
With the Auditor Access feature, a special user can be set up in MailStore who has read-access to all user archives.
Pleae note that a free MailStore user license is necessary to create the auditor user.

Under Auditor Access, click on Create
Auditor User....

• In the Create Auditor User
window, specify a password for
the new auditor user. The user
name is generated
automatically.

• Click on OK to create the new
user.

Using MailStore Client, the auditor
user can now log on to MailStore
Server and browse the archive. However, an auditor user can neither archive or export any emails nor change his
or her own password.



Retention Policies 130

5.12 Retention Policies
By default, MailStore allows the immediate deletion of archived emails by users with the privilege Delete Emails.
With retention policies you can specify the maximum and minimum retention period of either all messages or
only those that match certain search criteria. At the end of the retention period messages can be deleted from
the archive either automatically by a corresponding retention policy or manually by users with sufficient
privileges.

Retention Policy Basics
Every retention policy in MailStore consists of

•• a priority that defines the order by which retention policies are processed,
•• search criteria that determine whether a retention policy must be applied to a message,
•• a retention period during which a message cannot be deleted,
•• the option to automatically delete messages at the end of the retention period.

If a user with sufficient privileges attempts to delete a message manually, MailStore checks whether that a
retention policy is applied to that message. The retention policy with the highest priority is processed first. Once
the search criteria of a retention policy match a message, its retention period determines whether that message
may be deleted. All remaining retention policies with a lower priority will not be processed because a message
either gets deleted or must be retained.

The automatic deletion of messages is done by a system-generated job that processes all enabled retention
policies daily by default. The effects of the parameters listed above on the processing of retention policies are
explained in further detail below; examples are given at the end of this article.
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Creating Retention Policies
•• Log on to MailStore Client as MailStore administrator.
• Click on Administrative Tools > Compliance > Compliance General.
• In the Retention Policies section, click on Change...
•• The dialog to manage retention policies opens.

• Below the retention policy list, click on Create...
• The New Policy dialog opens.
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•• Enter an arbitrary name for the new retention policy.
• In the Scope section, configure whether the new retention policy applies to all messages or only to those

that match certain search criteria.
Notice

Please note that search terms may contain wildcards and phrases but narrowing by fields and
excluding words is not possible.

• In the Retention Period section, configure the retention period during which messages that this retention
policy applies to cannot be deleted. The minimum retention period is one day, the maximum period 1000
years. The beginning of the period is always defined by a message's archiving date.

Important Notice

Both the archiving date and the retention policy depend on the system time of the MailStore Server.
Please ensure that all settings (clock, time zone etc) that affect the system time in Windows are
always correct.

• In the Automatic Deletion section, configure whether messages that this retention policy applies to should
be deleted automatically at the end of the retention period.

Important Notice

The automatic deletion of messages is done by the system-generated job Process Retention Policies
that runs nightly at 3:30am by default. If you disable or delete this job, messages will no longer be
deleted automatically. You can recreate the job with the corresponding template at any time.

• Click OK to save the new retention policy.
Please note that the newly created retention policy has the lowest priority and is disabled by default. You can
change these settings as described in the next section.

https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_the_MailStore_Client_software%23Searching_for_Word_Fragments
https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_the_MailStore_Client_software%23Narrowing_by_Fields
https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_the_MailStore_Client_software%23Narrowing_by_Fields
https://help.mailstore.com/en/server/index.php?title=Jobs
https://help.mailstore.com/en/server/index.php?title=Jobs%23Templates
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Modifying Retention Policies
This section describes how the various properties of retention policies can be changed at any time.

Change Priority
The priority determines the order by which retention policies are processed. The policy list shows retention
policies ordered by descending priority; the policy with the highest priority is shown at the top.

By default, newly created retention policies get the lowest priority and are therefore shown at the bottom of the
list. To change the priority of a retention policy, proceed as follows:

•• Log on to MailStore Client as MailStore administrator.
• Click on Administrative Tools > Compliance > Compliance General.
• In the Retention Policies section, click on Change...
•• The dialog to manage retention policies opens.
• In the policy list, right-click on the retention policy you want to change and click on Move Up or Move Down

to increase or decrease its priority.

Change Status
Newly created retention policies are disabled by default and are therefore not taken into account for retention
date calculation and automatic deletion. To change the status of a retention policy, proceed as follows:

•• Log on to MailStore Client as MailStore administrator.
• Click on Administrative Tools > Compliance > Compliance General.
• In the Retention Policies section, click on Change...
•• The dialog to manage retention policies opens.
• In the policy list, right click on the retention policy you want to change and check Enabled for MailStore to

take that policy into account. Uncheck Enabled to have MailStore ignore the retention policy.

Change Name
To rename a retention policy, proceed as follows:

•• Log on to MailStore Client as MailStore administrator.
• Click on Administrative Tools > Compliance > Compliance General.
• In the Retention Policies section, click on Change...
•• The dialog to manage retention policies opens.
• In the policy list, right click on the retention policy you want to rename and select Rename....
•• Enter a new name for the retention policy.
• Click OK.

Change Properties
To modify the properties of retention policies, proceed as follows:

•• Log on to MailStore Client as MailStore administrator.
• Click on Administrative Tools > Compliance > Compliance General.
• In the Retention Policies section, click on Change...
•• The dialog to manage retention policies opens.
• In the policy list, double-click on the retention policy you want to change or right click on it and select

Properties.
• The Edit Policy dialog opens.
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•• Make the intended changes.
• Click OK.

Showing Retention Details
Retention policies determine the maximum and minimum retention date and optionally the automatic deletion
of messages in the archive.

Between the archiving date and the minimum retention date a message cannot be deleted from the archive
neither manually nor automatically. After the maximum retention date a message will be deleted from the
archive automatically.

Between the minimum and maximum retention date a message can be deleted manually from the archive.
Depending on the enabled retention policies, the minimum and maximum retention date of a message may be
the same or the message is not subject to any policy at all.

To show the retention details, i.e. the effect of all enabled retention policies on a given message, proceed as
follows:

•• Log on to MailStore Client as MailStore administrator.
• Navigate to the message whose retention details you want to show, either through the folder structure or

the search.
• In the message preview pane, click on Retention Details.

https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_the_MailStore_Client_software%23Searching_by_Folder_Structure
https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_the_MailStore_Client_software%23Advanced_Search
https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_the_MailStore_Client_software%23Email_Preview
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• The Retention Details dialog opens. If applicable, the minimum and maximum retention date and the
corresponding retention policies are shown.

•• By clicking on a retention policy you can view its details directly.
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Examples
The following examples detail the effects of priority, retention period and automatic deletion setting on the
processing of retention policies. For simplicity, the retention policies shown are applied to all messages. The
message whose retention details are shown was archived on 4/10/2018 at 9:34:19 AM.

Example 1: No Automatic Deletion

Scenario
One retention policy that defines a retention period of 3 years and no automatic deletion.

Result
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Explanation
The only retention policy defines a retention period of 3 years and no automatic deletion. Messages can
therefore not be deleted for at least 3 years starting from the archiving date (minimum retention date). As there
is no automatic deletion configured, there is also no maximum retention date.

Example 2: Automatic Deletion

Scenario
One retention policy that defines a retention period of 7 years and automatic deletion.

Result
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Explanation
The only retention policy defines a retention period of 7 years and automatic deletion. Messages will therefore
be retained for exactly 7 years starting from the archiving date and be deleted automatically afterwards; thus
minimum and maximum retention date are identical.

Example 3: Different Retention Periods

Scenario
A retention policy with highest priority that defines a retention period of 3 years and no automatic deletion.

A retention policy with lowest priority that defines a retention period of 7 years and no automatic deletion.

Result
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Explanation
The retention policy with highest priority defines a retention period of 3 years and no automatic deletion.
Messages can therefore not be deleted for at least 3 years starting from the archiving date (minimum retention
date).

The retention policy with lowest priority defines a retention period of 7 years and also no automatic deletion.
This retention policy has no effect because a retention policy with a higher priority and identical settings for
automatic deletion (no automatic deletion) matched first (overlapping search results).

Essentially, this (nonsensical) configuration yields the same results as in example 1.

Example 4: Different Retention Periods and Deletion Settings

Scenario
A retention policy with highest priority that defines a retention period of 3 years and no automatic deletion.

A retention policy with lowest priority that defines a retention period of 7 years and automatic deletion.

Result
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Explanation
The retention policy with highest priority defines a retention period of 3 years and no automatic deletion.
Messages can therefore not be deleted for at least 3 years starting from the archiving date (minimum retention
date).

The retention policy with lowest priority defines a retention period of 7 years and automatic deletion. Although
there already is a matching retention policy with a higher priority (overlapping search results), this policy is
applied to the message due to the different setting for automatic deletion. Messages will therefore be deleted
automatically after 7 years starting from the archiving date at the latest (maximum retention date).

Between the minimum and maximum retention date messages can be deleted manually from the archive by
users with sufficient privileges.

Example 5: Different Retention Periods and Deletion Settings but
Wrong Priority

Scenario
A retention policy with highest priority that defines a retention period of 7 years and no automatic deletion.

A retention policy with lowest priority that defines a retention period of 3 years and automatic deletion.

Result
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Explanation
The retention policy with highest priority defines a retention period of 7 years and no automatic deletion.
Messages can therefore not be deleted for at least 7 years starting from the archiving date (minimum retention
date).

The retention policy with lowest priority defines a retention period of 3 years and automatic deletion. Although
there already is a matching retention policy with a higher priority (overlapping search results), this policy is
applied to the message due to the different setting for automatic deletion. However, the retention policy with
the higher priority has already defined a retention period of 7 years. Messages will therefore be deleted
automatically after 7 years starting from the archiving date at the earliest.

Essentially, this (nonsensical) configuration yields the same results as in example 2.
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5.13 Auditing
With MailStore Server, specific events can be written into MailStore's own audit log or the Windows event log,
allowing you to track the activities of both MailStore administrators and users. This enables a company's
compliance officer, for example, to monitor compliance with legal and operational regulations.

Specifying the Audit Log Destination
The destination for logging of audit events can be configured in the MailStore Server Service Configuration. By
default, MailStore's own audit log is used which can be viewed under Administrative Tools > Compliance > Audit
Log. As an alternative, audit events can be written into the Windows application event log. In that case the
MailStore's own audit log is not accessible by the MailStore Client anymore.

Changing the Auditing Settings
Under Administrative Tools > Compliance > Auditing you can configure which user activities should be logged by
MailStore. Activities performed by MailStore administrators will always be written into the audit log.

To change the auditing settings, please proceed as follows:

•• From the list, select the event whose auditing status you would like to change.
•• Change the auditing status via the drop-down list.

Activities that can only be performed by MailStore administrators are listed with the auditing status All  Users
that cannot be changed.

Please note that some events (e.g. MessageRetrieveContent) may generate a large number of entries in
the audit log. Only enable such events if you are sure that you need that information.
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5.14 Audit Log
If MailStore's own audit log is used for logging audit events (default), this audit log can be retrieved via MailStore
Client.

Please note: If the Windows Eventlog is used as destination for logging of audit events, the Audit Log option at
Administrative Tools > Compliance is not shown. In that case, use the your favorite method for retrieving
information from the Windows Eventlog.

Retrieving the Audit Log
To retrieve information stored in MailStore's own audit log, proceed as follows:

• Start MailStore Client and log on as a MailStore administrator (admin).
• Click Administrative Tools > Compliance and then Audit Log.
• The events to be fetched from the audit log can be filtered by modifying the settings for Date Range, User

Name, User Activity Type and Maximum Number of Results.
• Click on Retrieve.
•• The matching events are shown in the table. To show further details of an event, double-click on the

corresponding table row.
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5.15 Storage Locations
A MailStore archive physically (i.e. on the storage) consists of individual archive stores, each with its own
database, search indexes and data containers. By default, MailStore Server automatically creates and activates a
new archive store every 5 million emails to immediately archive new emails in it.
To MailStore users these archive stores are fully transparent; they have access to all archived emails in all active
archive stores and thus get a logical view on the archive according to their respective privileges.

Under Administrative Tools > Storage > Storage Locations you can configure the parameters of the archive stores'
auto-create, manually create new archive stores and manage the archive's existing archive stores. You can also
view the location of the master database here.

Changing the Storage Location of the Master Database
The storage location of the master database can only be viewed here. In case the MailStore Client is started on
the MailStore Server machine, clicking on Change... closes the MailStore Client and starts the MailStore Server
Service Configuration.

Archive Store Basics
In MailStore, there are two types of archive stores: Internal Archive Stores and External Archive Stores.

Internal archive stores are stored entirely in configurable file system directories and can be created, managed
and backed up automatically by MailStore. For most environments using internal archive stores is
recommended.

External archive stores offer storage in SQL databases, but have several limitations. Information about external
archive stores is available in chapter Using External Archive Stores.

Both internal and external archive stores always consist of the following three components:

• Folder Information and Meta Data
Contains all data needed for the construction of the folder structure and the email list.

• Email Headers and Contents
Contains the actual payload of the archive.

• Full Text Index
Contains all data needed for searching through emails and attachments. The full text index can be
reconstructed at any time. Additional information is available in chapter Search Indexes.

MailStore archive stores as a whole as well as their individual components can be put on different physical
storage locations, including network based storages. For additional information, please refer to the article Using
Network Attached Storage (NAS).

Important notice: When choosing the physical storage system, please attend to the System Requirements.

Creating Archive Stores
In MailStore, archive stores can be created automatically and manually. For most environments using the
auto-create feature is recommended.

Creating Internal Archive Stores Automatically
By default, MailStore Server creates a new internal archive store for about every 5 million emails and archives
new emails therein. In practice, this value has proven to be suitable for most environments; therefore, when
changing this default setting, do not select a value that leads to the creation of new archive stores too
frequently.

Important notice: The triggers Quarterly, Monthly and sizings well below 5,000,000 emails or their gigabyte
equivalent should be considered deprecated and are not recommended. Future versions of MailStore may no
longer support these settings.

To change these settings, please proceed as follows:

https://help.mailstore.com/en/server/index.php?title=Using_External_Archive_Stores
https://help.mailstore.com/en/server/index.php?title=Using_Network_Attached_Storage_%28NAS%29
https://help.mailstore.com/en/server/index.php?title=Using_Network_Attached_Storage_%28NAS%29
https://help.mailstore.com/en/server/index.php?title=System_Requirements
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• Below the list of archive stores, click on the Create automatically... button.

The Auto-Create Archive Stores dialog
opens.

•• Customize the settings as
preferred.

• Under Base directory enter the
directory below which you
want MailStore to create the
new internal archive stores.
The internal archive stores that
are created automatically by
MailStore, including any
subfolders, follow the naming
scheme year-month, e.g.
2016-11.

• Optional: With the option Use
different base directories for
databases, content and search
indexes you can configure
separate directories for the
individual components of an
archive store. For example, you
can put database and search
index on a fast storage to
accelerate folder operations
and the MailStore search while leaving the email content files on a slower storage.

• Click on OK.
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Creating an Internal Archive Store Manually
Enter a name for the new internal
archive store in the Name field, e.g.
2016-11.

• If you don't want MailStore to
archive new emails in the new
archive store, deselect the
option Archive new messages
here.

•• From the name entered and the
path of the master database
MailStore derives a base
directory for the new internal
archive store. By default,
MailStore stores all
components of an archive store
in a folder structure that is
created automatically below
the base directory. You can
optionally either change the
proposed path manually or
select an existing directory; an
existing directory must not
contain any files or subfolders.

• Optional: With the option Use
different base directories for
databases, content and search
indexes you can configure
separate directories for the individual components of an archive store. For example, you can put database
and search index on a fast storage to accelerate folder operations and the MailStore search while leaving
the email content files on a slower storage.
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Setting the Status
Right-click on an archive store and select the status from the Set Status submenu. As an alternative, you can
select an archive store and set the status via the drop-down list in the details pane on the right of the archive
store list. You can set the following status:

• Archive here
In MailStore, there can only be one archive store with this status. All newly archived emails are written into
this archive store. The emails are available to all MailStore users and can be located by searching and
through the folder structure. Emails in this archive store can be deleted or moved according to configured
user privileges and compliance settings.

• Normal
Emails in archive stores with status Normal are available to all MailStore users and can be located by
searching and through the folder structure. Emails in this archive store can be deleted or moved according
to configured user privileges and compliance settings.

• Write-Protected
Irrespective of user privileges and compliance settings, emails in write-protected archive stores can only
be accessed read-only. The emails are available to all MailStore users and can be located by searching and
through the folder structure. However, emails in such archive stores cannot be deleted or moved.

Notice: Please note that file system write access to the directory of the archive store is still required and that this
status prevents automatic processing of retention policies.

• Disabled
Disabling an archive store allows you to make changes to its configuration. This may be necessary after
Moving the Archive, for example. While an archive store is disabled, the emails contained therein are not
available to the archive.

Notice: Please note that this status prevents the execution of archiving profiles.

https://help.mailstore.com/en/server/index.php?title=Moving_the_Archive
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Editing
Through the context menu item Edit... you can change the name and the directories of an archive store with
status Disabled.

Renaming
Through the context menu item Rename... you can change the name of an archive store irrespective of its status.

Detaching
Through the context menu item Detach you can detach an archive store from the archive, for example if all email
contained therein do no longer have to be archived. The detached archive store and the emails contained
therein are no longer available to the archive.

Attaching
A detached archive store can be reattached to the archive using the Attach... button. If the archive store cannot
be decrypted automatically, you will be asked for the respective recovery key. For example, this could be the
case for archive stores that belonged to another MailStore installation or which have been moved from another
machine. You can find more information on the recovery key in section Security and Encryption of chapter
MailStore Server Service Configuration.

Unlocking
If an archive store cannot be decrypted automatically, it will be listed as Locked in the list of archive stores.
Through the context menu item Unlock or by changing the status you will be asked for the respective recovery
key. You can find more information on the recovery key in section Security and Encryption of chapter MailStore
Server Service Configuration.

Maintenance of Archive Stores
All available maintenance commands can be accessed through the context menu of the list of archive stores.
Alternatively, you can select an archive store and click on the Maintenance drop-down list in the details pane.
The following commands are available:

• Cleanup (Compact)
Optimizes the data structures while compacting the data.

• Check Data Integrity
Verifies the data integrity between "Folder Information and Meta Data" as well as "Email Headers and
Contents".

• Maintain All FDB Files
Maintains the master database and all databases of internal archive stores.

• Recalculate all statistics
Recalculates the statistics (number of emails per archive store) for all archive stores.

Maintenance commands can also be scheduled for automatic execution via Jobs.

https://help.mailstore.com/en/server/index.php?title=MailStore_Server_Service_Configuration%23Security_and_Encryption
https://help.mailstore.com/en/server/index.php?title=MailStore_Server_Service_Configuration%23Security_and_Encryption
https://help.mailstore.com/en/server/index.php?title=Jobs
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5.16 Search Indexes
MailStore Server offers users an extremely fast full-text search. All emails a user has read-access to are searched,
in most cases in only fractions of a second. To ensure this remarkable speed, MailStore Server sets up so-called
search indexes during archiving. They work in a way similar to the indexes often found in the back of books:
looking up something in an index gets results significantly faster than searching each single page.

MailStore Server maintains one index file each

•• per file group and
•• per user.

MailStore Server can index all file types for which a so-called IFilter is installed on the MailStore Server computer.
Typically, IFilters exist at least for all applications which are installed on the respective machines.

For reasons of stability and performance, MailStore Server processes the following file types directly, regardless
of the IFilters that are installed:

•• Text files (TXT)
•• HTML files (HTM and HTML)

Typical tasks regarding indexes are described in the following sections.

Install Missing IFilters
Typically, IFilters exist at least for all applications which are installed on the respective machines. If, for example,
Microsoft Office 2013 is installed, the corresponding IFilter for Microsoft Office documents are installed as well.

Install the following IFilters on the MailStore Server computer to index the corresponding file types. Restart the
MailStore Server service after the IFilter installation to let MailStore detect the newly installed IFilters.

• Plain Text Files (TXT, CSV)
The IFilter responsible for these file types is shipped with Windows by default. In case this option is
disabled, a registry values might be wrong. Open the registry editor and verify that the Default value of the
key HKEY_LOCAL_MACHINE\SOFTWARE\Classes\.csv\PersistentHandler is set to
{5e941d80-bf96-11cd-b579-08002b30bfeb} and correct it if necessary.

• Portable Document Format (PDF)
For indexing PDF attachments, install Adobe PDF iFilter [1] on 64bit operating systems, or Adobe Acrobat
Reader 11 [2] on 32bit operating systems.
Important Notices:

• Take note of the installation instructions [1] of the 64bit IFilter. Especially adding the bin folder of the
IFilter installation folder to the PATH system variable increases indexing speed a lot. The PATH system
variable can be adjusted as administrator via
windows key + R > rundll32 sysdm.cpl,EditEnvironmentVariables

•• Newer versions of Adobe Acrobat Reader do not contain an IFilter. Thus, please deactivate the
automatic update function of Adobe Acrobat Reader 11.

• Microsoft Office (97-2003), Microsoft Office (2007 and later),
All these file types are supported by the Microsoft Office 2010 Filter Pack [3].

• Open Document Format (Libre Office/Open Office)
These file types require a working installation of OpenOffice or LibreOffice [4]. Latest version tested was
LibreOffice 5.1.
Notice: Though Microsoft's Office 2010 Filter Pack registers support for Open Document Format files,
indexing does not work with that IFilters.

Additional information about IFilters can be found in the corresponding Wikipedia article.

http://www.adobe.com/support/downloads/detail.jsp?ftpID=5542
https://www.adobe.com/support/downloads/thankyou.jsp?fileID=5519&ftpID=5507
http://www.adobe.com/support/downloads/detail.jsp?ftpID=5542
https://www.microsoft.com/en-us/download/details.aspx?id=17062
https://www.libreoffice.org/
http://en.wikipedia.org/wiki/IFilter
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Setting Up Indexing for the Contents of File Attachments
In the standard configuration, MailStore Server includes the file names of file attachments in the search indexes
but not their contents. To enable MailStore Server to search the contents of file attachments, it has to be
configured accordingly. Please proceed as follows:

• Start MailStore Client and log on as administrator (admin).
• Click on Administrative Tools > Storage and then on Search Indexes.
• In the area Attachments click on Change...
•• Select the file type groups or enter a space separated list of file extensions of attachment types you would

like archive in the text field below Other File Extensions.

• Click on OK to save the settings.
MailStore displays a notice, if file extensions were added for which no IFilter is installed on the MailStore Server
machine.

The new settings apply to all emails that are archived as of now. To apply the settings to already archived emails,
rebuild the appropriate search indexes as described below.
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Rebuilding Search Indexes
Normally, the creation, maintenance and usage of search indexes is completely transparent meaning that
neither administrators nor MailStore users need to know of their existence or their internal workings. In some
cases, however, some maintenance may become necessary. For example:

•• because of power outage,
•• because of unexpected termination of the MailStore Server service
•• because of missing network connectivity (only with storage on an NAS),
•• because of changes to the index configuration or
•• when restoring restoring backups without search indexes.

In these cases it may occur that archive, index and settings are no longer synchronous and that individual
indexes must be rebuilt. Generally, a corresponding error message will be displayed. In case multiple indexes
should be rebuilt, make sure other processes such as archiving profiles, exporting profiles or jobs are paused, or
else the indexing process may get interrupted.

To rebuild search indexes please proceed as follows:

•• Start MailStore Client and log on as administrator (admin).
• Click on Administrative Tools > Storage and then on Search Indexes.
• Check all search indexes to be rebuilt. Indexes with the status Please Rebuild are already checked for your

convenience.
• Click on Rebuild Search Indexes.
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5.17 Backup and Restore

Backup

Preliminary Considerations
MailStore Server supports two methods to perform a full backup of the email archive including all user settings:
the MailStore integrated backup feature and the use of external backup software.

Which method suits the needs of your business best depends on your preferences as well as your system
environment. In smaller environments without a designated administrator, with the integrated backup feature
no extensive configuration needs to be performed in order to make sure that the backup is successfully
completed and that all pertinent data and directories are included. However, to be able to transfer the data (for
example to Digital Linear Tape), it is necessary to integrate the backed up data into another system backup.

When using external backup software (e.g. Veeam, Windows Server Backup or Acronis True Image,) a successful
backup needs a few preparations. On the plus side, MailStore Server data can be integrated into existing backup
strategies without having to perform a separate system backup.

Which Data Must be Backed Up?
Each archive store in MailStore consists of three components:

•• Folder information and meta data
•• Email headers and contents
•• Full text index

While folder information and meta data as well as email headers and contents are a unit that requires
consistency, full text indexes can be reconstructed if needed. In environments with higher security demands, and
depending on the backup target, it may be advisable to exclude the unencrypted full text indexes from the
backup.

In addition to the archive stores, the MailStore master database (MailStoreMaster.fdb) must be backed up as
well because it contains all configuration settings such as users and profiles.

Using the MailStore Integrated Backup Feature
MailStore has built-in technology to perform a full backup of the archive.

The backup contains all archived emails and all program settings such as users and privileges. Restoring such a
backup is sufficient to completely reinstate the original archive without having to perform any further
configurations.

Important Notice: When using the integrated backup feature, MailStore only supports internal archive stores. If
you are using external archive stores, you need external backup software to perform a full backup .

Procedure
To create a complete database backup, proceed as follows:

•• Log on to MailStore Client as MailStore administrator.
• Click on Administrative Tools > Management API > Jobs.
• Click on Storage and select Create Backup.
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• Enter the target directory.
Please note: If the target directory is a network share, make sure that the MailStore Server service has
access to that share. The path to the network share has to be entered in UNC notation, e.g.
\\computer\sharename. Further information is available in the Using Network Attached Storage (NAS)
article.

•• The search indexes can be excluded optionally.
Please note: This option can be set so that administrators which have access to the backup files cannot
access the unencrypted search index files. When restoring backups that do not include search indexes, the
search indexes have to be rebuilt.

• Define the start time for the backup in the Schedule section.
• Click OK to finish the creation of the backup job.

If necessary, run the job manually in order to verify that MailStore Server is able to create a backup without
errors.

Please note: The archive cannot be accessed while a backup is in progress. Trying to access the archive will
generate the error message The server is currently not available due to maintenance.

https://help.mailstore.com/en/server/index.php?title=Using_Network_Attached_Storage_%28NAS%29
https://help.mailstore.com/en/server/index.php?title=Search_Indexes%23Rebuilding_Search_Indexes
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Using External Backup Software

Backup of Internal Archive Stores
When backing up internal archive stores with an external backup software, attention must be payed to the
consistency of data which mainly depends on the backup method. The following sections summarize the pros
and cons of the different methods.

File Based Backups
While file based backups solutions are good for backing up independent files, they are usually not suitable for
creating consistent backups of a MailStore Server as its data is spread across multiple rapidly changing files.

In order to create consistent backups with file based backup tools, it is required to either freeze and thaw
MailStore Server via net pause mailstoreserver and net continue mailstoreserver
commands or to shutdown and restart the MailStore Server via net stop mailstoreserver and net
start mailstoreserver commands.

As MailStore Server must remain shut down for the time of the backup, this typically results in downtimes during
which MailStore is neither able to archive new email nor provide end user access to the archived data.

Storage Snapshots
When using Volume Shadow Services (VSS) or other methods of creating snapshots on storage level, it is
necessary to ensure that all files are closed before the snapshot is created.

The MailStore Server service provides external backup software using Microsoft Volume Shadow Service with a
so-called Volume Shadow Service Writer (VSS Writer). The external backup software can use it to create
consistent backups of the MailStore master database and all internal archive stores. Whether this method
succeeds, however, largely depends on the backup software and the storage that is used. The VSS Writer has to
be activated in the MailStore Server Service Configuration.

To verify if the appropriate VSS events were initiated in MailStore during a backup, open the application protocol
in the Windows event viewer and search for the following events:

1.1. A backup session has been started.
2.2. The archive has been frozen as a reaction on the OnPrepareSnapshot event.
3.3. The archive has been thawn as a reaction on the OnThaw event.
4.4. The backup session has been shut down.

If these events cannot be found in the application protocol, no consistent backup using Volume Shadow Service
was performed. In that case the backup software needs to prepare MailStore Server for the snapshots. This can
be done with the methods detailed in the File Based Backups section.

For how to execute commands before and after performing snapshots, please consult your backup software's
documentation.

Full Virtual Machine Snapshots
Some backup solutions are highly integrated into virtualization solutions and can create and backup/replicate
full snapshots of virtual machines. These types of snapshots not only contain the current state of the hard disks
but also of the current main memory. Thus full virtual machine snapshots can be considered as being consistent.

Other Backup or Replication Methods
For questions regarding any other type of backup solutions such as block level replication, continuous backup
etc please contact the vendor's support to find out whether their software is able to create consistent backups of
whole directory structures.

Backup of External Archive Stores
External archive stores allow you to store folder information and meta data in an SQL database. Email headers
and contents can be stored optionally in an SQL database as well. Search index files have to be stored in the file
system.
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To backup external archive stores, the distributed data has to be backed up simultaneously. Stop the MailStore
Server service, backup the SQL databases and the files that are stored in the file system with appropriate backup
tools, then restart the MailStore Server service when done.

You can stop and start the MailStore Server service by executing the net stop mailstoreserver and
net start mailstoreserver commands.

In case the unencrypted search index files are not backed up, you can rebuild them after restoring the backup.

Restoring Backups
This section describes how a database backup of the entire email archive, which was created using the
integrated backup feature, can be restored.

Background
A database backup which was created using the integrated backup feature and that includes the search index
files contains all archived emails and program settings such as users and privileges. Restoring such a backup is
sufficient to completely reinstate the original archive without having to perform any further configurations.

Automatic Restore of a Database Backup
MailStore creates two files in the backup destination when creating a backup which allow an automatic full
restore of the archive in its original storage location. Should the backup be restored to a different storage
location or if only parts (i.e. a single archive store) should be restored, the restore procedure must be performed
manually (see next section).

An operative installation of MailStore Server is required to restore a database backup. Please proceed as follows:

• Stop the MailStore Server Service and delete the empty archive that has been created during installation
in C:\MailArchive.

• Next execute the file restore.bat from the backup directory.
Note: Is the file located on a network share, e.g. \\nas01\MailStoreBackup, you first have to crate a
mapped drive of that share, e.g. N:, and then execute the file on that drive.

•• Follow the on-screen instructions. Carefully check the output for possible error messages.
• Run the MailStore Server Service Configuration tool from the MailStore program folder in the Windows

start menu.
• Click Browse... under General > Master Database and select the restore directory which contains the

MailStoreMaster.fdb file. Confirm the selection by clicking OK.
•• Finally start the MailStore Server Service again.

In case the backup includes the search index files, no further steps are necessary after using the automatic
restore. Otherweise the search indexes have to be rebuild.

https://help.mailstore.com/en/server/index.php?title=Search_Indexes%23Rebuilding_Search_Indexes
https://help.mailstore.com/en/server/index.php?title=Search_Indexes%23Rebuilding_Search_Indexes
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Manual Restore of a Database Backup
An operative installation of MailStore Server is required to restore a database backup. Please proceed as follows:

•• Copy the database backup to a local hard drive on the computer or to a respective network share.
• Start the MailStore Server Service Configuration. It is located in the MailStore Server program folder that

can be accessed through the Windows Start menu.
• Below Master Database, click on Browse... and select the backup directory containing the file

MailStoreMaster.fdb.

• Click on OK to confirm.
• At the bottom of the window, click on Restart Service to save the new settings.
• When creating the backup, the folder names of the archive store may have changed. Please use the

Storage Locations Management to adjust the paths to the archive stores or rename the folders in the file
system accordingly. The mapping of the backup's archive store folder names to their original names can
be found in the restore.csv file that has been created with the backup.

In case the backup includes the search index files, no further steps are necessary after the restore. Otherweise
the search indexes have to be rebuilt.

https://help.mailstore.com/en/server/index.php?title=Search_Indexes%23Rebuilding_Search_Indexes
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5.18 License Management
The license management in MailStore allows you to install or update your MailStore Server license and gives an
overview of the license currently in use. Furthermore the Open Online-Shop button provides direct access to our
online shop, where, for example, license renewals or upgrades can be purchased.

In case the automatic retrieval of the license information is blocked, the license file can be downloaded
manually [1].

Please notice: License holders that have not purchased their license directly from MailStore Software must
contact their reseller for any license related topics.

References
[1] https:/ / my. mailstore. com/ softwareactivation

https://my.mailstore.com/softwareactivation
https://my.mailstore.com/softwareactivation
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5.19 SMTP Settings
To be able to send emails, MailStore Server requires SMTP access data. MailStore sends notifications by email if
product updates are available or if the automatic creation of a new archive store failed. Furthermore, email
copies for the restore from MailStore Web Access can be sent via SMTP.

Under Administrative Tools > Miscellaneous > SMTP Settings you can specify the SMTP settings.

• Start MailStore Client and log on as MailStore administrator (admin).
• Click on Administrative Tools > Miscellaneous and then on SMTP Settings.
• Under Server, enter the host name of the SMTP server or its IP address.
• By default, MailStore uses port 587. If you want to use a different port, enter port number in the Port field.
• In the field Protocol, select SMTP for an unencrypted connection to the SMTP server. For an encrypted

connection, select SMTP-TLS or SMTP-SSL. If the SMTP server does not have an official or installed SSL
certificate, check Ignore SSL Warnings; otherwise, the sending process will fail.

•• Especially SMTP servers which are accessible through the internet require a login (SMTP authentication).
Check the corresponding checkbox and enter the appropriate access data. In most cases, the POP3 access
data of any user on the email server can be used.

• Under Sender, enter the Display Name and the Email Address of the email sender. Many SMTP servers
require an existing email address to be entered. The display name can be chosen freely; ideally the name
indicates that the email was sent by MailStore Server.

• Under Recipient for Notifications, enter the email address of the recipient for administrative notifications of
MailStore Server.

• Once all settings have been specified, MailStore Server can be instructed to send a test email to the email
address entered for notifications; simply click on Apply and Test. If an error message appears or the
recipient specified does not receive the email, the following hints for troubleshooting may be helpful.

https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_with_MailStore_Web_Access%23Restoring_Email
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Troubleshooting
•• If no error occurs upon sending but the email does not arrive, please check the spam or junk mail folder of

the mailbox. Perhaps the email was filtered out.
• If an error message appears because of an invalid certificate ("Server's certificate was rejected by the

verifier because of an unknown certificate authority."), check Ignore SSL Warnings and try again.
• If an error message appears indicating that "One or more recipients rejected", the SMTP server probably

requires authentication. Enter the appropriate access data as described above.
• If an error message appears because of invalid access data ("Incorrect authentication data"or

"Authentication failed"), verify the data entered. In most cases, the access data match those of the
corresponding POP3 server.

•• If further error messages appear or other problems arise, please check your entries for possible mistakes.
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5.20 Active Sessions
Under Administrative Tools > Active Sessions, administrator can see which users are currently logged into
MailStore Server. This may be important in preparation of performing maintenance tasks such as a backup, in
order to identify which active users are affected by such an action.
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5.21 Product Updates
On this page you can configure whether MailStore should check for new versions automatically as well as
whether to submit anonymous usage data.

Enable automatic update check
If this option is enabled, MailStore Server regularly checks for new product versions. If a new version is available,
this will be displayed on the dashboard in the MailStore Client. Additionally, if a Recipient for Notifications is
defined in the SMTP Settings, a notification will be sent to this email address.

Submission of anonymous usage data
If this option is enabled, MailStore Server regularly sends data on how the program is being used to MailStore.
This data allows us to better understand different usage scenarios of MailStore Server and focus our
development capacities accordingly. The submitted data is collected and evaluated exclusively for this purpose.

You can display the data to be submitted by clicking on the Show data link. No personal data such as user
names, passwords or email content will be submitted. The submitted data is completely anonymized and
cannot be correlated to a specific customer installation. This option is disabled by default (opt-in).
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5.22 MailStore Server Management Shell
Many instructions available in the graphical user interface of MailStore Client can also be executed using
MailStore's management shell, a command line client which is automatically included when installing MailStore
Server and MailStore Client.

The management shell is useful when no graphical user interface is available (e.g. if using telnet or ssh) or for the
integration of scripts (e.g. batch files) that are executed either manually or automatically.

Beside the client-side commands, the Management Shell also offers access to server-side commands of the
MailStore Server Administration API. Output of server-side commands is in JSON format.

Starting the Management Shell in MailStore Client
The management shell can be started directly from MailStore: Log on to MailStore Client as administrator and
click on Administrative Tools > Management API > Command Prompt.

The font size can be adjusted by holding the Ctrl key and using the mouse wheel or pressing + and -. Holding
down the Ctrl key and pressing 0 resets the font size.
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Using MailStoreCmd.exe in Non-Interactive Mode
In non-interactive mode, the management shell logs on with the access data passed, executes the command
passed, and automatically terminates upon execution. If the login and the execution of the command were
successful, the exit code (ERRORLEVEL) of the process is set to 0 (zero), otherwise it is set to any value other than
0. MailStoreCmd.exe can be found in the installation directory of MailStore Server. MailStoreCmdSilent.exe does
the same, but does not open a console window.

Login credentials for your installation can be found in the scheduled task of an archiving profile of the type
E-Mail Programs or E-Mail Files.

There are multiple ways to pass credentials to MailStoreCmd.exe.

To read credentials from the Windows Credentials Manager, they have to be stored there first. The MailStore
Client does this automatically when creating a scheduled task in the Windows Task Planer. This methods
prevents reading passwords easily by unauthorized persons.

MailStoreCmd.exe --h=<server> --cred=<user>@<server/ip address> --pkv3=<thumbprint> -c <command> [--param1=<value> --param2=<value> ...]

The credentials can also be passed as plain text.

MailStoreCmd.exe --h=<server> --u=<user> --p=<password> --pkv3=<thumbprint> -c  <command> [--param1=<value> --param2=<value> ...]

The below command line parameters are required followed by additional API command parameters if
necessary.

Parameter Description

--h The machine name of the MailStore server to which code>MailStoreCmd.exe is to connect.

--pkv3 The (optional) Public Key Fingerprint, which guarantees the identity of MailStore Server.

--u User name

--p Password

--cred Alternative to --u and --p, the password is read from the Windows Credential Manager. The
parameter must be entered in the from <user>@<server/ip address>.

--nologo Optional. Prevents the logo from being displayed.

--o Optional. Redirects the output to a given file. When this parameter is given, no output is sent to the
console.

-c The actual command follows (non-interactive mode).

Command Overview
Find a list of all client side commands below. An overview of all available server side commands can be found
under Function Reference.

 clear

Clears the texts currently displayed improving visibility.

 debug-conn

Activates debug protocol for IMAP and HTTP connections during archiving for the running MailStore Client
process.

 debuglog-browse

Opens the file explorer and shows MailStore's Debug Log directory.
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 debuglog-enable,  debuglog-disable

Activates or deactivates the global debug protocol (within computer scope).

 exejcfg [--d]

Enables envelope journaling on Exchange 2003 servers. When the parameter --d is given, envelope journaling will
be disabled. This command must be executed from a domain joined computer.

 export-execute [--name=<profilename>] [--id=<profileid>] [--verbose] [--[property]="value"]

Executes an export profile. Following parameters are supported:

--name | --id name or ID of the export profile to execute

--verbose activates a detailed status display on the console

--[property] Overwrites the given property of a profile. The internal properties can be displayed, by
selecting an export profile and press CTRL + SHIFT + P. The name of the property has to
be in brackets. Multiple properties can be modified by repeating the parameter.

 export-list

Displays a list of all existing export profiles (ID and profile name).

 help

Displays a list of all available commands and their parameters.

 import-execute [--name=<profilename>] [--id=<profileid>] [--verbose] [--user=<username>] [--[property]="value"]

Executes the archiving profile. Following parameters are supported:

--name | --id name or ID of the import profile to execute

--verbose activates a detailed status display on the console

--user user archive to store archived emails

--[property] Overwrites the given property of a profile. The internal properties can be displayed, by
selecting an archiving profile and press CTRL + SHIFT + P. The name of the property has
to be in brackets. Multiple properties can be modified by repeating the parameter.

 import-list [--user=<username>]

Displays a list of all existing archiving profiles (ID and profile name).

 livelog-client-disable,  livelog-client-enable,  livelog-server-disable,  livelog-server-enable

Activates or deactivates the live debug protocol of MailStore Server or MailStore Client. The live protocol can be
viewed with Sysinternal's DebugView. DebugView must be started with elevated privileges and it must be
configured to capture Global Win 32 events.

 store-setprop --name=<name> [--value=<value>]

Changes the value of a global property

--name Name of the global property

--value Value of the global property
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Following global properties are supported:

Name Version Values Default

public.arcclient.skipMimeContentConversionFailed 8 true = Exchange
MimeContentConversionFailed errors are
ignored and not handled as an archiving
error.
false = Exchange
MimeContentConversionFailed errors are
handled as archiving errors.

false

public.arcclient.skipVirusDetected 8.1 true = Exchange ErrorVirusDetected errors
are ignored and not handled as an
archiving error.
false = Exchange ErrorVirusDetected errors
are handled as archiving errors.

false

public.arcclient.skipEwsErrorItemNotFound 10 true = Exchange ErrorItemNotFound errors
are ignored and not handled as an
archiving error.
false = Exchange ErrorItemNotFound errors
are handled as archiving errors.

false

public.backup.hideNotDetectedWarningMessage 11 true = Backup warning messages are not
shown on dashboard.
false = Backup warning messages are
shown on dashboard.

false

 user-list

Display list of users.
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6.1 MailStore Server Service Configuration
With the MailStore Server Service Configuration you can configure low level features of a MailStore Server
installation as well as control the MailStore Server service. The current status of the MailStore Server service is
shown at the bottom of the window.

General
On this page you can select the storage location of the master database, configure where audit events should be
stored and enable or disable individual features for accessing MailStore Server.

Master Database
Select the storage location of an existing master database. If you chose an empty directory, a new master
database will be created therein. If you want to move an existing archive to a new storage location, refer to the
instructions in Moving the Archive.

You can also specify the destination for logging audit events here.

Features
In this section you can enable or disable individual features for accessing MailStore Server.

• MailStore Web Access / Outlook Add-In (HTTP)
Enables archive access via HTTP through MailStore Web Access and the MailStore Outlook Add-in.

• MailStore Web Access / Outlook Add-In (HTTPS)
Enables archive access via HTTPS through MailStore Web Access and the MailStore Outlook Add-in.

• IMAP Server (unencrypted / STARTTLS) 
Enables the STARTTLS-encrypted archive access through the integrated IMAP server (explicit TLS). Login

https://help.mailstore.com/en/server/index.php?title=Moving_the_Archive
https://help.mailstore.com/en/server/index.php?title=Accessing_the_Archive_via_Integrated_IMAP_Server


MailStore Server Service Configuration 169

over unencrypted connections is not supported.
• IMAP Server (SSL)

Enables SSL-encrypted archive access through the integrated IMAP server (implicit TLS).
• MailStore Administration API (HTTPS)

Enables the MailStore Administration API.
• VSS Writer

Activates the MailStore Volume Shadow Service Writer for enabling live backups of the archive using an
external backup software.

• Exclude Indexes from VSS Backup
Location of index files will not be reported by the VSS Writer.

IP Addresses and Ports
In addition to enabling and disabling individual network based components, you can choose the IP address and
the port to which a component is to be bound as well as the SSL certificate that should be used for encrypted
connections.

https://help.mailstore.com/en/server/index.php?title=Backup_and_Restore%23Using_External_Backup_Software
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Basic Options

IP Address
The IP address on which the component accepts connections. Generally, it is recommended to bind all MailStore
Server components to all IP addresses (default).

Port
Indicates the TCP port on which the component accepts connections.

Hint: If no web server other than MailStore Web Access is installed (e.g. an IIS website, Microsoft Outlook
Web Access or SharePoint), you can specify the HTTP- and HTTPS standard ports (80 and 443). This way,
users can access MailStore Web access directly using the URLs http://<server name> or
https://<server name> without port numbers.

Server Certificate
Shows the current SSL certificate for the respective component. Click on the name of the SSL certificate to view
further details. Using the ellipsis button (…) next to the name you can:

•• Select an SSL certificate from the certificate store of the MailStore Server computer.
•• Create a new self-signed SSL certificate.
• Import an SSL certificate from a file directly into the certificate store of the MailStore Server computer. The

file must be in PKCS #12 format and usually has the file extension pfx or p12.
Further information about certificates and SSL security can be found in the following articles:

•• Using Your Own SSL Certificate
•• Enhancing SSL Security

Specific Options

MailStore Client
You cannot disable this component because the MailStore Client is essential for managing MailStore Server. The
default TCP port is 8460.

MailStore Web Access / Outlook Add-in (HTTP)
This component provides unencrypted archive access through MailStore Web Access and the MailStore Outlook
Add-in. The default TCP port is 8461.

• Enable HTTPS redirect
Enabling this option redirects unencrypted HTTP requests to the HTTPS port.

• Redirect to custom server name
If MailStore Server should use a specific server name for the HTTPS redirect, it must be specified here.

https://help.mailstore.com/en/server/index.php?title=Using_Your_Own_SSL_Certificate
https://help.mailstore.com/en/server/index.php?title=Enhancing_SSL_Security
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MailStore Web Access / Outlook Add-in (HTTPS)
This component provides SSL-encrypted archive access through MailStore Web Access and the MailStore
Outlook Add-in. The default TCP port is 8462.

IMAP Server (unverschlüsselt / STARTTLS)
This component provides STARTTLS-encrypted archive access through the integrated IMAP server. The default
TCP port is 143. Login over unencrypted connections is not supported.

IMAP Server (SSL)
This component provides SSL-encrypted archive access through the integrated IMAP server. The default TCP
port is 993.

MailStore Administration API (HTTPS)
This component provides SSL-encrypted access to the MailStore Administration API. The default TCP port is
8463.

Security and Encryption
This page provides several security features related to archive access and encryption. Please note that you
cannot use these features while the MailStore Server service is running; it has to be stopped first.
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Restore Default Admin
Through this feature you can restore the default admin user admin with the likewise password admin. If the
recovery key of the archive whose default admin you want to restore is not the product key of the current
MailStore Server installation, you will be asked to enter the associated recovery key.
A restore of the default admin user is written into the audit log.

Reinitialize Archive Encryption
For security reasons the archive encryption is bound to the Windows installation of the MailStore Server
machine. Therefore it might be necessary to reinitialize the archive encryption when moving the archive to
another computer. If the recovery key of the archive whose encryption you want to reinitialize is not the product
key of the current MailStore Server installation, you will be asked to enter the associated recovery key.

Set Recovery Key
The recovery key is used to authorize several security related tasks in MailStore Server, such as restoring the
default admin, moving the archive to another machine or attaching archive stores from another MailStore
installation. That way the number of people that may perform such tasks can be kept small and administrative
archive and system duties can be kept separate.

By default, MailStore Server uses the product key provided during setup as recovery key and most security
related tasks are carried out automatically without the need to enter the recovery key for authorization.

To improve security you can change your recovery key to an automatically generated, random value. In that
case, every security related tasks must be authorized by entering the recovery key. For easier reference, each
recovery key has a unique identifier that is displayed when the related recovery key must be provided. Only the
most recent recovery key can be used for authorization.

Changing the Recovery Key

Click on Change to change the
recovery key to an automatically
generated, random value.

•• You will be asked to save the
recovery key to a file and/or
print it. You have to choose at
least one option to continue.

•• After successfully changing the
recovery key only the new key
can be used henceforth.

Important notice: Always store the
recovery key in a secure location.
Without the recovery key carrying out
security related tasks is no longer
possible.
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Resetting the Recovery Key

The MailStore Server service can execute a script before startup. The script can be used to establish a connection
to a network resource using special connection parameters as described in chapter Using Network Attached
Storage (NAS).

Event Viewer
Events such as starting or stopping the MailStore Server service are displayed here. If there are any errors, click
on the corresponding entry to view additional details below the list.

Debug Log
On this page you can enable, view or delete all debug logs created by MailStore Server.

Enable Debug Log
Enable this feature if any problems or errors have occurred while running MailStore Server. After restarting the
server service via Restart Service in the same window, a detailed log file is recorded. This file can be evaluated by
the MailStore support team, for example.

Enable IMAP Connection Debug Log
Enable this feature if problems or errors have occurred while accessing MailStore Server using the integrated
IMAP server. After restarting the server service via Restart Service in the same window, a detailed log file is
recorded. This file can be evaluated by the MailStore support team, for example.

The table shows an overview of all debug log files. To view the contents of a debug log file in a text editor,
double-click on the file name or click on Open. To delete a debug log file, highlight the file name and click on
Delete.

https://help.mailstore.com/en/server/index.php?title=Using_Network_Attached_Storage_%28NAS%29
https://help.mailstore.com/en/server/index.php?title=Using_Network_Attached_Storage_%28NAS%29
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7.1 Administration API - Using the API
In this chapter you can find a description of the MailStore Server Administration API. With the Administration API
administrative tasks, such as managing users or storage locations, can be remote controlled from a central
location. Communication with the Administration API is done using web requests through HTTPS.

For security reasons, the MailStore Server Administration API is deactivated by default and has to be activated
using the MailStore Server Service Configuration. When you are connecting to the API and using a hostname
other than localhost or 127.0.0.1 you have to change the password of the admin user before.

Executing Regular API Functions
To execute regular Management API functions, send a HTTP POST request to the following URL:

https://<mailstore-server>:8463/api/invoke/<function>

With every request to the API, the username and password of a MailStore Administrator must be submitted
following the HTTP Basic Authentication specification as described in RFC 2617. When a function needs
additional data, this data must be send urlencoded. The HTTP header Content-Type:
application/x-www-form-urlencoded should be set.

Example

HTTP Request

POST /api/invoke/GetServerInfo HTTP/1.1
Authorization: Basic YWRtaW46UGFzc3cwcmQ=
User-Agent: curl/7.35.0
Host: mailstore.example.com:8463
Accept: */*
Content-Length: 0

HTTP Response

HTTP/1.1 200 OK
Cache-Control: 
no-cache,private,no-store,must-revalidate,max-stale=0,post-check=0,pre-check=0
Pragma: no-cache
Content-Length: 251
Content-Type: application/json
Expires: Wed, 25 Jun 2014 14:13:43 GMT
Server: Microsoft-HTTPAPI/2.0
Date: Thu, 26 Jun 2014 14:13:43 GMT
 
{
  "error": null,
  "token": null,
  "statusVersion": 2,
  "statusCode": "succeeded",
  "percentProgress": null,
  "statusText": null,
  "result": {
    "version": "9.0.0.9702",
    "machineName": "MAILSTORE"
  },
  "logOutput": null
}

To get a list of all available functions, send a POST request to https://<mailstore-server:8463/api/get-metadata.

http://en.wikipedia.org/wiki/Basic_access_authentication
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Long Running Processes
Some API functions start a long running process that may take several minutes or even hours to complete. To
keep track of the progress a unique token is returned upon initial request, which can be used to periodically poll
for status updates.

The overall process is as follows:

1. Send HTTP POST to https://<mailstore-server>:8463/api/invoke/VerifyStore in
order to execute the function.

2. Check the server's response for the keys token, statusCode and statusVersion.
3. To retrieve status updates, send periodic requests to
https://<mailstore-server>:8463/api/get-status with the following parameters:

Name Description

token The received unique token for the process.

lastKnownStatusVersion Value of statusVersion from last response.

millisecondsTimeout Time in milliseconds until the the server stops waiting for a new status update to
send. If a new status update is available it will be sent to the client immediately,
otherwise the last status is repeated.

4. The process finished when the statusCode is not running.

Example

Initial HTTP Request

POST /api/invoke/VerifyStore HTTP/1.1
Authorization: Basic YWRtaW46UGFzc3cwcmQ=
User-Agent: curl/7.35.0
Host: mailstore.example.com:8463
Accept: */*
Content-Length: 5
Content-Type: application/x-www-form-urlencoded
 
id=11

Initial HTTP Response

HTTP/1.1 200 OK
Cache-Control: 
no-cache,private,no-store,must-revalidate,max-stale=0,post-check=0,pre-check=0
Pragma: no-cache
Content-Length: 290
Content-Type: application/json
Expires: Wed, 25 Jun 2014 14:15:41 GMT
Server: Microsoft-HTTPAPI/2.0
Date: Thu, 26 Jun 2014 14:15:41 GMT
 
{
  "error": null,
  "token": "b3af0ebae4dd755d1a54b9756817baee",
  "statusVersion": 3,
  "statusCode": "running",
  "percentProgress": 0,
  "statusText": null,
  "result": null,
  "logOutput": "Verifying file group #11...\r\nCreating a list of 
messages to be verified...\r\n"
}
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Periodic HTTP Request of Progress

POST /api/get-status HTTP/1.1
Authorization: Basic YWRtaW46UGFzc3cwcmQ=
User-Agent: curl/7.35.0
Host: spe.example.com:8474
Accept: */*
Content-Length: 90
Content-Type: application/x-www-form-urlencoded
  
token=b3af0ebae4dd755d1a54b9756817baee&lastKnownStatusVersion=3&millisecondsTimeout=5000

HTTP Response to Periodic Progress Requests

HTTP/1.1 200 OK
Cache-Control: 
no-cache,private,no-store,must-revalidate,max-stale=0,post-check=0,pre-check=0
Pragma: no-cache
Content-Length: 242
Content-Type: application/json
Expires: Wed, 25 Jun 2014 14:08:15 GMT
Server: Microsoft-HTTPAPI/2.0
Date: Thu, 26 Jun 2014 14:08:15 GMT
  
{
  "error": null,
  "token": "b3af0ebae4dd755d1a54b9756817baee",
  "statusVersion": 9,
  "statusCode": "running",
  "percentProgress": 0,
  "statusText": null,
  "result": null,
  "logOutput": "  400 messages verified...\r\n"
}

Final HTTP Response

HTTP/1.1 200 OK
Cache-Control: 
no-cache,private,no-store,must-revalidate,max-stale=0,post-check=0,pre-check=0
Pragma: no-cache
Content-Length: 242
Content-Type: application/json
Expires: Wed, 25 Jun 2014 15:08:15 GMT
Server: Microsoft-HTTPAPI/2.0
Date: Thu, 26 Jun 2014 15:08:15 GMT
 
{
  "error": null,
  "token": null,
  "statusVersion": 269,
  "statusCode": "succeeded",
  "percentProgress": null,
  "statusText": null,
  "result": null,
  "logOutput": null
}
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Error Handling
Additionally to handling protocol specific issues such as HTTP or TCP errors, developers receive detailed
information from the API itself in case the request did not succeed.

In case the request was successfully be processed, the response will contain:

 "error": null

Otherwise in the event of a failure the error key will have the following structure

 "error": {
   "message": string,
   "details": string
 }

allowing developers to display a meaningful error message and further technical details.
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7.2 Administration API - Function Reference

AttachStore
Attach existing archive store.

Arguments

Name Type Description

name string Meaningful name of archive store.

type string Type of archive store.

databaseName string
(optional)

Name of database on Microsoft SQL Server or PostgreSQL server.

databasePath string
(optional)

Path to directory in which database folder information and email meta data
are stored.

contentPath string
(optional)

Path to directory in which email headers and contents are stored.

indexPath string
(optional)

Path to directory in which full text search indexes are stored.

serverName string
(optional)

Name of Microsoft SQL Server or PostgreSQL server.

userName string
(optional)

User name for accessing Microsoft SQL Server or PostgreSQL server.

password string
(optional)

Password for accessing Microsoft SQL Server or PostgreSQL server.

requestedState string
(optional)

State of archive store after attaching.

Argument Values

type

Name Description

FileSystemInternal Advanced file system-based archive store.

SQLServer Microsoft SQL Server-based archive store.

PostgreSQL PostgreSQL server-based archive store.

requestedState
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Name Description

current Same as Normal but new messages will be archived in the archive store that is set to
Current.

normal The content of archives store is available to users and can be modified if the user has the
appropriate permission.

writeProtected The content of write protected archive stores is available to users, but cannot be modified
(e.g. delete or move messages, rename or move folders)

disabled Disabled archive stores are not in use but the instance still knows about their existence.
Therefore the content is not available to users.

CancelJobAsync
Cancel a running job asynchronously.

Arguments

Name Type Description

id number The unique identifier of the job to be canceled.

ClearUserPrivilegesOnFolders
Removes all privileges of a user on all archive folders.

Arguments

Name Type Description

userName string User name of MailStore user.

CompactMasterDatabase
Compact master database.

CompactStore
Compact archive store.
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Arguments

Name Type Description

id number Unique ID of archive store

CreateBackup
Create a backup of the entire archive.

Arguments

Name Type Description

path string Path to directory into which the backup should be written.

excludeSearchIndexes bool
(optional)

Indicates whether the search index files should be excluded from
the backup.

CreateJob
Create a new job to execute Management API commands.

Arguments

Name Type Description

name string
(optional)

A meaningful name for the job. Example: Daily Backup.

action string
(optional)

Management API command to execute.

owner string
(optional)

Username of the job owner; must be an administrator.

timeZoneId string
(optional)

The time zone the date should be converted to, e.g. $Local, which represents the
time zone of the operating system.

date string
(optional)

Datetime string (YYYY-MM-DDThh:mm:ss) for running the job once.

interval number
(optional)

Interval for running job.

time string
(optional)

Time for running job. Without additional parameter, this means daily execution.

dayOfWeek string
(optional)

Day of week to run job. Parameter "time" also required.

dayOfMonth string
(optional)

Day of month to run job. Parameter "time" also required. dayOfWeek can
optionally be used to define further.



Administration API - Function Reference 182

Argument Values

dayOfWeek

Name Description

Sunday Sunday

Monday Monday

Tuesday Tuesday

Wednesday Wednesday

Thursday Thursday

Friday Friday

Saturday Saturday

dayOfMonth

Name Description

1 to 31 Numeric representation of day of month.

Last Last day of month.

interval

Name Description

5 Every 5 minutes.

10 Every 10 minutes.

15 Every 15 minutes.

20 Every 20 minutes.

30 Every 30 minutes.

60 Every hour.

120 Every 2 hours.

180 Every 3 hours.

240 Every 4 hours.

360 Every 6 hours.

720 Every 12 hours.

CreateProfile
Create a new archiving or exporting profile.

Arguments
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Name Type Description

properties json Profile properties.

raw bool Currently only 'true' is supported.

Argument Values

properties
To receive available profile properties create a profile of the desired type via MailStore Client and then use the
GetProfiles method to receive supported values. The properties id and version must be omitted, the password
field must be filled properly.

CreateStore
Create and attach a new archive store.

Arguments

Name Type Description

name string Meaningful name of archive store.

type string
(optional)

Type of archive store.

databaseName string
(optional)

Name of database on Microsoft SQL Server or PostgreSQL server.

databasePath string
(optional)

Path to directory in which database folder information and email meta data
are stored.

contentPath string
(optional)

Path to directory in which email headers and contents are stored.

indexPath string
(optional)

Path to directory in which full text search indexes are stored.

serverName string
(optional)

Name of Microsoft SQL Server or PostgreSQL server.

userName string
(optional)

User name for accessing Microsoft SQL Server or PostgreSQL server.

password string
(optional)

Password for accessing Microsoft SQL Server or PostgreSQL server.

requestedState string
(optional)

State of archive store after attaching.

Argument Values

type
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Name Description

FileSystemInternal Standard archive store.

SQLServer Microsoft SQL Server-based archive store.

PostgreSQL PostgreSQL server-based archive store.

requestedState

Name Description

current Same as Normal but new messages will be archived in the archive store that is set to
Current.

normal The content of archives store is available to users and can be modified if the user has the
appropriate permission.

writeProtected The content of write protected archive stores is available to users, but cannot be modified
(e.g. delete or move messages, rename or move folders)

disabled Disabled archive stores are not in use but the instance still knows about their existence.
Therefore the content is not available to users.

CreateUser
Create new MailStore user.

Arguments

Name Type Description

userName string User name of new MailStore user.

privileges string Comma separated list of privileges.

fullName string (optional) Full name of user.

distinguishedName string (optional) LDAP DN string.

authentication string (optional) Authentication setting for user: 'integrated or 'directoryServices'.

password string (optional) Password of new user.

Argument Values

privileges
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Name Description

none The user is granted no global privileges. If specified, this value has to be the only
value in the list.

admin The user is granted administrator privileges. If specified, this value has to be the
only value in the list.

login The user can log on to MailStore Server.

changePassword The user can change his own MailStore Server password. This only makes sense if
the authentication is set to integrated.

archive The user can run archiving profiles.

modifyArchiveProfiles The user can create, modify and delete archiving profiles.

export The user can run export profiles.

modifyExportProfiles The user can create, modify and delete export profiles.

delete The user can delete messages. Please note that a non-admin user can only delete
messages in folders where he has been granted delete access. In addition,
compliance settings may be in effect, keeping administrators and users from
deleting messages even if they have been granted the privilege to do so.

DeleteEmptyFolders
Remove folders from folder tree that do not contain emails.

Arguments

Name Type Description

folder string (optional) Entry point in folder tree.

DeleteJob
Deletes a job.

Arguments

Name Type Description

id string The unique identifier of the job to be deleted.

DeleteMessage
Delete a single message

Arguments
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Name Type Description

id string Unique ID of message. Format: <store_id>:<message_num>

reason string The reason why that message has to be deleted.

DeleteProfile
Delete an archiving or exporting profile.

Arguments

Name Type Description

id number Unique ID of profile.

DeleteUser
Delete a MailStore user. Neither the user's archive nor the user's archive emails are deleted when deleting a user.

Arguments

Name Type Description

userName string User name of MailStore user.

DetachStore
Detaches an archive store.

Arguments

Name Type Description

id number Unique ID of archive store.

GetActiveSessions
Get list of current user sessions.

GetChildFolders
Get child folders. Depending on compliance settings this method may return only the first folder hierarchy level.

Arguments
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Name Type Description

folder string (optional) Parent folder which child folders should be returned. If omitted, all archives and
folder will be returned.

maxLevels number
(optional)

Depth of child folders.

GetComplianceConfiguration
Get current compliance configuration settings.

GetDirectoryServicesConfiguration
Get current Directory Services configuration settings.

GetFolderStatistics
Get folder statistics.

GetJobResults
Retrieves list of finished job executions.

Arguments

Name Type Description

fromIncluding string Beginning of time range to fetch.

toExcluding string End of time range to fetch.

timeZoneId string Time zone in which timestamp should be returned.

jobId number (optional) The job id for which to retrieve results.

Interactive Management Shell Example: GetJobResults --fromIncluding="2016-12-01T00:00:00"
--toExcluding="2016-12-31T23:59:59" --timeZoneId="$Local" --jobId=1

Use the API command GetTimeZones to retrieve a list of all available time zones.

GetJobs
Retrieve list of jobs

GetMessages
Get list of messages from a folder.

Arguments

Name Type Description

folder string (optional) Folder whose content to list.
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GetProfiles
Get list of archiving and exporting profiles.

Arguments

Name Type Description

raw bool Currently only 'true' is supported.

GetRetentionPolicies
Get the retention policies.

Example retention policies object:

[
  {
    "name": "Keep All Mails for 10 Years",
    "order": 1,
    "enabled": true,
    "searchCriteria": null,
    "period": 10,
    "periodInterval": "year",
    "delete": false
  }
]

GetServerInfo
Get MailStore Server version and machine name.

GetServiceConfiguration
Get MailStore Server service configuration. This includes the path to the Master Database, the location of the
audit log, whether the different debug logs are enabled and the endpoint configuration.

GetSmtpSettings
Get current SMTP configuration.

GetStoreIndexes
Get list of full text indexes.

Arguments

Name Type Description

id number (optional) Unique ID of archive store.
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GetStores
Get list of archive stores.

Arguments

Name Type Description

includeSize bool
(optional)

Includes size of archive store. Default: true. May be slow when running on slow
hardware.

GetTimeZones
Get list of available time zones.

GetUserInfo
Get detailed information about user.

Arguments

Name Type Description

userName string User name of MailStore user

GetUsers
Get list of users.

GetWorkerResults
Get results of profile executions.

Arguments

Name Type Description

fromIncluding string Beginning of time range to fetch.

toExcluding string End of time range to fetch.

timeZoneID string Time zone in which timestamp should be returned.

profileID number (optional) Filter results by given profile ID.

userName string (optional) Filter results by given user name.

Interactive Management Shell Example: GetWorkerResults --fromIncluding="2016-01-01T00:00:00"
--toExcluding="2016-12-31T23:59:59" --timeZoneID="$Local" --profileID=1 --userName="admin"
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MaintainFileSystemDatabases
Run database maintenance on all databases of file system based archive stores.

MergeStore
Merge two archive stores.

Arguments

Name Type Description

id number Unique ID of destination archive store.

sourceId number Unique ID of source archive store.

MoveFolder
Move folder.

Arguments

Name Type Description

fromFolder string Old folder name.

toFolder string New folder name.

ProcessRetentionPolicies
Processes the configured retention policies.

RebuildSelectedStoreIndexes
Rebuild all full-text indexes selected for rebuild.

RebuildStoreIndex
Rebuild search index for given archive folder.

Arguments

Name Type Description

id number Unique ID of archive store.

folder string Name of folder name.
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RecoverStore
Recreates a broken Firebird database from recovery records. The archive store must have been upgraded to the
latest version and the recovery records must not be corrupt. The archive store must be in the Disabled or Error
state.

Arguments

Name Type Description

id number Unique ID of archive store.

encryptionKey string (optional) Encryption key of the archive store.

RecreateRecoveryRecords
Recreates broken Recovery Records of an archive store. Use VerifyStore to verify the state of the Recovery
Records. Cannot be used for external archive stores that store their content in the database.

Arguments

Name Type Description

id number Unique ID of archive store.

RefreshAllStoreStatistics
Refresh statistics of all archive stores.

RenameJob
Rename job.

Arguments

Name Type Description

id number (optional) The unique identifier of the job to be renamed.

name string (optional) The new job name.

RenameStore
Rename archive store

Arguments
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Name Type Description

id number Unique ID of archive store.

name string New name of archive store.

RenameUser
Rename a MailStore user.

Arguments

Name Type Description

oldUserName string Old user name.

newUserName string New user name.

RenewMasterKey
Renews the master key which is used to encrypt the encryption keys.

RetryOpenStores
Retry opening stores that failed previously.

RunJobAsync
Run an existing job.

Arguments

Name Type Description

id number The identifier of the job to be run.

RunProfile
Run an existing archiving or exporting profile.

Arguments

Name Type Description

id number Unique profile ID.

RunTemporaryProfile
Run a temporary/non-existent profile.
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Arguments

Name Type Description

properties json Profile properties.

raw bool Currently only 'true' is supported.

Argument Values

properties
To receive available profile properties create a profile of the desired type via MailStore Client and use the
GetProfiles method to receive supported value.

SelectAllStoreIndexesForRebuild
Select all full-text indexes for rebuild.

SendStatusReport
Sends a status report to the given recipients.

Arguments

Name Type Description

timespan string Timespan that is covered by the status report.

timeZoneId string The time zone the date should be converted to, e.g. $Local, which represents the time zone
of the operating system.

recipients string Comma separated list of recipients that will receive the status report.

Argument Values

Timespan

Name Description

today The day when the status report is sent.

yesterday The day before the status report is sent.

thisweek The week when the status report is sent.

lastweek The week before the status report is sent.

thismonth The month when the status report is sent.

lastmonth The month before the status report is sent.
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SetComplianceConfiguration
Set compliance configuration settings.

Arguments

Name Type Description

config json Compliance configuration.

Argument Values

config
Use GetComplianceConfiguration to receive supported value.

Example settings object:

{
  "adminEmailPreviewEnabled": true,
  "legalHoldEnabled": false,
  "logSuccessfulUserActivities": [
    "AdminRestored",
    "ComplianceChangeSettings",
    "FileGroupAttach",
    "FileGroupCreate",
    "FileGroupDetach",
    "FileGroupRename",
    "FileGroupSetProperties",
    "FileGroupSetRequestedState",
    "ProfileChangeUserName",
    "UserAdd",
    "UserDelete",
    "UserRename",
    "UserSetFolderAccess",
    "UserSetMappings",
    "UserUpdate"
  ]
}

SetDirectoryServicesConfiguration
Set directory services configuration settings.

Arguments

Name Type Description

config json Directory services configuration.

Argument Values

config
Use GetDirectoryServicesConfiguration to receive supported value.
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SetJobEnabled
Set enabled status of a job.

Arguments

Name Type Description

id number (optional) The unique identifier of the job to be modified.

enabled bool (optional) Boolean value of enabled attribute.

SetJobSchedule
Modify the schedule of a job.

Arguments

Name Type Description

id number The unique identifier of the job to be modified.

timeZoneId string The time zone the date should be converted to, e.g. $Local, which represents the
time zone of the operating system.

date string
(optional)

Datetime string (YYYY-MM-DDThh:mm:ss) for running the job once.

interval number
(optional)

Interval for running job.

time string
(optional)

Time for running job. Without additional parameter, this means daily execution.

dayOfWeek string
(optional)

Day of week to run job. Parameter "time" also required.

dayOfMonth string
(optional)

Day of month to run job. Parameter "time" also required. dayOfWeek can
optionally be used to define further.

Argument Values

dayOfWeek

Name Description

Sunday Sunday

Monday Monday

Tuesday Tuesday

Wednesday Wednesday

Thursday Thursday

Friday Friday

Saturday Saturday
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dayOfMonth

Name Description

1 to 31 Numeric representation of day of month.

Last Last day of month.

interval

Name Description

5 Every 5 minutes.

10 Every 10 minutes.

15 Every 15 minutes.

20 Every 20 minutes.

30 Every 30 minutes.

60 Every hour.

120 Every 2 hours.

180 Every 3 hours.

260 Every 4 hours.

360 Every 6 hours.

720 Every 12 hours.

SetRetentionPolicies
Set retention policies.

Arguments

Name Type Description

config json Retention policy configuration.

To get example policies use the client to create retention policies manually. Then use the API command
GetRetentionPolicies to retrieve the json values.
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SetSmtpSettings
Set SMTP configuration.

Arguments

Name Type Description

settings json SMTP configuration.

Argument Values

settings
Example settings object:

{
  "hostname": "mail.example.com",
  "port": 587,
  "protocol": "SMTP-TLS",
  "ignoreSslPolicyErrors": false,
  "authenticationRequired": true,
  "username": "sending.user@example.com",
  "password": "userpassword",
  "fromDisplayName": "Sending User",
  "fromEmailAddress": "sending.user@example.com",
  "recipientEmailAddress": "administrator@example.com"
}

SetStoreProperties
Set properties of archive store.

Arguments

Name Type Description

id number Set properties of archive store.

type string
(optional)

databaseName string
(optional)

Name of database on Microsoft SQL Server or PostgreSQL server.

databasePath string
(optional)

Path to directory in which database folder information and email meta data
are stored.

contentPath string
(optional)

Path to directory in which email headers and contents are stored.

indexPath string
(optional)

Path to directory in which full text search indexes are stored.

serverName string
(optional)

Name of Microsoft SQL Server or PostgreSQL server.

userName string
(optional)

User name for accessing Microsoft SQL Server or PostgreSQL server.

password string
(optional)

Password for accessing Microsoft SQL Server or PostgreSQL server.
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Argument Values

type

Name Description

FileSystemInternal Advanced file system-based archive store.

SQLServer Microsoft SQL Server-based archive store.

PostgreSQL PostgreSQL server-based archive store.

SetStoreRequestedState
Set state of archive store.

Arguments

Name Type Description

id number Unique ID of archive store.

requestedState string (optional) State of archive store after attaching.

Argument Values

requestedState

Name Description

current Same as Normal but new messages will be archived in the archive store that is set to
Current.

normal The content of archives store is available to users and can be modified if the user has the
appropriate permission.

writeProtected The content of write protected archive stores is available to users, but cannot be modified
(e.g. delete or move messages, rename or move folders)

disabled Disabled archive stores are not in use but the instance still knows about their existence.
Therefore the content is not available to users.

SetUserAuthentication
Set authentication settings of a MailStore user.

Arguments
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Name Type Description

userName string User name of MailStore user.

authentication string Authentication method. Either 'integrated' or 'directoryServices'.

SetUserDistinguishedName
Set the LDAP distinguished name of a MailStore user.

Arguments

Name Type Description

userName string User name of MailStore user.

distinguishedName string (optional) LDAP DN string.

SetUserEmailAddresses
Set email addresses of MailStore user.

Arguments

Name Type Description

userName string User name of MailStore user.

emailAddresses string (optional) List of email addresses.

SetUserFullName
Set full name of MailStore user.

Arguments

Name Type Description

userName string User name of MailStore user.

fullName string (optional) Full name of MailStore user.

SetUserPassword
Set password of MailStore user.

Arguments
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Name Type Description

userName string User name of MailStore user.

password string Password of MailStore user.

SetUserPop3UserNames
Set POP3 user name of MailStore user.

Arguments

Name Type Description

userName string User name of MailStore user.

pop3UserNames string (optional) Comma separated list of POP3 user names.

SetUserPrivileges
Set privileges of MailStore user.

Arguments

Name Type Description

userName string User name of MailStore user.

privileges string Comma separated list of privileges.

Argument Values

privileges

Name Description

none The user is granted no global privileges. If specified, this value has to be the only
value in the list.

admin The user is granted administrator privileges. If specified, this value has to be the
only value in the list.

login The user can log on to MailStore Server.

changePassword The user can change his own MailStore Server password. This only makes sense if
the authentication is set to integrated.

archive The user can run archiving profiles.

modifyArchiveProfiles The user can create, modify and delete archiving profiles.

export The user can run export profiles.

modifyExportProfiles The user can create, modify and delete export profiles.

delete The user can delete messages. Please note that a non-admin user can only delete
messages in folders where he has been granted delete access. In addition,
compliance settings may be in effect, keeping administrators and users from
deleting messages even if they have been granted the privilege to do so.
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SetUserPrivilegesOnFolder
Set privileges on folder for MailStore user.

Arguments

Name Type Description

userName string User name of MailStore user.

folder string Folder name.

privileges string Comma separated list of folder privileges.

Argument Values

privileges

Name Description

none The user is denied access to the specified folder. If specified, this value has to be the only value in the
list. This effectively removes all privileges on the specified folder.

read The user is granted read access to the specified folder.

write The user is granted write access to the specified folder. Messages can be moved within an archive.

delete The user is granted delete access to the specified folder.

SyncUsersWithDirectoryServices
Sync users of MailStore instance with directory services.

Arguments

Name Type Description

dryRun bool (optional) Simulate sync only.

TestSmtpSettings
Test current SMTP configuration.

UnlockStore
Unlock a foreign archive store. In case an archive store from a foreign MailStore installation is attached, this
method can be used to unlock that archive store.

Arguments
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Name Type Description

id number Unique ID of archive store to unlock.

passphrase string Product key or recovery key of the foreign MailStore installation.

UpgradeStore
Upgrade archive store from MailStore Server 5 or older to current format.

Arguments

Name Type Description

id number Unique ID of archive store.

VerifyStore
Verify archive stores consistency.

Arguments

Name Type Description

id number The unique identifier of the archive store to be verified.

VerifyStores
Verify consistency of all archive stores.


